Getting Started

Cubase • sx/SL 3
Music Creation And Production System

steinberg
Table of Contents
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Introduction</td>
</tr>
<tr>
<td>8</td>
<td>Welcome</td>
</tr>
<tr>
<td>10</td>
<td>About the manuals and the Help</td>
</tr>
<tr>
<td>14</td>
<td>How you can reach us</td>
</tr>
<tr>
<td>15</td>
<td>Installation and Requirements for Windows</td>
</tr>
<tr>
<td>16</td>
<td>About this chapter</td>
</tr>
<tr>
<td>16</td>
<td>Requirements</td>
</tr>
<tr>
<td>20</td>
<td>Hardware installation</td>
</tr>
<tr>
<td>22</td>
<td>Installing Cubase SX/SL</td>
</tr>
<tr>
<td>27</td>
<td>Installation and Requirements for Mac OS X</td>
</tr>
<tr>
<td>28</td>
<td>About this chapter</td>
</tr>
<tr>
<td>28</td>
<td>Requirements</td>
</tr>
<tr>
<td>31</td>
<td>Hardware installation</td>
</tr>
<tr>
<td>32</td>
<td>Installing Cubase SX/SL</td>
</tr>
<tr>
<td>35</td>
<td>Setting up your system</td>
</tr>
<tr>
<td>36</td>
<td>Setting up audio</td>
</tr>
<tr>
<td>47</td>
<td>Setting up MIDI</td>
</tr>
<tr>
<td>51</td>
<td>Connecting a synchronizer</td>
</tr>
<tr>
<td>52</td>
<td>Setting up video</td>
</tr>
<tr>
<td>53</td>
<td>Optimizing audio performance</td>
</tr>
<tr>
<td>57</td>
<td>Basic Cubase SX/SL concepts</td>
</tr>
<tr>
<td>58</td>
<td>About this chapter</td>
</tr>
<tr>
<td>58</td>
<td>The project</td>
</tr>
<tr>
<td>60</td>
<td>Audio terminology</td>
</tr>
<tr>
<td>62</td>
<td>MIDI terminology</td>
</tr>
<tr>
<td>62</td>
<td>Video terminology</td>
</tr>
<tr>
<td>63</td>
<td>Basic Methods</td>
</tr>
<tr>
<td>64</td>
<td>About this chapter</td>
</tr>
<tr>
<td>64</td>
<td>Using menus</td>
</tr>
<tr>
<td>66</td>
<td>Using tools</td>
</tr>
<tr>
<td>68</td>
<td>Changing values</td>
</tr>
<tr>
<td>72</td>
<td>Selecting objects</td>
</tr>
<tr>
<td>73</td>
<td>Zoom and view techniques</td>
</tr>
<tr>
<td>76</td>
<td>Window handling</td>
</tr>
<tr>
<td>79</td>
<td>Undo</td>
</tr>
<tr>
<td>83</td>
<td>Guided Tour</td>
</tr>
<tr>
<td>84</td>
<td>The main windows in Cubase SX/SL</td>
</tr>
<tr>
<td>95</td>
<td>Quick start for former Cubase users</td>
</tr>
<tr>
<td>96</td>
<td>Introduction</td>
</tr>
<tr>
<td>97</td>
<td>Songs and Arrangements</td>
</tr>
<tr>
<td>97</td>
<td>Project window vs. Arrange window</td>
</tr>
<tr>
<td>98</td>
<td>Audio related differences</td>
</tr>
<tr>
<td>100</td>
<td>MIDI related differences</td>
</tr>
<tr>
<td>101</td>
<td>General differences</td>
</tr>
<tr>
<td>103</td>
<td>Tutorial 1: Recording and playing back audio</td>
</tr>
<tr>
<td>104</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>105</td>
<td>Creating a new project</td>
</tr>
<tr>
<td>107</td>
<td>Preparing to record</td>
</tr>
<tr>
<td>117</td>
<td>Recording</td>
</tr>
<tr>
<td>117</td>
<td>Playing back what you just recorded</td>
</tr>
<tr>
<td>118</td>
<td>Recording more events</td>
</tr>
<tr>
<td>119</td>
<td>Playing back in a cycle</td>
</tr>
<tr>
<td>Page</td>
<td>Section</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>121</td>
<td>Tutorial 2: Recording and playing back MIDI</td>
</tr>
<tr>
<td>122</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>123</td>
<td>Setting up for recording MIDI</td>
</tr>
<tr>
<td>126</td>
<td>Recording MIDI</td>
</tr>
<tr>
<td>126</td>
<td>Playing back what you just recorded</td>
</tr>
<tr>
<td>127</td>
<td>Playing back in a cycle</td>
</tr>
<tr>
<td>128</td>
<td>Transposing the MIDI track</td>
</tr>
<tr>
<td>131</td>
<td>Tutorial 3: Mixing</td>
</tr>
<tr>
<td>132</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>132</td>
<td>Preparations</td>
</tr>
<tr>
<td>134</td>
<td>Setting levels</td>
</tr>
<tr>
<td>135</td>
<td>Setting pan</td>
</tr>
<tr>
<td>136</td>
<td>Using Mute and Solo</td>
</tr>
<tr>
<td>137</td>
<td>Adding EQ to an audio channel</td>
</tr>
<tr>
<td>141</td>
<td>Audio effects</td>
</tr>
<tr>
<td>147</td>
<td>Automation</td>
</tr>
<tr>
<td>149</td>
<td>Tutorial 4: Creating a surround mix (Cubase SX only)</td>
</tr>
<tr>
<td>150</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>150</td>
<td>Preparations</td>
</tr>
<tr>
<td>154</td>
<td>Creating a Project</td>
</tr>
<tr>
<td>156</td>
<td>Creating a surround bus</td>
</tr>
<tr>
<td>156</td>
<td>Setting up a surround mix</td>
</tr>
<tr>
<td>163</td>
<td>Exporting to a surround audio file</td>
</tr>
<tr>
<td>167</td>
<td>Tutorial 5: Editing in the Project window</td>
</tr>
<tr>
<td>168</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>169</td>
<td>Preparations</td>
</tr>
<tr>
<td>169</td>
<td>Overview</td>
</tr>
<tr>
<td>170</td>
<td>Moving and copying events</td>
</tr>
<tr>
<td>172</td>
<td>Muting and erasing events</td>
</tr>
<tr>
<td>173</td>
<td>Splitting and resizing events</td>
</tr>
<tr>
<td>175</td>
<td>Adding a fade</td>
</tr>
<tr>
<td>177</td>
<td>Tutorial 6: Using VST Instruments</td>
</tr>
<tr>
<td>178</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>178</td>
<td>Preparations</td>
</tr>
<tr>
<td>179</td>
<td>Activating a VST Instrument</td>
</tr>
<tr>
<td>181</td>
<td>Routing</td>
</tr>
<tr>
<td>182</td>
<td>Playing back</td>
</tr>
<tr>
<td>183</td>
<td>Adding another instrument</td>
</tr>
<tr>
<td>185</td>
<td>Playing a VST Instrument in real time</td>
</tr>
<tr>
<td>187</td>
<td>Recording</td>
</tr>
<tr>
<td>188</td>
<td>Making parameter settings</td>
</tr>
<tr>
<td>190</td>
<td>Automating the changes</td>
</tr>
<tr>
<td>191</td>
<td>Tutorial 7: Tempo matching audio loops</td>
</tr>
<tr>
<td>192</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>193</td>
<td>Setting up</td>
</tr>
<tr>
<td>197</td>
<td>Activating Musical Mode</td>
</tr>
<tr>
<td>201</td>
<td>Tutorial 8: Arranging with the play order function</td>
</tr>
<tr>
<td>202</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>203</td>
<td>Setting up</td>
</tr>
<tr>
<td>204</td>
<td>Creating play order parts</td>
</tr>
<tr>
<td>207</td>
<td>Creating a play order list</td>
</tr>
<tr>
<td>Page</td>
<td>Tutorial 9: Editing audio</td>
</tr>
<tr>
<td>------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>211</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>212</td>
<td>The Sample Editor</td>
</tr>
<tr>
<td>215</td>
<td>Processing audio</td>
</tr>
<tr>
<td>216</td>
<td>Applying an effect plug-in (Cubase SX only)</td>
</tr>
<tr>
<td>217</td>
<td>Using the Offline Process History dialog</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page</th>
<th>Tutorial 10: Editing MIDI</th>
</tr>
</thead>
<tbody>
<tr>
<td>219</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>220</td>
<td>Opening the Key Editor</td>
</tr>
<tr>
<td>221</td>
<td>Drawing events in the Key Editor</td>
</tr>
<tr>
<td>222</td>
<td>Selecting and moving events</td>
</tr>
<tr>
<td>223</td>
<td>About quantize</td>
</tr>
<tr>
<td>225</td>
<td>Editing velocity in the controller display</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page</th>
<th>Tutorial 11: Customizing</th>
</tr>
</thead>
<tbody>
<tr>
<td>227</td>
<td>About this tutorial</td>
</tr>
<tr>
<td>228</td>
<td>Setting preferences</td>
</tr>
<tr>
<td>231</td>
<td>Setting up Key Commands</td>
</tr>
<tr>
<td>234</td>
<td>Changing the look of the toolbar</td>
</tr>
<tr>
<td>236</td>
<td>Changing the appearance of the program</td>
</tr>
<tr>
<td>237</td>
<td>Applying track colors</td>
</tr>
<tr>
<td>240</td>
<td>Creating a template</td>
</tr>
<tr>
<td>243</td>
<td>Setting up Zoom presets</td>
</tr>
<tr>
<td>244</td>
<td>Setting up workspaces</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page</th>
<th>Shortcuts &amp; key commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>247</td>
<td>About this chapter</td>
</tr>
<tr>
<td>248</td>
<td>The default key commands</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page</th>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>257</td>
<td></td>
</tr>
</tbody>
</table>
1

Introduction
Welcome

Congratulations and thank you for your purchase of Steinberg Cubase SX/SL. The year 2004 marks the twentieth anniversary of Steinberg. Steinberg’s involvement in developing and stimulating growth in the music industry by creating powerful tools for music composition and production has first and foremost been defined by Cubase. Can you think of a better way to celebrate such a remarkable anniversary than to introduce a brand new version of Cubase? Well, here it is: Cubase SX/SL 3 – the most powerful version of Cubase ever!

Steinberg’s product management and software development teams have spent an entire year turning an already fantastic product into something even bigger. We have integrated powerful real-time audio time stretching and pitch shifting technologies to facilitate the use of loops and phrases in your arrangements. No more need to calculate tempo or process samples offline. Use your favorite loop libraries and place loop elements in your arrangements without interrupting your creative flow. We have also created the new Play Order Track. It allows you to change the arrangement of your song quickly and try different versions of a song without having to change the song’s original arrangement itself. Pretty smart – and very intuitive. Furthermore, we have spent quite some time thinking about how we could better integrate hardware instruments and processors into the virtual studio world of VST. Yes, we invented the virtual instrument and virtual studio technology, but we never wanted you to abandon your beloved hardware instruments and effects entirely. With Cubase SX 3, the seamless integration of outboard equipment is now possible, using MIDI Device Panels, Studio Connections support and an extremely handy External FX Plug-in. Now you can let your ears decide which instrument or effects to use. Most likely, you will soon stop thinking about whether you are using a plug-in or hardware.

But these are only a few of the new Cubase SX/SL 3 features. If you are new to Cubase you will find many more unique and powerful tools and features that speed up your workflow and at the same time inspire your creative mind. Making music should be fun. After all, it is fun for us making these tools for you.
Take some time to make yourself familiar with Cubase SX/SL 3. If you are already familiar with Cubase you should check out the tutorials 7 and 8 for a brief introduction to tempo matching using Audio Warp and arranging using the Play Order Track. If this is your first experience with Cubase, we suggest reading this entire manual and going through all the tutorial chapters. They are a very good introduction to Cubase and how to make use of the fundamental tools and functions.

If you haven’t registered the product with us online, we strongly recommend doing so. You will have access to our user forums and support pages and you will be able to receive exclusive Steinberg offers for Cubase users only. Of course, we would like to hear how you find working with Cubase. It is your input that allows us to make this product better with every version. Be part of our worldwide Cubase community, together with thousands of other Cubase users.

See you around!

The Steinberg Cubase Team
About the manuals and the Help

The Cubase SX/SL documentation is divided into several sections, as listed below. Most of the documents are in Adobe Acrobat format (extension ".pdf") - these can be accessed in the following ways:

- You can open the pdf documents from the Help menu in the program.
- Under Windows you can also open these documents from the Cubase SX/SL Documentation subfolder on the Windows Start menu.
- Under Mac OS X the pdf documents are located in the folder "~/Library/Documentation/Cubase SX/SL 3" or in the Cubase SX/SL program folder under "~/Contents/Documentation/".

- **To read the pdf documents you need to have the Acrobat Reader application installed on your computer.** An Acrobat installer is provided on the program DVD.

The Getting Started book

This is the book you are reading now. The Getting Started book covers the following areas:

- Computer requirements.
- Installation issues.
- Setting up your system for audio, MIDI and/or video work.
- A guided tour of the main Cubase SX/SL windows.
- Tutorials describing the most common procedures for recording, playing back, mixing and editing in Cubase SX/SL.
- Basic concepts and terminology.
- A description of the general methods used when working in Cubase SX/SL.

In other words, this book does not go into detail on any Cubase SX/SL windows, functions or procedures. The Getting Started book comes as a printed book but is also available as a pdf document.

The Operation Manual

The Operation Manual is the main Cubase SX/SL reference documentation, with detailed descriptions of Cubase SX/SL operations, parameters, functions and techniques. You should be familiar with the concepts and methods described in the Getting Started book before moving on to the Operation Manual.
MIDI Devices and Features
Contains descriptions of the included MIDI effect plug-ins; how to manage MIDI Devices and device panels; how to work with MIDI System Exclusive messages and how to use the Logical Editor and Input Transformer.

Audio Effects and VST Instruments
Describes the features and parameters of the included VST plug-ins (real-time audio effects and VST instruments).

Remote Control Devices
This pdf document lists the supported MIDI remote control devices and describes how to set them up and use them with Cubase SX/SL.

Score Layout and Printing (Cubase SX only)
Describes the score editing features in Cubase SX.

• There is a more basic Score editor in Cubase SL – this is described in the Operation Manual.

Using Cubase SX/SL with DSP Factory (Windows only)
Describes how to set up and use a Yamaha DSP Factory audio card with Cubase SX/SL.
The Help System

Cubase SX/SL comes with a detailed help system, making it easy to look up procedures and descriptions from within the program. The contents of the help basically mirror the complete Operation Manual text. The help systems are slightly different depending on which operating system you use, Windows or Mac OS X:

**HTML Help (Windows)**

You use the HTML Help in the following way:

- To open the HTML Help for browsing, select “HTML Help” from the Help menu in the program.
  This brings up the HTML Help browser in which you can browse the help table of contents, search the index or perform a free text search.

- To get information about the active window or a dialog, press [F1] on the computer keyboard or click the Help button in the actual dialog.
  Within a topic, related topics are sometimes directly accessible via clickable links.

**Apple Help (Mac OS X)**

You use the Apple Help in the following way:

- To open the Apple Help for browsing, select “Cubase SX/SL Help” from the Help menu in the program.
  This brings up the Apple Help Viewer window. There, you can either browse the help table of contents, use the index or type any words into the Search field at the top of the window.

- To get information about the active window or a dialog, press [F1] on the computer keyboard or click the Help button in the actual dialog.
  Within a topic, related topics are sometimes directly accessible via clickable links.

Please note that you can open the Cubase SX/SL Help even when the program isn’t running:

1. Select “Mac Help” from the Help menu in the Finder.
2. In the Apple Help Viewer, bring up the “Help Center”.
3. Click the “Cubase SX/SL Help” link in the Help Center.
About the program versions

The documentation covers two program versions; Cubase SX and Cubase SL, for two different operating systems or “platforms”; Windows and Mac OS X.

Some features described in the documentation are only applicable to the Cubase SX version. Whenever this is the case this will be clearly indicated in the heading of the related subject.

Similarly, some features and settings are specific to one of the platforms, Windows or Mac OS X. This is also clearly stated.

In other words:

• If nothing else is said, all descriptions and procedures in the documentation are valid for both Cubase SX and Cubase SL, under Windows and Mac OS X.

The screenshots are taken from the Windows version of Cubase SX.

Key command conventions

Many of the default key commands in Cubase SX/SL use modifier keys, some of which are different depending on the operating system. For example, the default key command for Undo is [Ctrl]-[Z] under Windows and [Command]-[Z] under Mac OS X.

When key commands with modifier keys are described in this manual, they are shown with the Windows modifier key first, in the following way:

[Win modifier key]/[Mac modifier key]-[key]

For example, [Ctrl]/[Command]-[Z] means “press [Ctrl] under Windows or [Command] under Mac OS X, then press [Z].”

Similarly, [Alt]/[Option]-[X] means “press [Alt] under Windows or [Option] under Mac OS X, then press [X].”
How you can reach us

On the Help menu in Cubase SX/SL, you will find items for registering online, getting additional information and help:

- On the “Steinberg on the Web” submenu you can find links to various Steinberg websites. Selecting one will automatically launch your browser application and open the page.
  You can find support and compatibility information, answers to frequently asked questions, links for downloading new drivers, etc. This requires that you have a web browser application installed on your computer, and a working Internet connection.
2
Installation and Requirements
for Windows
About this chapter

This chapter describes the system requirements and installation procedures for Cubase SX/SL for Windows. Installing Cubase SX/SL for Mac OS X is described on page 28.

Requirements

To use Cubase SX/SL, you need the following:

- A PC with Windows XP installed. A USB Port is also required. For more details about the computer requirements, see below.

- Compatible audio hardware. By audio hardware we mean a card capable of recording and playing back digital audio using your hard disk as a storage medium. It must also have an appropriate ASIO driver (see page 18) or be Windows Multimedia compatible. Also, to take full advantage of Cubase’s channel i/o bus architecture and surround features (SX only), audio hardware with multiple inputs and outputs is required.

For MIDI

- At least one MIDI interface.

- At least one MIDI instrument.

- Any audio equipment necessary to listen to the sound from your MIDI devices.
Computer requirements

Hardware – PC

The minimum requirements for running Cubase SX/SL on a PC are:

• A 800MHz Pentium processor or Athlon processor and Windows XP.
• 384MB of RAM.
• Monitor and graphics card supporting 1024 x 768 resolution.
• A free USB drive for the copy protection key.
• A DVD ROM drive.

For optimum performance we recommend the following:

• Pentium or Athlon processor at 2.8GHz or faster.
• 512MB of RAM.
• A dual monitor setup with 1152 x 864 screen resolution or higher.

RAM

Audio work requires a lot of RAM! In fact, there is a direct relation between the amount of available RAM and the number of audio channels that you can have running. As specified earlier, 384 MB is the minimum requirement, but as a general rule “the more the better” applies.

Hard disk size

• The size of the hard disk determines how many minutes of audio you will be able to record.

  Recording one minute of stereo CD quality audio, requires 10 MB of hard disk space.
  That is, eight stereo tracks in Cubase SX/SL use up at least 80 MB of disk space per recording minute.

Hard disk speed

The speed of the hard drive also determines the number of audio tracks you can run. That is the quantity of information that the disk can read, usually expressed as “sustained transfer rate”. Again, “the more the better” applies.

Wheel mouse

Although a regular mouse will work fine with Cubase SX/SL, we recommend that you use a wheel mouse, as this will speed up value editing and scrolling considerably. See page 68 and page 73.
Audio hardware

Cubase SX/SL will run with audio hardware that meets the following basic specifications:

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Is supplied with a special ASIO driver, or a DirectX or Windows Multimedia compatible driver as described below.

About drivers

A driver is a piece of software that allows a program to communicate with a certain piece of hardware. In this case, the driver allows Cubase SX/SL to use the audio hardware. For audio hardware, there are three different cases, each requiring different driver configurations:

If the audio hardware has a specific ASIO driver

Professional audio cards often come with an ASIO driver written especially for the card. This allows for communication directly between Cubase SX/SL and the audio card. As a result, audio cards with specific ASIO drivers can provide lower latency (input-output delay), which is crucial when monitoring audio via Cubase SX/SL or using VST Instruments. The ASIO driver may also provide special support for multiple inputs and outputs, routing, synchronization, etc.

Audio card-specific ASIO drivers are provided by the card manufacturers. Make sure to check the manufacturer’s web site for the latest driver versions.

If your audio hardware comes with a specific ASIO driver we strongly recommend that you use this.
If the audio card communicates via DirectX

DirectX is a Microsoft “package” for handling various types of Multimedia under Windows. Cubase SX/SL supports DirectX, or to be more precise, DirectSound, which is a part of DirectX used for playing back and recording audio. This requires two types of drivers:

- A DirectX driver for the audio card, allowing it to communicate with DirectX. If the audio card supports DirectX, this driver should be supplied by the audio card manufacturer. If it isn’t installed with the audio card, please check the manufacturer’s web site for more information.
- The ASIO DirectX Full Duplex driver, allowing Cubase SX/SL to communicate with DirectX. This driver is included with Cubase SX/SL, and does not require any special installation.

If the audio card communicates via Windows Multimedia system

If the card is Windows compatible, it can be used in Cubase SX/SL. The card then communicates with Windows Multimedia system, which in turn communicates with Cubase SX/SL. This requires two types of drivers:

- A Windows Multimedia driver for the audio card, allowing it to communicate with the Windows Multimedia system. This driver should be supplied by the audio card manufacturer, and is normally installed when you install the audio card.
- The ASIO Multimedia driver, allowing Cubase SX/SL to communicate with the Windows Multimedia system. This driver is included with Cubase SX/SL, and does not require any special installation.
Hardware installation

Installing the copy protection key – please read!

New users

Included with the Cubase SX/SL package, you will find a hardware key (sometimes referred to as a “dongle”) that is part of the Cubase SX/SL copy protection scheme. Cubase SX/SL will not run if this key isn’t installed properly.

The copy protection key should be plugged into the computer’s USB port after installing Cubase SX/SL and restarting the computer! When the copy protection key is plugged into the USB port, Windows will automatically register it as a new hardware device and will attempt to find drivers for it – these necessary drivers won’t be there until Cubase SX/SL has been installed and the computer restarted.

If you're upgrading from a previous version of Cubase SX/SL

In this case you already have a copy protection key – all you need to do is authorize that key for use with your new Cubase SX/SL version.

This is done by means of the Authorization Code included in the upgrade package, after installing the program, see page 24!

Installing the audio hardware and its driver

1. Install the audio card and related equipment in the computer, as described in the card’s documentation.

2. Install the driver for the card.
   There are three types of drivers that could apply: card-specific ASIO drivers, DirectX drivers and Windows Multimedia drivers:

Specific ASIO driver

If your audio card has a specific ASIO driver it may be included with the audio card, but you should always make sure to check the audio card manufacturer’s web site for the most recent drivers. For details on how to install the driver, refer to the manufacturer’s instructions.
**DirectX driver**

If your audio card is DirectX compatible, its DirectX drivers will most likely be installed when you install the card (as with the Windows Multimedia driver). If you have downloaded special DirectX drivers for the audio card, you should follow the manufacturer’s installation instructions.

**Windows Multimedia driver**

These drivers are normally included with all types of regular PC audio cards. Some are even included with Windows itself. Depending on whether the audio card is “Plug’n’Play compatible” or not, the installation of the card is done differently:

- If the card is “Plug’n’Play compatible”, Windows will detect the card once it is plugged in, and ask for the necessary driver disks.

- If not, you need to use the “Add New Hardware” feature in the Control Panel to install the card and its drivers. Refer to the documentation that comes with the card.

Should you have an audio card but no driver, please check the manufacturer’s web site, or ask your music or computer dealer for help.

**Testing the card**

To make sure the audio card will work as expected, perform the following two tests:

- Use any software included with the audio card to make sure you can record and play back audio without problems.

- If the card is accessed via a standard Windows driver, use the Media Player application (included with Windows) to play back audio.
Installing a MIDI interface/synthesizer card

Installation instructions for a MIDI interface should be included with the product. However, here’s an outline of the necessary steps:

1. Install the interface (or MIDI synthesizer card) inside your computer or connect it to a “port” (connector) on the computer. Which is right for you depends on which type of interface you have.

2. If the interface has a power supply and/or a power switch, turn it on.

3. Install the driver for the interface, as described in the documentation that comes with the interface. It is likely that you will need a CD ROM or floppy disk supplied by the manufacturer of the MIDI interface. You should also make sure to check the manufacturer’s web site for the latest driver updates.

Installing Cubase SX/SL

Defragment the hard disk

If you plan to record audio on a hard disk where you have already stored other files, now is the time to defragment it. Defragmentation reorganizes the physical allocation of space on the hard disk in order to optimize its performance. It is done with a special defragmentation program. In Windows XP, for example, you might look for the “Disk Defragmenter” utility.

It is crucial to the audio recording performance that your hard disk is optimized (defragmented). You should make sure to defragment regularly.
Installing the files from the DVD-ROM

The installation procedure puts all files in the right places, automatically.

1. Insert the Cubase SX/SL DVD-ROM.

2. A pop-up dialog appears automatically, containing three items for installing, browsing the DVD and exiting.

3. To start the installation process, select “Install”.
   This starts the installation procedure for the Syncrosoft License Control Center.

4. Remove all copy protection keys (if plugged) and click the “Next” button to continue.

5. You will be asked to read and confirm the license agreement (shown on screen).
   This is required for the installation to proceed.

6. Install the drivers for the copy protection key and click the “Next” button to continue.

7. Click the “Finish” button to finish the installation of the License Control Center.

Now you are ready to proceed with the installation of Cubase SX/SL:

1. In the “Cubase SX/SL 3” dialog that appears, fill in your name and the serial number of your Cubase SX/SL copy, and click OK.
   You will find the serial number on the DVD sleeve. Check the name and number in the confirmation dialog and click “Yes” if they are correct. Clicking “No” brings back the previous dialog.

2. You will be asked to read and confirm the license agreement (shown on screen).
   This is required for the installation to proceed.

3. At one point you will be asked whether Cubase SX/SL should be available to all users of the computer or just to you.
   Choose the option that suits you best.

4. Finally, a dialog box informs you that the installation was successful and recommends that you restart your computer.
   Remove the DVD-ROM and store it in a safe place.
Setting up the protection key

If you are a new Cubase SX/SL user:

1. After restarting the computer, plug in the hardware protection key into the USB port.
   If you are unsure which port this is, consult the computer’s documentation.

2. The first time the copy protection device is plugged in, it will be registered as a new hardware device, and a dialog will appear asking you whether you would like to find drivers for the device manually or automatically.

3. Choose to find drivers automatically.
   The dialog closes.

4. You are now ready to launch Cubase SX/SL!

If you are upgrading from a previous Cubase SX/SL version and have a working internet connection:

   Before launching the program you need to authorize the protection key for use with your new Cubase SX/SL version.

1. After restarting the computer, plug in your Cubase SX/SL key into the USB port.

2. Make sure that your computer has a working internet connection.

3. Locate the Authorization Code in the upgrade package and keep it at hand.

4. Launch the “License Control Center” application (found under “Syn-crosoft” on the Start menu).
   This application allows you to view your USB protection keys and authorize them for new applications by downloading licenses.

5. Use the License Control Center “Wizard” function to download a license for your new program version to your protection key.
   This requires that you enter your Authorization Code – just follow the directions on screen. If you are uncertain about how to proceed, consult the help for LCC.

6. When the authorization is complete, you are ready to launch Cubase SX/SL!
   This completes the installation of your Cubase SX/SL program!
For information about product updates, you should check the Steinberg website regularly. Open the “Steinberg on the Web” submenu on the Help menu and select “Product Updates”. The website that opens contains a list with the recent updates.

If you are upgrading from a previous Cubase SX/SL version and have no working internet connection:

Before launching the program you need to authorize the protection key for use with your new Cubase SX/SL version.

1. Insert your program CD into a second computer with internet connection or go to an internet cafe.

2. Open the folder “Additional Content/Copy Protection Driver” on the program CD and double click on the file “Copy Protection Driver Installer.exe”.
   The application “License Control Center” will be installed.

3. Plug in you Cubase SX/SL key into the USB port and let Windows install the corresponding drivers.

4. Connect to the internet.

5. Launch the application “License Control Center”.
   This application allows you to view your USB protection keys and authorize them for new applications by downloading licenses.

6. Use the License Control Center “Wizard” function to download a license for your new program version to your protection key.
   This requires that you enter your Authorization Code – just follow the directions on screen. If you are uncertain about how to proceed, consult the help for LCC.

7. When the authorization is complete, you can disconnect your copy protection key and plug it into the USB port of your audio computer.
Register your software!

Registering your software will make sure you are entitled to technical support and kept aware of updates and other news regarding Cubase SX/SL. For full support services, you need to register both online and by sending in your registration card.

For online registration, you need a working internet connection. From the Help menu of Cubase SX/SL, select “Register Online...” and follow the instructions. If your computer does not have a working Internet connection, you can also register from another computer.

The items on the start menu

If you open the Windows Start menu, you will find a Cubase SX/SL group on the “Programs” submenu. This contains the following items:

- **Documentation.**
  
  On this submenu you can access the various Cubase SX/SL documentation files in the Acrobat pdf format. These documents are also available on the Help menu from within the program.

- **ASIO Multimedia Setup.**
  
  This opens a dialog with settings for the ASIO (Audio Stream Input Output) system, which handles audio recording and playback in Cubase SX/SL, if you are using the ASIO MME driver. This dialog can also be opened from within Cubase SX/SL. See the chapter “Setting up your system” in this book.

- **Cubase SX/SL.**
  
  This launches the actual program.

- **Cubase SX/SL 3 application data folder.**
  
  This opens the application data folder, where your Cubase SX/SL settings are stored.

  On the “Programs” submenu you will also find an item called Syncrosoft (License Control Center). This item shows all Syncrosoft protection devices and valid licenses currently installed and allows you to download new licenses to your protection key.

  There may also be additional items (such as Readme files) available on the Start menu. Please read all such files before launching Cubase SX/SL, since they may contain late information not included in the manuals.
3

Installation and Requirements
for Mac OS X
About this chapter

This chapter describes the system requirements and installation procedures for Cubase SX/SL for Mac OS X. Installing Cubase SX/SL for Windows is described on page 16.

Requirements

To use Cubase SX/SL, you need the following:

- A Macintosh computer running Mac OS X 10.3.3 or later. A USB Port is also required.
  For more details about the computer requirements, see below.

- Mac OS X compatible audio hardware.
  While the built-in audio hardware of the Macintosh may be adequate for basic audio playback, we strongly recommend audio hardware that is specifically designed for audio recording and music applications. Also, to take full advantage of Cubase’s multi-channel i/o bus architecture and surround features (SX only), audio hardware with multiple inputs and outputs is required.

For MIDI

- At least one MIDI interface.

- At least one MIDI instrument.

- Any audio equipment necessary to listen to the sound from your MIDI devices.
Computer requirements

Hardware – Mac

The absolute minimum requirements for running Cubase SX/SL on a Macintosh are as follows:

- A G4 with 867MHz and OS X 10.3.3 or later.
- 384MB RAM.
- Monitor and graphics card supporting 1024 x 768 resolution.
- A free USB drive for the copy protection key.
- A DVD ROM drive.

For optimum performance we recommend the following:

- A G5 dual processor with 1.8GHz or faster.
- 512MB RAM.
- A dual monitor setup with 1152 x 864 screen resolution or higher.

RAM

Audio work requires a lot of RAM! In fact, there is a direct relation between the amount of available RAM and the number of audio channels that you can have running. As specified earlier, 384MB is the minimum requirement, but as a general rule “the more the better” applies.

Hard disk size

- The size of the hard disk determines how many minutes of audio you will be able to record.
  Recording one minute of stereo CD quality audio, requires 10MB of hard disk space.
  That is, eight stereo tracks in Cubase SX/SL use up at least 80MB of disk space per recording minute.

Hard disk speed

The speed of the hard drive also determines the number of audio tracks you can run. That is the quantity of information that the disk can read, usually expressed as “sustained transfer rate”. Again, “the more the better” applies.
Mouse

Although a regular mouse will work fine with Cubase SX/SL, we recommend that you use a wheel mouse with two mouse buttons.

- Having a wheel mouse will speed up value editing and scrolling considerably.
- If your mouse has two mouse buttons you should program the right mouse button to generate a [Ctrl]-click (this is typically the default behavior of the right mouse button).
  This will allow you to bring up context menus by right clicking (see page 65).

Audio hardware

Cubase SX/SL will run with audio hardware that meets the following basic specifications:

- Stereo.
- 16 bit.
- Support of at least the 44.1kHz sampling rate.
- Is supplied with proper Mac OS X (Core Audio) drivers.

A basic rule of thumb is: if the hardware works under Mac OS X, you can use it in Cubase SX/SL.

- Cubase SX/SL also supports audio hardware with Mac OS X compliant ASIO drivers.
  ASIO drivers may provide special support for routing, monitoring, synchronization, etc.
  Note that the ASIO drivers must be written specifically for Mac OS X – Mac OS 9.X ASIO drivers cannot be used.

Using the built-in audio hardware of the Macintosh

Although Cubase SX/SL is designed with multi-channel input and output in mind, it’s of course possible to use the program with “basic” stereo inputs and outputs. As of this writing, all current Macintosh models have built-in 16 bit stereo audio hardware. Depending on your preferences and requirements, this may be sufficient for use with Cubase SX/SL. The built-in audio hardware is always available for selection in Cubase SX/SL – you don’t need to install any additional drivers.

Some Macintosh models have audio outputs but no inputs. This means that you can only play back audio – recording is not possible without additional audio hardware.
Hardware installation

About the copy protection key – please read!

New users

Included with the Cubase SX/SL package, you will find a hardware key (sometimes referred to as a "dongle") that is part of the Cubase SX/SL copy protection scheme. Cubase SX/SL will not run if this key isn't installed properly.

- You should first install the program (and any necessary hardware, see below), then insert the protection key and finally launch the program. This is because the necessary drivers for the key are installed when you install the program.

If you're upgrading from a previous version of Cubase SX/SL

In this case you already have a copy protection key – all you need to do is authorize that key for use with your new Cubase SX/SL version. This is done by means of the Authorization Code included in the upgrade package, after installing the program – see page 32!

Installing the audio hardware and its driver

1. Make sure you have the latest Mac OS X drivers for the audio hardware! Please check the manufacturer’s web site for the latest versions.

2. Install the driver(s) for the audio hardware.
   This is usually done by running an installer application.

3. Install or connect the audio interface, as described in the card's documentation.

Installing a MIDI interface

1. Make sure you have the latest Mac OS X drivers for the MIDI interface!
   Please check the manufacturer’s web site for the latest versions.

2. Install the driver(s) for the interface.
   This is usually done by running an installer application.

3. Connect the MIDI interface to the computer, as described in the interface documentation.
Installing Cubase SX/SL

Defragment the hard disk

If you plan to record audio on a hard disk where you have already stored other files, now is the time to defragment it. Defragmentation reorganizes the physical allocation of space on the hard disk in order to optimize its performance. It is done with a special defragmentation program.

It is crucial to the audio recording performance that your hard disk is optimized (defragmented). You should make sure to defragment regularly.

Installing the files from the DVD-ROM

The installation procedure puts all files in the right places, automatically.

1. Insert the Cubase SX/SL DVD-ROM.

2. Locate the Cubase SX/SL installer and run it.
   The installation procedure starts. This will create a Cubase SX/SL folder in your Applications folder and add various required files to your system.

3. At one point during the installation you will need to fill in your name and the serial number of your Cubase SX/SL copy.
   You will find the serial number on the DVD sleeve.

4. You will be asked to read and confirm the license agreement (shown on screen).
   This is required for the installation to proceed.
   Finally, a dialog box informs you that the installation was successful.

Setting up the protection key

If you are a new Cubase SX/SL user:

1. After restarting the computer, plug in the hardware protection key into the USB port.
   If you are unsure over which port this is, consult the computer’s documentation.

2. You are now ready to launch Cubase SX/SL!
If you are upgrading from a previous Cubase SX/SL version and have a working internet connection:

Before launching the program you need to authorize the protection key for use with your new Cubase SX/SL version.

1. After restarting the computer, plug in your Cubase SX/SL key into the USB port.

2. Make sure that your computer has a working internet connection.

3. Locate the Authorization Code in the upgrade package and keep it at hand.

4. Launch the “License Control Center” application (found in the Applications folder).
   This application allows you to view your USB protection keys and authorize them for new applications by downloading licenses.

5. Use the License Control Center “Wizard” functions to download a license for your new program version to your protection key.
   This requires that you enter your Authorization Code – just follow the directions on screen. If you are uncertain about how to proceed, consult the help for LCC.

6. When the authorization is complete, you are ready to launch Cubase SX/SL!
   This completes the installation of your Cubase SX/SL program!

For information about product updates, you should check the Steinberg website regularly. Open the “Steinberg on the Web” submenu on the Help menu and select “Product Updates”. The website that opens contains a list with the recent updates.
If you are upgrading from a previous Cubase SX/SL version and have no working internet connection:

Before launching the program you need to authorize the protection key for use with your new Cubase SX/SL version.

1. Insert your program CD into a second computer with internet connection or go to an internet cafe.

2. Open the folder “Additional Content/Copy Protection Driver” on the program CD and double click on the file “SynchrosoftLicenseControl.pkg”.
   The application “License Control Center” will be installed.

3. Plug in you Cubase SX/SL key into the USB port.

4. Connect to the internet.

5. Launch the application “License Control Center”.
   This application allows you to view your USB protection keys and authorize them for new applications by downloading licenses.

6. Use the License Control Center “Wizard” function to download a license for your new program version to your protection key.
   This requires that you enter your Authorization Code – just follow the directions on screen. If you are uncertain about how to proceed, consult the help for LCC.

7. When the authorization is complete, you can disconnect your copy protection key and plug it into the USB port of your audio computer.

Register your software!

Registering your software will make sure you are entitled to technical support and kept aware of updates and other news regarding Cubase SX/SL. For full support services, you need to register both online and by sending in your registration card.

For online registration, you need a working internet connection.
Launch Cubase SX/SL, select “Register Online…” from the Cubase SX/SL menu and follow the instructions. If your computer does not have a working Internet connection, you can also register from another computer.
4

Setting up your system
Setting up audio

Always make all connections with all equipment turned off!

Connecting audio

Exactly how to set up your system is a very personal matter – the following connection diagrams should be taken as examples.

The audio connections below may be digital or analog, it doesn’t matter.

Stereo input and output – the simplest connection

If you only use a stereo input and output from Cubase SX/SL, you can connect your audio hardware directly to the input source, a mixer for example, and the outputs to a power amplifier and speaker.

A simple stereo audio setup.
Multi-channel input and output

Most likely however, you will have other audio equipment that you want to integrate with Cubase SX/SL. This will require a mixer, preferably one with a group or bus system that can be used for feeding inputs on the audio hardware.

In the example below, four buses are used for feeding signals to the audio hardware’s inputs. The four outputs are connected back to the mixer for monitoring and playback. Remaining mixer inputs can be used for connecting audio sources like microphones, instruments, etc.

A multi-channel audio setup.

• When connecting an input source (like a mixer) to the audio hardware, you should use output buses, sends or similar that are separate from the mixer’s master output to avoid recording what you are playing back.
Connecting for surround sound (Cubase SX only)

If you plan to mix for surround sound, you could connect the audio outputs to a multi-channel power amplifier, driving a set of surround channels.

A surround sound playback configuration.

Cubase SX supports surround formats with up to 6 speaker channels. The figure above shows a 5.1 surround setup.

Connecting external effect processors (Cubase SX only)

You can connect external effects and use these as Send or Insert effects in Cubase. This is done by configuring External FX Send/Return buses in the VST Connections window. Connected effects are selectable from the effect pop-up menus just like internal effects.
Recording from a CD player

Most computers come with a CD-ROM drive that can also be used as a regular CD player. In some cases the CD player is internally connected to the audio hardware so that you can record the output of the CD player directly into Cubase SX/SL (consult the audio hardware documentation if you are uncertain).

- All routing and level adjustments for recording from a CD (if available) are done in the audio hardware setup application (see page 40).
- You can also grab audio tracks directly from a CD in Cubase SX/SL (see the Operation Manual).

Word Clock connections

If you are using a digital audio connection you may also need a word clock connection between the audio hardware and external devices. Please refer to the documentation that came with the audio hardware for details.

It is very important that word clock synchronization is done correctly or there might be clicks and crackles in recordings that you make!

About recording levels and inputs

When you connect your equipment, you should make sure that the impedance and levels of the audio sources and inputs are matched. Typically, different inputs may be designed for use with microphones, consumer line level (-10 dBV) or professional line level (+4 dBV), or you may be able to adjust input characteristics on the audio interface or in its control panel. Please check the audio hardware documentation for details.

Using the correct types of input is important to avoid distortion or noisy recordings. For more information about checking input levels, see page 110.

Cubase SX/SL does not provide any input level adjustments for the signals coming in to your audio hardware, since these are handled differently for each card. Adjusting input levels is either done in a special application included with the hardware or from its control panel (see below).
Making settings for the audio hardware

Most audio cards come with one or more small applications that allow you to configure the inputs of the hardware to your liking.

This includes:

- Selecting which inputs/outputs are active.
- Setting up word clock synchronization (if available).
- Turning monitoring via the hardware on/off (see page 46).
- Setting levels for each input. This is very important!
- Setting levels for the outputs, so that they match the equipment you use for monitoring.
- Selecting digital input and output formats.
- Making settings for the audio buffers.

In many cases all available settings for the audio hardware are gathered in a control panel, which can be opened from within Cubase SX/SL as described below (or opened separately, when Cubase SX/SL isn’t running). In some cases there may be several different applications and panels – please refer to the audio hardware documentation for details.
Selecting a driver and making audio settings in Cubase SX/SL

The first thing you need to do is select the correct driver in Cubase SX/SL to make sure that the program can communicate with the audio hardware:

1. Launch Cubase SX/SL, select Device Setup from the Devices menu and click on VST Audiobay in the list.

The VST Audiobay panel in the Device Setup dialog.

2. Select your audio hardware driver from the Master ASIO Driver menu. There may be several options here that all refer to the same audio hardware. When you have selected a driver, it is added to the Devices list.

Under Windows, we strongly recommend that you access your hardware via an ASIO driver written specifically for the hardware, if available. If no ASIO driver is installed we recommend that you check with your audio hardware manufacturer if they have an ASIO driver available, for example for download via the Internet.

3. Select the driver in the Devices list to open the Driver settings for your audio hardware.
4. Bring up the control panel for the audio hardware and adjust the settings as recommended by the audio hardware manufacturer.

- Under Windows, you can open the control panel by clicking the Control Panel button.
  The control panel that appears when you click this button is provided by the audio hardware manufacturer and not Cubase SX/SL (unless you use DirectX or MME, see below). Hence it will be different for each audio card brand and model.
  The Control panels for the ASIO Multimedia and ASIO DirectX drivers are an exception, as they are provided by Steinberg. They are described in the HTML Help, opened by clicking the Help button in the respective dialog. See also the notes below.

- Under Mac OS X, you will find the control panel for your audio hardware in the System Preferences (“Other” section), opened from the Apple menu or from the Dock.
  If you are using the built-in audio hardware of the Macintosh, you use the “Sound” control panel in the System Preferences to set levels, balance, etc.
  If you are using ASIO audio hardware, you can click the Control Panel button to bring up its panel.

5. If you plan to use several audio applications simultaneously, you may want to activate the option “Release ASIO Driver in Background” on the VST Audiobay page. This will allow another application to play back via your audio hardware even though Cubase SX/SL is running.
  The application that is currently active (i.e. the “top window” on the desktop), will get access to the audio hardware. Make sure that any other audio application accessing the audio hardware is also set to release the ASIO (or Mac OS X) driver so Cubase SX/SL can use it when it becomes the active application again.

6. If your audio hardware and its driver support ASIO Direct Monitoring, you may want to activate the Direct Monitoring checkbox.
  Read more about monitoring later in this chapter and in the Recording chapter in the Operation Manual.

7. Click Apply and then OK to close the dialog.
If you are using audio hardware with a DirectX driver (Windows only)

If your Windows audio hardware doesn't have a specific ASIO driver, a DirectX driver is the next best option.

Cubase SX/SL comes with a driver called ASIO DirectX Full Duplex, available for selection on the Master ASIO Driver pop-up menu (VST Audiobay page).

- To be able to take full advantage of DirectX Full Duplex, the audio hardware must support WDM (Windows Driver Model) in combination with DirectX version 8.1 or higher.
  In all other cases, the audio inputs will be emulated by DirectX (see the HTML Help for the ASIO DirectX Full Duplex Setup dialog for details about how this is reported). Since using emulated inputs will result in higher latency, you may want to use the ASIO Multimedia driver instead, as this gives you more possibilities to fine-tune the settings.

- During the installation of Cubase SX/SL, the latest DirectX will be installed on your computer.
  When the ASIO DirectX Full Duplex driver is selected in the Device Setup dialog, you can open the ASIO Control Panel and adjust the following settings (for more details, click the Help button in the control panel):
  - Direct Sound Output and Input Ports
    In the list to the left in the window, all available Direct Sound Output and Input Ports are listed. In many cases, there will only be one Port in each list. To activate or deactivate a Port in the list, click the checkbox in the left column. If the checkbox is ticked, the port is activated.

  - You can edit the Buffer Size and Offset settings in this list if necessary, by double clicking on the value and typing in a new value.
    In most cases the default settings will work fine. Audio buffers are used when audio data is transferred between Cubase SX/SL and the audio card. While larger buffers ensure that playback will occur without glitches, the latency (the time between the moment Cubase SX/SL sends out the data and when it actually reaches the output) will be higher.

  - Offset
    If a constant offset is audible during playback of Audio and MIDI recordings, you can adjust the output or input latency time using this value.
If you are using audio hardware with a Windows Multimedia (MME) driver

When you select the ASIO Multimedia Driver for the first time, the system will ask you whether you want to test the configuration. We strongly recommend that you perform this test. If it fails, or if you for other reasons need to make adjustments to your ASIO Multimedia configuration, click the Control Panel button to open the ASIO Multimedia Setup control panel included with Cubase SX/SL. This control panel comes with an HTML Help describing the features and procedures.

Setting up the input and output ports

Once you have selected the driver and made the settings as described above, you need to specify which inputs and outputs should be used and name these:

1. In the Device Setup dialog, select VST Outputs in the list to the left.

All output ports on the audio hardware are listed.
2. To hide an output port, click in the “Visible” column for the port (so that it says “No”).
   Ports that aren’t visible cannot be selected in the VST Connections window where you set up your input and output busses – see page 107.

   If you attempt to hide a port that is already used by a bus you will be asked whether this is really what you want – note that this will disable the output port!

3. To rename a port, click on its name in the list and type in a new name.

   • It is a good idea to give your ports generic names that are related to the channel configuration (rather than to the actual hardware model)!
   For example, if you are using a 5.1 surround audio setup (Cubase SX only), you could name the six ports Left, Right, Center, Lfe, Left Surround and Right Surround. This makes it easier to transfer your projects between different computers, e.g. in different studios – if the same port names are used on both computers, Cubase SX will automatically handle the bus connections properly when you open the project on the other computer.

4. Select VST Inputs in the list to the left and set up the input ports in the same way.

5. Click OK to close the Device Setup dialog and apply your changes.
About monitoring

In Cubase SX/SL, monitoring means listening to the input signal while preparing to record or while recording. There are basically three ways to monitor:

External monitoring

External monitoring (listening to the input signal before it goes into Cubase SX/SL) requires an external mixer for mixing the audio playback with the input signal. This mixer could be a stand-alone physical mixer or a mixer application for your audio hardware, if this has a mode in which the input audio is sent back out again (usually called “Thru”, “Direct Thru” or similar).

Via Cubase SX/SL

In this case, the audio passes from the input into Cubase SX/SL, possibly through Cubase SX/SL effects and EQ and then back to the output. You then control monitoring via settings in Cubase SX/SL.

This allows you to control the monitoring level from Cubase SX/SL and add effects to the monitored signal only.

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring (this feature may also be available for audio hardware with Mac OS X drivers). In this mode, the actual monitoring is done in the audio hardware, by sending the input signal back out again. However, monitoring is controlled from Cubase SX/SL. This means that the audio hardware’s direct monitoring feature can be turned on or off automatically by Cubase SX/SL.

Monitoring is described in detail in the Recording chapter in the Operation Manual. However, when setting up, there’s one thing to note:

- If you want to use the external monitoring via your audio hardware, make sure the corresponding functions are activated in the card’s mixer application.
Setting up MIDI

Always make all connections with all equipment turned off!

This section describes how to connect and set up MIDI equipment. If you have no MIDI equipment you can skip this section.

Connecting the MIDI equipment

Below follows a description of a typical but small setup example. You might need or want to hook things up differently!

In this example we assume that you have a MIDI keyboard and an external MIDI sound module. The keyboard is used both for feeding the computer with MIDI messages for recording and for playing back MIDI tracks. The sound module is used for playback only. Using Cubase SX/SL’s MIDI Thru feature (described later) you will be able to hear the correct sound from the sound module while playing the keyboard or recording.

A typical MIDI Setup.
You might want to use even more instruments for playback. If you do, simply connect MIDI Thru on the sound module to MIDI In on the next instrument, and so on. In this hook-up, you will always play the first keyboard when recording. But you can still use all your devices for providing sounds on playback.

If you plan to use more than three sound sources we recommend that you either use an interface with more than one output, or a separate MIDI Thru box instead of the Thru jacks on each unit.

**Setting MIDI Thru and Local On/Off**

In the “MIDI” section in the Preferences dialog (located on the File menu under Windows and on the Cubase SX/SL menu under Mac OS X), you will find a setting called “MIDI Thru Active” which can be enabled or not. This is related to a setting in your instrument called “Local On/Off” or “Local Control On/Off”.

- If you use a MIDI keyboard instrument, as described earlier in this chapter, MIDI Thru should be activated and that instrument should be set to Local Off (sometimes called Local Control Off – see the instrument’s operation manual for details). This will let the MIDI signal from the keyboard get recorded into Cubase SX/SL and at the same time re-routed back to the instrument so that you hear what you are playing, without the keyboard “triggering” its own sounds.
If you use a separate MIDI keyboard – one that does not produce any sounds itself – MIDI Thru in Cubase SX/SL should also be activated, but you don’t need to look for any Local On/Off setting in your instruments.

The only case where MIDI Thru should be deactivated is if you use Cubase SX/SL with only one keyboard instrument and that instrument cannot be set to Local Off mode.

Note that MIDI Thru will only be active for MIDI tracks that are record enabled and/or have the monitor button activated. See the Recording chapter in the Operation Manual for more information.
Setting up MIDI ports in Cubase SX/SL

The Device Setup dialog lets you set up your MIDI system in the following ways:

- **Note:** After changing a setting in the Device Setup dialog, you should click Apply and then click OK to close the dialog.

### Showing or hiding MIDI Ports

Under Windows, the MIDI ports are listed in the Device Setup dialog on the DirectMusic page and/or the Windows MIDI page (depending on your system). By clicking in the “Show” column for a MIDI input or output, you can specify whether or not it should be listed on the MIDI pop-up menus in the program.

Under Mac OS X, you can hide or show MIDI ports on the MIDI System page in the Device Setup dialog.

- Hiding a MIDI port from view does not turn it off if it’s already selected for a track or a MIDI device.

### Setting up the “All MIDI Inputs” option

When you record MIDI in Cubase SX/SL, you can specify which MIDI input each recording MIDI track should use. However, you can also select the “All MIDI Inputs” option, which causes any MIDI data from any MIDI input to be recorded.

The All MIDI Inputs page in the Device Setup dialog allows you to specify which inputs should be included when you select All MIDI Inputs for a MIDI track. This can be especially useful if your system provides several instances of the same physical MIDI input – by deactivating the duplicates you make sure only the desired MIDI data is recorded.

- If you have a MIDI remote control unit connected you should also make sure to deactivate that MIDI input on the All MIDI Inputs page.
  This is to avoid accidentally recording the data from the remote control when the “All MIDI Inputs” option is selected as input for a MIDI track.
Setting up a default MIDI input and output

The Default MIDI Ports page in the Device Setup dialog allows you to select which MIDI ports should be selected by default when you create a new MIDI track. In other words, newly created tracks will always use the input and output specified on this page. However, you can later change this setting for each individual track in the Project window.

Connecting a synchronizer

Always make all connections with all equipment turned off!

When using Cubase SX/SL with external tape transports you will most likely need to add a synchronizer to your system. All connections and setup procedures for synchronization are described in the Synchronization chapter in the Operation Manual.
Setting up video

Always make all connections with all equipment turned off!

Cubase SX/SL plays back video films in AVI, Quicktime or MPEG formats. Under Windows, video playback can be done using one of the following playback engines: Video for Windows, DirectShow or Quicktime. This ensures compatibility with as wide a range of video files as possible. Under Mac OS X, Quicktime is always used as playback engine.

Generally there are two ways to play back video:

- Without any special hardware at all, using the computer CPU. In this case, the “codec” is in software. While this will be fine in many situations it does put a limit on the size of the video window as well as the quality of the image.

- Using video hardware that for example connects to an external monitor.
  Mac OS X: Using a FireWire port, you can play back video on an external monitor using a DV-to-analog converter or a DV camera (see also the Video chapter in the Operation Manual).
  Windows: Multi-head graphics cards which support overlay functionality can be used to display the video picture on an external monitor. As of this writing, the following manufacturers have working solutions available: nVIDIA and Matrox.

If you plan to use special video hardware, install it and set it up as recommended by the manufacturer.

Before you use the video hardware with Cubase SX/SL, we recommend that you test the hardware installation with the utility applications that came with the hardware and/or the Windows Media Player or Quicktime Player (Mac OS X) applications.
Optimizing audio performance

This section gives you some hints and tips on how to get the most out of your Cubase SX/SL system, performance-wise. Some of this text refers to hardware properties and can be used as a guide when upgrading your system. This text is very brief. Look for details and current information on the Cubase SX/SL web site (see page 14)!

Two aspects of performance

There are two distinct aspects of performance in respect to Cubase SX/SL:

Tracks and effects

Simply put: the faster your computer, the more tracks, effects and EQ you will be able to play. Exactly what constitutes a “fast computer” is almost a science in itself, but some hints are given below.

Short response times (latency)

Another aspect of performance is response times. Latency is a phenomenon based on the fact that in a computer, audio has to be “buffered” (stored) in small chunks during various steps of the recording and playback process. The more and larger those chunks, the higher the latency.

High latency is most troublesome when playing VST Instruments and when monitoring through the computer, that is when listening to a live audio source via the Cubase SX/SL Mixer and effects. However, very long latency times (several hundred milliseconds) can hamper other processes like mixing, since e.g. a fader movement will affect the audio noticeably late.

While Direct Monitoring and other techniques reduce the problems associated with very long latency times, a system that responds fast will always be more convenient to work with.

- Depending on your audio hardware, it may be possible to “trim” your latency times, usually by lowering the size and number of buffers. For details, refer to the audio hardware documentation, or, if you are using a DirectX or MME driver under Windows, the HTML Help.
System factors that affect performance

CPU and processor cache

It goes without saying that the faster the computer processor, the better. But there are a number of factors that affect the apparent speed of a computer: the bus speed and type (PCI is strongly recommended), the processor cache size and of course, the processor type and brand. Cubase SX/SL relies heavily on floating point calculations. When shopping for a processor, please make sure you get one that is powerful in calculating floating point arithmetics.

Note also that Cubase SX/SL features full support for multi-processor systems. So if you own a computer system with more than one processor, Cubase SX/SL can take advantage of the total capacity and evenly distribute the processing load to all available processors. See page 55.

Hard disk and controller

The number of hard disk tracks you can record and play back at the same time also depends on the speed of your hard disk and hard disk controller. If you use E-IDE disks and controllers, make sure that the transfer mode is DMA Busmaster. Under Windows, you can check the current mode by launching the Windows Device Manager and looking for properties of the IDE ATA/ATAPI Controller’s primary and secondary channel. DMA transfer mode is enabled by default, but may be turned off by the system should hardware problems occur.

Audio hardware and driver

The hardware and its driver can have some effect on regular performance. A badly written driver can reduce the performance of your computer. But where the hardware driver design makes the most difference is with latency.

Again, we strongly recommend that you use audio hardware for which there is a specific ASIO driver!

This is especially true when using Cubase SX/SL for Windows:

- Under Windows, ASIO drivers written specifically for the hardware are more efficient than MME or DirectX drivers and produce shorter latency times.
Under Mac OS X, audio hardware with properly written Mac OS X (Core Audio) drivers can be very efficient and produce very low latency times. However, there are additional features currently only available with ASIO drivers, such as the ASIO Positioning Protocol.

Making settings that affect performance

Choosing a driver for your audio hardware

As described on page 41, it is recommended to install and use a standard ASIO driver if available for your specific hardware. Check the manufacturers web site for the latest drivers etc.

Making audio buffer settings

Audio buffers affect how audio is sent to and from the audio hardware. The size of the audio buffers affect both the latency and the audio performance. Generally, the smaller the buffer size, the lower the latency. On the other hand, working with small buffers can be demanding for the computer. If the audio buffers are too small, you may get clicks, pops or other audio playback problems.

Under Mac OS X, you can adjust the size of the buffers on the VST Audiobay page in the Device Setup dialog. You may also find buffer settings in the control panel for the audio hardware.

Under Windows, you adjust the buffer size settings in the control panel for the audio hardware (opened by clicking the Control Panel button on the driver page in the Device Setup dialog).

The Expert settings

On the VST Audiobay page you will find a button called “Expert…”. This opens a dialog with advanced settings for the VST Engine, including a Multi Processing switch. When this is activated (default setting if you have a hyper-threading or multiple-CPU system – in a single-CPU system, this option is greyed out) and there is more than one CPU in your system, the processing load is distributed evenly to all available CPUs, allowing Cubase SX/SL to make full use of the combined power of the multiple processors. See the Online Help for details.

Activating the “Lower Latency” option will basically disable the CPU overload protection, but allow for lower latencies. See the Online Help for details.
Optimizing processor scheduling (Windows only)

To get the lowest possible latencies when using ASIO under Windows XP (on a single CPU system), the “system performance” has to be optimized for background tasks:

1. Open the Control Panel from the Start menu and select System.
2. Select the Advanced tab and click the Settings button in the Performance section.
   The Performance Options dialog appears.
3. Select the Advanced tab.
4. In the Processor Scheduling section, select “Adjust for best performance of: Background services”
5. Click OK to close the dialogs.
Basic Cubase SX/SL concepts
About this chapter

This chapter describes the basic “building blocks” and terminology in Cubase SX/SL. Please take your time to read this chapter thoroughly before moving on!

The project

The native document format of Cubase SX/SL is called a project. Before you can start recording, playing back or editing you always have to create a new project, or open a saved project file from disk. There can be several projects open at the same time, but one is always the active project.

Two Project windows in Cubase SX/SL. Here, the project “on top” is the active project, as indicated by the lit blue indicator in the upper left corner of the window.
About the file and folder structure

A project file (file extension ".cpr" under Windows) is always associated with a project folder on your hard disk. Several projects can share the same project folder (which is practical if you have several versions of your project, for example).

- The Audio folder contains audio files referenced by the project.
  It is also possible for the project to refer to audio files elsewhere on your disk(s) – you can even specify different folders for different audio tracks when recording. However, having all audio files in the project’s Audio folder makes the project easy to move and archive, and is a good safety measure.

- The Edits folder contains audio files created automatically by editing and processing operations in Cubase SX/SL.
  As a rule, you shouldn’t touch the files in this folder. To remove unused edit files, it is better to use the Cleanup function, as described in the Operation Manual.

- The Images folder contains waveform images for the audio files in the project.

- The Freeze folder contains audio files generated by the Track and Instrument Freeze function.
  This function (described in the Operation Manual) renders the output of audio tracks and VST Instruments to temporary audio files, allowing you to conserve processor power. You shouldn’t touch these files.

- The project file itself contains all references to audio and video files, along with playback information, MIDI data and settings for the project (such as sample rate, frame rate, etc.).

- Video files are never automatically copied to the project folder.
  This is because video files are often very large, and it doesn’t make sense to copy them into different project folders. However, nothing stops you from creating a Video folder inside the project folder and storing your video files there.

- You may also find additional files in the project folder.
  For example, Cubase SX/SL’s Auto Save feature stores backup copies of the project file in its project folder.
Audio terminology

When you record audio in Cubase SX/SL, this is what happens:

- An audio file is created on the hard disk.
- In Cubase SX/SL, an audio clip is created. The audio clip refers to the audio file on disk.
- An audio event is also created in Cubase SX/SL. This plays back the audio clip.

There are good reasons for this long chain of references:

- The audio event is the object that you place on a time position in Cubase SX/SL. If you make copies of an audio event and move them to different positions in the project, they will still all refer to the same audio clip. Furthermore, each audio event has an Offset value and a Length value. These determine at which positions in the clip the event will start and end, i.e. which section of the audio clip will be played back by the audio event. For example, if you resize the audio event, you will just change its start and/or end position in the audio clip – the clip itself will not be affected.

- The audio clip does not necessarily refer to just one original recorded file! For example, if you apply some processing to a section of an audio clip, this will actually create a new audio file that contains only the section in question. The processing will then be applied to the new audio file only, leaving the original audio file unchanged. Finally, the audio clip is automatically adjusted, so that it refers both to the original file and to the new, processed file. During playback, the program will switch between the original file and the processed file at the correct positions. You will hear this as a single recording, with processing applied to one section only. This feature makes it possible to undo processing at a later stage, and to apply different processing to different audio clips that refer to the same original file.
Audio tracks, parts and channels

For an audio event to be played back in Cubase SX/SL, it has to be placed on an audio track. This is similar to a track on a multi-track tape recorder, and allows you to view the event and move it along the timeline. You can place any number of audio events on an audio track, but only one at a time can be played back. You can have a virtually unlimited number of audio tracks, although the number of tracks you can play back at the same time depends on your computer performance.

Even though audio events can be placed directly on audio tracks, sometimes it is convenient to gather several audio events into an audio part. This is simply a “container”, allowing you to move and duplicate several audio events as one.

An event and a part.

Each audio track has a corresponding audio channel in the mixer. This is much like a channel on a hardware mixer, allowing you to set levels and panning, add EQ and effects, etc.
**MIDI terminology**

When you are recording MIDI (or entering MIDI data manually in an editor), MIDI events are created. For example, each note you record is a separate MIDI event, and if you record the movement of a modulation wheel or other controller, a large number of densely spaced events are created.

MIDI events are always placed in MIDI parts. These are "containers", allowing you to move or copy a number of MIDI events (e.g. a recorded MIDI melody line) as one item.

MIDI parts are placed on MIDI tracks. For each MIDI track you can specify on which MIDI output and MIDI channel its MIDI events should be played back. This allows you to have different tracks play back different sounds, in the same or different MIDI instruments.

A MIDI part on a MIDI track. The black lines in the part indicate MIDI events.

**Video terminology**

- When you import a video file from disk into a Cubase SX/SL project, a video clip is created that refers to the file.
- A video event is then created, referring to the video clip. Video events can be moved, copied and resized without affecting their video clips.
- For a video event to be played back, it has to be placed on the video track. There can only be one video track in a Cubase SX/SL project.

The video support in Cubase SX/SL is described in its own chapter in the Operation Manual.
6

Basic Methods
About this chapter

This chapter contains descriptions of the general methods and procedures used in Cubase SX/SL. As this information applies to all parts of the program and all ways of working, please take time to read this chapter before continuing with the Operation Manual.

Using menus

Main menus

The menus in the main Cubase SX/SL menu bar are available regardless of which window is active. You select items from the main menus following the standard procedure for the operating system. Menu items that are not relevant in the current window may be greyed out.

Pop-up menus

Pop-up menus can be found throughout the program and are often used for selecting options or values. A pop-up menu is indicated by a small arrow in a field showing the currently selected option/value.

- To bring up the pop-up menu, click the arrow.
  Selecting is done as with regular menus.

Selecting from the Snap pop-up menu.
**The Quick menu**

In Cubase SX/SL, clicking the right mouse button will bring up a contextual pop-up menu (under Mac OS X you need to press [Ctrl] and click, or preferably use a two-button mouse set up so that the right mouse button generates a [Ctrl]-click).

Some areas have special context menus with functions or settings that only apply to the corresponding area (for example, right-clicking in a ruler brings up a pop-up menu with display format options).

However, right-clicking in the main area of a window brings up the Quick menu. As a rule, the Quick menu contains:

- The tools (provided that the window has tools), see page 66.
- The most relevant menu items from the main Cubase SX/SL menus.
- Settings that are specific for the window.

For example, in the Sample Editor the Quick menu contains settings determining which elements should be shown in the waveform display.

- If the option “Popup toolbox on right click” is activated in the Preferences dialog (Editing page), right-clicking (or [Ctrl]-clicking under Mac OS X) will instead bring up a dedicated toolbox, containing the tools only.

In that case you can bring up the Quick menu by pressing a modifier key (e.g., [Shift]) and right-clicking/[Ctrl]-clicking.
Using tools

Editing in Cubase SX/SL is largely done with the various tools. Typical examples are selecting and moving events with the Arrow (Object Selection) tool, drawing with the Pencil tool, deleting with the Eraser tool, etc. There are different tools for different windows.

Tools can be selected in four ways:

- By clicking the corresponding tool icon on the toolbar.
  When you click a tool icon, the pointer takes on the shape of the corresponding tool.

- By using the Quick menu.
  As described on page 65, clicking with the right mouse button in the main area of a window brings up the Quick menu. The tools will be listed (along with their corresponding icons) at the top of the menu – to select a tool, simply select it from the menu.
• By using the dedicated toolbox.
If the option “Popup toolbox on right click” is activated in the Preferences dialog (Editing page), right-clicking (or [Ctrl]-clicking under Mac OS X) will bring up the toolbox instead. This shows the tools only and you select tools as if from a menu.

![Toolbox](image)

Note that you can still bring up the Quick menu in this mode by pressing a modifier key (e.g. [Shift]) and right-clicking/[Ctrl]-clicking. Similarly, if the option isn’t activated in the Preferences dialog, you can bring up the toolbox in that way.

• By using key commands.
By default, the keys [1] - [9] on the alphanumeric part of the keyboard are used, so that pressing [1] selects the leftmost tool and so on. You can also use key commands to step between the tools on the toolbar. By default, pressing [F9] selects the previous tool and pressing [F10] selects the next tool.

The uses and purposes of the tools in the different windows are described in the corresponding chapters of the Operation Manual.

About tool tips
If you position the pointer over a tool icon (or any other icon or button in Cubase SX/SL), a label will appear after a moment, informing you of the function of the icon or button.

• This feature can be turned off by deactivating the option “Show Tips” on the General page in the Preferences dialog (found on the File menu under Windows and on the Cubase SX/SL menu under Mac OS X).
Changing values

Throughout the program you will encounter various value fields that can be edited. These can be divided into three categories: position values, regular numeric values and names.

Editing position values

Depending on the selected display format (see the Operation Manual), position values in Cubase SX/SL are usually divided into several "segments" (the exception being the “Samples” display format, in which values are edited as regular numeric values). Two examples:

If the “Seconds” display format is selected, positions are shown as “hours:minutes:seconds.milliseconds”.

If the “Bars+Beats” display format is selected, positions are shown as “bars.beats.sixteenth notes.ticks” (with 120 ticks per sixteenth note, by default).

Each value segment can be edited separately, in one of the following ways:

- Point at the upper or lower edge of the segment and click.
  Clicking at the upper edge will raise the value of the segment one step, clicking at the lower edge will lower the value.

- Click directly on the value segment, type in a new value and press [Return].

- If you are using a wheel mouse, point at the value segment and use the wheel to raise or lower its value.
  Generally, we recommend that you use a wheel mouse, as this speeds up editing in many areas in Cubase SX/SL.
You can also edit the whole value (all segments) by double clicking and typing in a new value. Note:

- To separate the value segments, you can use spaces, dots, colons or any other character that isn’t a number.

- If the “Bars+Beats” display format is selected, and you enter a value with less than four segments, the largest position value segments will be affected and the program will set the lesser segments to their lowest values. For example, if you enter “5.3”, the position will be set to “5.3.1.0”.

- If one of the frame based display formats is selected and you enter a value with less than four segments, the smallest position value segments will be affected and the program will set the larger segments to their lowest values. For example, if you enter “2:5”, the position will be set to “0:0:2:5”.

- If the “Seconds” display format is selected, value editing works as with the frame based formats, with one addition: The smallest value segment (milliseconds) is considered to be the decimal part of the seconds segment. This means that if you enter “2:50”, the position will be set to “0:0:2:500”, rather than “0:0:2:050”.

**Editing regular numeric values**

Numeric values other than positions are edited by clicking the value and editing numerically from the computer keyboard.

In the Preferences dialog (Editing–Controls page) you can specify what should happen when you click on a value field. The “Value Box/Time Control Mode” item contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Input on Left-Click</td>
<td>In this mode, clicking a value box will open it for editing by typing.</td>
</tr>
<tr>
<td>Increment/Decrement on Left/Right-Click</td>
<td>In this mode you can click with the left or right mouse button to decrease or increase the value, respectively. To edit values by typing in this mode, please double-click.</td>
</tr>
<tr>
<td>Increment/Decrement on Left-Click and Drag</td>
<td>In this mode, you can click and drag up or down to adjust the value (much like dragging a vertical fader). To edit values by typing in this mode, please double-click.</td>
</tr>
</tbody>
</table>
In the Inspector and elsewhere in the program you can find value sliders that may be blue or green – click and drag to adjust the value.

For some values, you can hold down [Alt]/[Option], click on the value and keep the mouse button pressed to display a value slider. This allows you to scroll the value by dragging up or down with the mouse button pressed. When you release the mouse button, the value slider is hidden again.

Most values can also be edited using a wheel mouse: point at the value and use the wheel to raise or lower it.

**Editing names**

To edit a name, click on it, type a new name and press [Return] (or click outside the name field).
Using knobs and sliders

In the VST audio windows, most parameters are shown as knobs, sliders and buttons, emulating hardware interfaces. For knobs and sliders, you can select the desired way of making adjustments in the Preferences dialog (Editing–Controls page):

![Editing-Controls]

Knobs

The Knob Mode pop-up menu contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circular</td>
<td>To move a knob, you click on it and drag in a circular motion, much like turning a “real” knob. When you click anywhere along the knob’s edge, the setting is immediately changed.</td>
</tr>
<tr>
<td>Relative Circular</td>
<td>Works like the “Circular” option, but clicking does not automatically change the setting. This means you can make adjustments to the current setting by clicking anywhere on a knob and dragging, without having to click on the exact current position.</td>
</tr>
<tr>
<td>Linear</td>
<td>To move a knob, you click on it and drag up or down with the mouse button pressed – as if the knob were a vertical slider.</td>
</tr>
</tbody>
</table>

Sliders

The Slider Mode pop-up menu contains the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump</td>
<td>In this mode, clicking anywhere on a slider will make the slider handle instantly move to that position.</td>
</tr>
<tr>
<td>Touch</td>
<td>In this mode, you have to click on the actual slider handle to adjust the parameter. This reduces the risk of accidentally moving sliders.</td>
</tr>
<tr>
<td>Ramp</td>
<td>In this mode, clicking anywhere on a slider (but not on the handle) and keeping the mouse button pressed, will cause the handle to move smoothly to the new position.</td>
</tr>
</tbody>
</table>
Selecting objects

Selecting Cubase SX/SL objects such as audio and MIDI events is generally done with the Arrow tool, according to standard selection procedures.

- Clicking on an object selects it (and deselects any previously selected objects).
- Holding down [Shift] and clicking on an object selects it without deselecting any other objects.
- You can also create a selection rectangle by clicking in an empty area and dragging with the mouse button pressed. All objects partially or totally enclosed by the rectangle will be selected.
- If an object is already selected, you can use the left and right arrow key on the computer keyboard to select the previous or next object, respectively. Holding down [Shift] and using the arrow keys allows you to select the previous/next object without deselecting the current object.

There are several additional ways to make selections in the different Cubase SX/SL windows. These are described in the corresponding Operation Manual chapters.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative</td>
<td>In this mode, clicking anywhere on a slider does not automatically change the setting, but you can make adjustments to the current setting by clicking anywhere on a slider and dragging, without having to click on the exact current position.</td>
</tr>
</tbody>
</table>
Zoom and view techniques

Scrolling the view

If the active window isn’t large enough to show all its contents, you can scroll the view by using the standard window scroll bars. However, if you are using a wheel mouse, there are two additional ways to scroll:

- Rolling the wheel will scroll the view vertically.
  If you hold down [Shift] and use the wheel, the view will be scrolled horizontally. Just make sure not to point at a value field, as this will edit the value instead.

- If you aim in the main area of a window, click the wheel and keep it pressed, the pointer takes on the shape of a hand. You can now scroll the view freely by dragging the mouse horizontally and/or vertically.

Zooming

All windows that contain graphical displays can be zoomed horizontally and vertically. While some windows have special zoom functions (see the respective chapters in the Operation Manual), a few methods are commonly available:

Using the zoom sliders

In the lower right corner of all zoomable displays, you will find two zoom sliders.

- To zoom in horizontally, drag the horizontal zoom slider handle to the right.

- To zoom in vertically, drag the vertical zoom slider upwards.
  There is one exception to this: in the Project window, dragging the vertical zoom slider upwards will decrease the height of Tracks (in effect, zooming out). See the chapter “The Project Window” in the Operation Manual.
Clicking on a zoom slider will move the handle to the click position, instantly changing the magnification.

If the project cursor is visible when you zoom in or out horizontally, the magnification will be "centered on the cursor". In other words: if possible, the project cursor will remain in the same position on screen.

### Using the Magnifying Glass tool

You can use the Magnifying Glass tool to zoom in and out horizontally, using the following methods:

- **Click once to zoom in one step.**
  Zooming will be centered on the click position.

- **Double click (or press [Alt]/[Option] and click) to zoom out one step.**

- **Draw a zoom rectangle by pressing the mouse button, dragging the pointer and releasing the mouse button.**
  The view will zoom in horizontally, so that only the area enclosed in the zoom rectangle is visible.

### Using the Zoom submenu

At the bottom of the Edit menu, you will find a Zoom submenu with various zoom functions. Exactly which items on the submenu are available depends on the currently active window.

- **The Zoom submenu is also available as a separate menu item on the Quick menu.**

- **As with any menu item, you can specify key commands for the functions on the Zoom submenu, for quick access.**
  Key commands are set up in the Key Commands dialog on the File menu. This is described in a separate chapter in the Operation Manual.
Zooming in the ruler

If the option “Zoom while Locating in Time Scale” is activated in the Preferences dialog (Transport page), you can use the rulers for zooming. This allows you to quickly zoom in or out on a certain position, without having to select a special tool:

1. Click in the ruler and keep the mouse button pressed.
   The project cursor is automatically moved to the click position. If you don’t want to move the cursor, press [Shift] and click in the ruler instead.

2. Drag down to zoom in (horizontally) or drag up to zoom out.
   Zooming will be centered on the project cursor.

Zooming in the overview

By clicking the Show Overview button on the toolbar, an extra pane appears under the toolbar: the project overview line.

![The Show Overview button.](image)

In the overview line, events and parts on all tracks are displayed as boxes. You can use the overview line to zoom in or out, and for navigating to other sections of the project. This is done by moving and resizing the track view rectangle in the overview line:

- The track view rectangle indicates the section of the project currently displayed in the event display.
- You can zoom in or out vertically by resizing the track view rectangle.
  Resizing is done by dragging the edges of the rectangle.
- You can drag the track view rectangle to view other sections of the project.
  The number of tracks shown will not change.
Window handling

Generally, Cubase SX/SL windows are handled according to the standard procedures. However, the Window menu contains some functions that make work quicker and easier:

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Closes the currently active window. If this is a Project window, you will close the current project.</td>
</tr>
<tr>
<td>Close All</td>
<td>Closes all windows, including all open projects.</td>
</tr>
<tr>
<td>Minimize All</td>
<td>Minimizes all windows.</td>
</tr>
<tr>
<td>Restore All</td>
<td>Restores all minimized Cubase SX/SL windows.</td>
</tr>
<tr>
<td>Tile Horizontally/Vertically (Windows version only)</td>
<td>Arranges the open windows next to each other on screen.</td>
</tr>
<tr>
<td>Cascade (Windows version only)</td>
<td>Arranges the open windows in a partially overlapping pattern.</td>
</tr>
<tr>
<td>Workspaces</td>
<td>Allows you to set up different window combinations and store these for instant recall. See page 244 and the Operation Manual.</td>
</tr>
<tr>
<td>Windows...</td>
<td>See below.</td>
</tr>
<tr>
<td>The open windows list</td>
<td>Selecting a window from the list at the bottom of the menu brings it to front.</td>
</tr>
</tbody>
</table>

The open windows list is a list of all open windows, which can be used to quickly switch between them.
The Windows dialog

By selecting “Windows…” from the Window menu, you open the Windows dialog. This allows you to manage the open windows in various ways.

The display to the left lists all open windows, hierarchically arranged (so that editors and other windows that belong to a certain project are listed under the corresponding Project window). To the right are various window functions. To use one of the functions, proceed as follows:

1. Click in the field below the OK button to select one of the selection modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected</td>
<td>Only the windows selected in the list will be affected.</td>
</tr>
<tr>
<td>Cascaded</td>
<td>The selected windows will be affected, along with all their “sub-windows”. Typically, if a Project window is selected in the list, all open windows belonging to that project will be affected.</td>
</tr>
<tr>
<td>All</td>
<td>All windows will be affected, regardless of the selection.</td>
</tr>
</tbody>
</table>

2. If you chose the “Selected” or “Cascaded” modes, select the desired windows by clicking in the list. As usual, you can select multiple items by holding [Shift] or [Ctrl]/[Command] and clicking.

3. Use the buttons to the right to activate (bring to front), minimize, restore or close the specified window(s). Closing a window will also remove it from the list.

4. When you are done, click OK to close the dialog.
The Devices panel

If you like, you can manage devices from a central Devices panel:

1. Pull down the Devices menu and select “Show Panel". The Devices Panel appears.

2. To display a closed or hidden window, click on its button in the Devices panel.

3. Clicking the button again will close the window.
Undo

There are two ways to undo operations in Cubase SX/SL: by using “regular Undo” and by using the Offline Process History.

- The regular Undo can be applied to virtually all actions you perform, in multiple levels. It is accessed by using the “Undo”, “Redo” and “History” items on the Edit menu, as described below.
- The Offline Process History allows you to remove and modify applied processing, and is different from the “regular” Undo in that you don’t have to undo processing functions in the order they were performed. The Offline Process History is described in the chapter “Audio Processing” in the Operation Manual.

The Undo and Redo commands

Cubase SX/SL offers wide-ranging, multiple Undo, allowing you to undo virtually any action you perform.

- To undo the last performed action, select Undo from the Edit menu or use the corresponding key command (by default [Ctrl]/[Command]-[Z]). If you select Undo again, the previously performed action will be undone, and so on.
- To redo the last undone action, select Redo from the Edit menu or use the corresponding key command (by default [Ctrl]/[Command]-[Shift]-[Z]). Undone actions will be available for Redo until you perform another action (at which point the “Redo stack” is cleared – see below).

You can specify how many levels of Undo should be available with the “Maximum Undo” setting on the General page in the Preferences dialog on the File menu (Windows) or Cubase SX/SL menu (Mac).
The Edit History window

Selecting “History…” from the Edit menu opens the Edit History window. This contains a graphic representation of the “Undo stack” (the performed actions, with the most recent action at the top of the stack) and the “Redo stack” (the undone actions, with the most recently undone action at the bottom of the stack). The two stacks are separated by a divider line.

The most recently undone action.

The most recently performed action.
The Edit History dialog allows you to undo or redo several actions in one go, by moving the divider between the Undo stack and the Redo stack (in essence, moving actions from the Undo stack to the Redo stack, or vice versa):

1. Click on the divider line and drag it up or down.
   Drag up to redo actions, drag down to undo them.

   ![Edit History dialog](image)

   In this case, three more actions will be undone (and moved to the Redo stack).

   • You can also click directly between two items in the list, instantly moving the divider line.

   • When you move the divider line by dragging or clicking, the actions are immediately undone or redone.
   The changes are reflected in all open Cubase SX/SL windows.

2. When you're finished, click OK to close the dialog.

   The Undo and Redo stacks are cleared when you close a project.
7

Guided Tour
The main windows in Cubase SX/SL

The Project window

The Project window is the main window in Cubase SX/SL. This provides you with a graphic overview of the project, allowing you to navigate and perform large scale editing. The Project window is divided vertically into tracks and has a time line going from left to right. Each project has one Project window.
The Project Browser

The Project Browser provides a list based representation of the project. This allows you to view and edit all events on all tracks by using regular value editing in a list.

The Transport panel

The Transport panel features transport controls, much like those found on a conventional tape recorder. It can also be used for locating Marker positions, setting tempo and time signature, etc.

- Note that you can customize the appearance of the Transport panel! You can remove controls that you don’t need to use or even change the positions of the different sections on the panel. This is described in the Customizing chapter in the Operation Manual.
The Pool

All files, audio or video, that belong to a project are listed in the Pool. There is a separate Pool for every project. In the Pool you can organize, convert and audition clips, amongst many other things.
The Sample Editor

In the Sample Editor you can view and manipulate audio, by cutting and pasting, removing or drawing audio data. By using the Offline Process History, you can undo changes or revert to the original versions at any point.

Thumbnail overview

Waveform view

A selected range
The MIDI editors

Editing MIDI data is done using the MIDI editors. The following editors are available:

**Key Editor**

The Key Editor shows the contents of one or several MIDI parts. The MIDI notes are represented by “boxes”, whose vertical position corresponds to their pitch.

This box represents a MIDI note.

This section is called the controller display. It shows “continuous” MIDI events (such as controllers) or as in this figure, the velocity values of notes.
In-Place editing

The In-Place editing function allows you to edit events and parts directly in the Project window, in context with other tracks. It is very similar to the Key editor.

Score Editor

The Score Editor shows MIDI notes as a musical score.

- Cubase SL comes with a basic Score Editor – this is described in the Operation Manual.
- Cubase SX comes with a full Score Editor, with advanced tools and functions for notation, layout and printing. This is described in the separate pdf document “Score Layout and Printing”.

Guided Tour  CUBASE SX/SL  7 – 89
List Editor

The List Editor shows MIDI events as a list, allowing you to view and edit their properties numerically.

Drum Editor

The Drum Editor is similar to the Key Editor, but takes advantage of the fact that with drum parts, each key corresponds to a separate drum sound.
**Tempo Track Editor**

For each audio and MIDI track, you can specify whether it should use a musical or linear Time base. Tempo based tracks follow a tempo, which can either be fixed through the whole project or follow the Tempo Track. In the Tempo Track Editor you can draw curves that determine how the tempo will change over time or record tempo changes in real time.
The Mixer

The Mixer is where you mix your audio and MIDI channels, that is, adjust the levels (volume), panning, effect sends, EQ, etc. You will also find channel strips for the output busses here (as well as input busses and a dedicated bus for auditioning functions – Cubase SX only).

- There are 3 different mixer windows (2 in Cubase SL) that can be configured to show different views of the mixer. This allows you to e.g. control all audio channels in one window and all VST Instrument channels in another.

- In Cubase SX, each audio channel in the mixer can carry up to 6 speaker channels. Surround sound is fully supported in Cubase SX, from the input busses via audio mixer channels to the output busses.
Channel Settings

The Channel Settings window is used for adding effects and EQ to individual channels. Each mixer channel has its own Channel Settings window.

VST Connections

This is where you set up input and output busses – the audio connections between Cubase SX/SL and the inputs and outputs on your audio hardware.
Quick start for former Cubase users
Introduction

This chapter is intended as a quick start for users that are familiar with previous versions of Cubase (i.e. pre-SX/SL).

We will outline some of the more basic concept differences between Cubase SX/SL and earlier versions of Cubase, to help seasoned Cubase users to quickly find their way around in this new environment!

You can import Songs and Arrangements created with previous versions of Cubase into Cubase SX/SL. Before you attempt to do this, you should read through the section “Importing older Cubase files” in the Operation Manual – File Handling chapter.

What is the fundamental difference?

Basically everything is new in Cubase SX/SL. Cubase SX/SL are not updated Cubase versions – they have been completely redesigned. While this is mostly transparent to the user – the main working areas of the program are still very similar – there are still changes in how recorded files are handled, changes in terminology used, the main menu structure is different etc.

While this may be slightly confusing initially to users of previous versions of Cubase, the advantages will soon become very apparent. Once the basic concept differences have been overcome, we feel certain that you will never look back!
**Songs and Arrangements**

The basic concept of Songs and Arrangements is no longer used.

Instead, the native document format of Cubase SX/SL is called a project (Windows file extension “.cpr”). All settings, file references etc. relating to the project are stored in the project folder which is designated when you create a project. You can have several open projects, but only one can be active at a time.

**Can't I work with multiple Arrangements in the way I'm used to?**

Of course you can. As several projects can share the same project folder, having different formats for Songs and Arrangements is redundant. Simply create new projects and designate them to use the same project folder.

For information about creating a project and the file and folder structure of a project, see page 58.

**Project window vs. Arrange window**

Cubase SX/SL's main working area, the Project window, is comparable to the 'Arrange' window in earlier Cubase versions. It allows real-time placement of audio, video and MIDI parts and performing of almost all primary editing tasks, including automation and it gives an overview of the entire project. Please read the chapter “Tutorial 5: Editing in the Project window” for a tutorial covering the basic editing procedures in the Project window.
Audio related differences

Files and segments

Cubase SX/SL uses different terminology for referencing audio files in a project. Please read through the section about audio terminology on page 60 to familiarize yourself with the basic terms used in Cubase SX/SL.

About audio channels

- You do not have to specify the number of audio channels to use in a project nor do you have to designate an audio channel to record on in Cubase SX/SL. You can simply create as many audio tracks you need in any project (limited only to what your computer can handle).

- In Cubase SX/SL, an audio track and an audio channel is the same thing. All audio tracks will have a corresponding audio channel strip in the Mixer.

About busses

In earlier Cubase versions, the number of output busses was directly related to the number of outputs on your audio hardware. In Cubase SX/SL you can create and set up any number of output busses with different channel configurations (especially useful when working with different surround formats in Cubase SX). Similarly, all audio input passes through input busses – again you can create and set up any number of these. In Cubase SX, you can also add effects or EQ to the input busses, making it possible to record with effects.

Recording audio

In former Cubase versions, recording normally happened on the selected track.

- In Cubase SX/SL, you simply activate the Record Enable button for each track you wish to record on. How many you can record at a time depends on the number of activated inputs on your audio hardware. You can also set things up so that selected tracks are automatically record enabled.
Events/parts

In Cubase SX/SL, audio events can appear directly on audio tracks in the Project window, with no need for audio parts. You can also put one or several audio events into an audio part – this is useful for grouping events together and e.g. moving them as one unit.

Dynamic events

There are no dynamic events for audio events anymore. Instead, you can use the pencil tool to draw a volume curve directly in the part or use the regular automation features to automate pan (you can have the automation follow when you move and rearrange events if you like). The Match Points feature in previous Cubase versions has been replaced by a comprehensive Hitpoint editing feature. For matching time positions and meter positions – check out the Time Warp and Warp Samples tools. These tools and Hitpoints are described in the Operation Manual.

Applying processing (SX only)

In Cubase SX/SL you can of course use plug-in effects in real time, just as before. But in Cubase SX you can also permanently apply the effect processing to selected audio events which can be very useful. This is described in the Operation Manual chapter “Audio processing and functions”.
MIDI related differences

Recording MIDI

In former Cubase versions, recording normally happened on the selected track.

- In Cubase SX/SL, recording happens on all tracks that are record enabled.
  You can also set things up so that selected tracks are automatically record enabled.

- The MIDI input can be set separately for each MIDI track in Cubase SX/SL.
  The MIDI input was global for all tracks in previous versions of Cubase.

Setting MIDI Thru

To be able to play a connected MIDI instrument, MIDI Thru must be activated. This is done either by record enabling the track or by clicking the Monitor button for the track.

Play Parameters

Cubase SX/SL features greatly extended real time processing of MIDI data. Cubase SX/SL comes with a number of MIDI effect plug-ins, capable of transforming the MIDI output from a track in various ways. MIDI effects are described in the Operation Manual chapter “MIDI realtime parameters and effects”.

However, unlike the Play Parameters in previous Cubase versions, track parameters in Cubase SX/SL cannot be applied to individual MIDI parts. Instead, they are always set up for complete MIDI tracks (with two exceptions: you can adjust velocity shift and transpose for individual MIDI parts using the info line in the Project window).
Drum tracks

There is no specific track class for drums. Instead, you can assign a drum map to any MIDI track – this gives you the same drum editing features as in previous Cubase versions.

Where's the MIDI Track Mixer?

Mixing MIDI is done in the Mixer together with your audio channels. The MIDI channel strips are similar to the channel strips in the MIDI Track Mixer, allowing you to set levels, panning and other parameters for your MIDI tracks.

General differences

Multiple Undo/Redo

Cubase SX/SL offers wide-ranging, multiple Undo, allowing you to undo virtually any action you perform. See page 79.

Edit History

The Edit History dialog allows you to undo or redo several actions in one go. This is described on page 80.

Offline Process History

The Offline Process History allows you to remove and modify applied processing, and is different from the “regular” Undo in that you don’t have to undo processing functions in the order they were performed.

The Offline Process History is described in the chapter “Audio processing and functions” in the Operation Manual.

Graphic editing of automation events

Automation handling is greatly improved in Cubase SX/SL. Automation events can be drawn graphically in the Project window. Each audio and MIDI track in the Track list has an automation track containing all parameters for the track. You can select which parameters to view and edit by opening subtracks for the automation track.
You can of course also use normal “Write/Read” automation to record your actions just like in previous versions of Cubase.

All effect control panels also feature Write/Read buttons. Each automated effect and VST Instrument will have its own automation track in the Track list, with subtracks for each parameter. See the chapter “Automation” in the Operation Manual.

**Surround sound (SX only)**

Cubase SX has integrated surround sound features with support for several formats. See the Operation Manual chapter “Surround sound” for descriptions.

**Integration**

The graphic design in Cubase SX/SL integrates the various windows in a much clearer way than before. For example, the Inspector, the Track list and the Mixer have many shared parameters, which all have buttons of the same style. This allows you to make settings quickly and intuitively in whatever window you are currently working.

**Customizing**

You can customize the program in several ways, from specifying custom key commands to rearranging toolbars, transport panels and track lists. You will find an introduction to this in the Customizing tutorial on page 227.
Tutorial 1: Recording and playing back audio
About this tutorial

This chapter contains a step-by-step description of how to make a simple audio recording and play it back. The purpose is for you to try out some of the most common recording and playback features. However, you should make sure to read the Recording chapter in the Operation Manual before doing any "serious" recording, as there are a lot of settings, options and methods that are not mentioned here.

Before you start

This chapter assumes that:

- You have installed and set up your audio hardware.
- Your audio source (a mixer or tape recorder, for example) is properly connected to the inputs of the audio hardware.
- The outputs of the audio hardware are connected to some sort of listening equipment, allowing you to listen to the recorded audio during playback.
- You are monitoring your audio source through Cubase SX/SL.
  This means that when you are recording, the audio source is sent into Cubase SX/SL and then back out again to your monitoring equipment. This way of monitoring allows you to adjust monitoring levels from within the program, add effects to the monitor signal, etc. However, it also requires audio hardware with low latency – otherwise the monitored signal will be noticeably delayed. Even if you find that the latency is too high for monitoring through Cubase SX/SL – please bear with us through this tutorial! In the Operation Manual you will find other methods for monitoring that may suit you better.
- You have launched Cubase SX/SL.
Creating a new project

Before you can start recording, you need a working environment – a project:

1. Pull down the File menu and select “New Project”.
   A dialog appears, listing a number of project templates for various purposes.

2. Make sure the “Empty” item in the list is selected and click OK.
   A file dialog appears, allowing you to specify a location for the project folder. This will contain all files related to the project.

3. Navigate to the desired location of the project folder, and select it by clicking OK, or click “Create” to create and name a new folder.
   The project folder is created on disk, and an empty Project window appears.

At this point, you can make various settings for the project, such as sample rate, resolution, etc. However, to keep things simple we will use the default settings for now.
The next step is to create an audio track to record on:

4. Pull down the Project menu and select “Add Track”.
   A submenu appears, listing the various types of tracks available in Cubase SX/SL.

   4. Pull down the Project menu and select “Add Track”.
      A submenu appears, listing the various types of tracks available in Cubase SX/SL.
   
   5. Select “Audio”.
      In the dialog that appears you can select whether the track should be mono or stereo.
      If you are using Cubase SX, you can also select one of several different surround configurations.

   6. In this example, set the track to stereo by selecting Stereo from the pop-up menu and clicking “OK”.
      An empty audio track appears in the Project window.
Preparing to record

Before you can start recording, there are some preparations to make:

Setting up input and output busses

When you record in Cubase SX/SL, the signal passes from the inputs on your audio hardware to an input bus in the program. This is where you check levels and adjust the sound to be recorded. From the input bus the signal is written to an audio file on your hard disk, and sent to the track’s channel in the mixer for monitoring etc.

You can have as many input busses as you like, but for this example we only need a stereo input bus:

1. Pull down the Devices menu and select “VST Connections”. The VST Connections window appears. This is where you view, add and set up input and output busses.
2. Select the "Inputs" tab by clicking on it. 
   By default, there is a stereo bus present – if there wasn’t you could easily add one by 
   clicking the Add Bus button.

3. Click the "+" button to the left so that the individual inputs in the bus 
   are shown. 
   The Device Port column shows the physical inputs on your audio hardware that are 
   used by the bus.

   ![VST Connections - Inputs](image)

4. Click in the Device Port column for the “Left” channel. 
   A pop-up menu appears, listing all inputs on your audio hardware.

5. Select the input you want to use for the left channel in the stereo bus.

6. Select the input for the right channel in the same way.

7. Click the "Outputs" tab and set up a stereo output bus in the same way. 
   This is strictly not required for recording – but you need it for monitoring and for playing 
   back the recording afterwards.

8. Close the VST Connections window and open the Mixer from the De- 
   vices menu. 
   This is Cubase SX/SL’s Mixer window, used for setting levels, etc. The mixer contains 
   channel strips for all tracks in the project and all busses (input busses are not shown in 
   Cubase SL).
• In addition there is an “Audition” output bus (SX only). This is a dedicated output bus exclusively for monitoring when previewing, scrubbing or editing in the Sample editor. The Audition bus is set up on the “Studio” tab in the VST Connections window, and is described in the Operation Manual.

![Mixer screenshot](image1)

• Right now the mixer should contain one input bus (Cubase SX only), one stereo audio channel and one output bus (apart from the Audition bus) – just like the picture above. If not, check the Hide buttons to the left. If any of these is lit (orange), click on it so that it goes grey.

![Hide button screenshot](image2)

When this button is lit, the output busses are hidden.
9. At the very top of the channel strip for the audio track, you find an Input Routing pop-up menu. Click this and make sure your stereo input bus is selected. The input bus is now routed to the audio track.

Checking the input level

When you record digitally, it’s important to set the input level correctly. Above all, you don’t want the signal to be too loud, as this will cause clipping, digital distortion.

Clipping typically occurs in the audio hardware, when a too loud analog signal is converted to digital in the hardware’s A/D converters.

- If you are using Cubase SX clipping might also happen when the signal from the input bus is written to a file on your hard disk. This would only happen if you made the signal louder in the input bus (by raising the bus level, adding effects or EQ, etc.).

Checking the input level is done in slightly different ways depending on whether you have Cubase SX or Cubase SL:
Cubase SX
1. Locate your stereo input bus to the left in the mixer window.

2. Right-click (Win) or [Ctrl]-click (Mac) somewhere in the Mixer window to bring up the Mixer context menu.

3. Select the VU-Meter Settings submenu and make sure “Input VU” is activated.

   Now the input bus meter displays the signal level coming in to your hardware – note that this level cannot be adjusted from within the program!
4. Play the audio source that you want to record and check the level meter for the input bus.
   The signal should be as loud as possible without exceeding 0 dB (the Clipping indicator for the input bus shouldn’t light up).

5. Adjust the output level of your audio source so that the meters go as high as possible without going up to 0.0 dB.
   Check the numerical peak level indicator below the meter in the bus channel strip. To reset the Clipping indicator and the peak level indicator, click on either one.

   Now you’ve made sure there’s no clipping in the audio hardware.

6. Bring up the Mixer context menu again and select “Post-Fader VU” or “Post-Panner VU” from the VU-Meter Settings submenu.
   These metering modes show levels after the channel faders. The “Post Panner VU” also takes pan settings into account.

7. If you now play back the audio source you can check the output level of the input bus – the signal that is to be recorded on your hard disk.
   Since we haven’t made any adjustments in the input bus there should be no risk of clipping here. If you had made level adjustments in the input bus and the Clipping indicator lit up at this point, you would simply lower the input bus fader, reset the indicators and try again.
Cubase SL

In Cubase SL, the input busses are not shown in the mixer. Instead, you need to check the level at the channel strip for the track on which you are recording:

1. Right-click (Win) or [Ctrl]-click (Mac) somewhere in the Mixer window to bring up the Mixer context menu.

2. Select the VU-Meter Settings submenu and make sure “Input VU” is activated.
   In this mode, the level meters show the levels “pre-fader” – that is, unaffected by level fader changes, etc.

3. Locate the channel strip for the track you’re about to record on.

4. Activate monitoring for the channel by clicking the speaker button next to the fader.
   When monitoring is activated, the meter shows the level of the incoming audio signal.

5. Play the audio source that you want to record and check the level meter for the channel.

6. Adjust the output level of your audio source so that the meters go reasonably high without reaching 0.0 dB.
   Check the numerical peak level indicator below the meter in the bus channel strip. To reset the peak level indicator, click on it.

   • You must adjust the output level of the audio source – you cannot use the faders in Cubase SL to adjust the input level!

   • An alternative way of checking the input levels would be to use the control panel for your audio hardware (if it’s equipped with input level meters).
   See the documentation of the audio hardware for details.
Making the track ready for recording

1. If the “Record Enable” button next to the fader on the mixer channel strip isn’t already red, click on it so that it lights up.

2. Make sure the Transport panel is visible.
   If not, pull down the Transport menu and select the “Transport Panel” item at the top.
3. The Transport panel contains a lot of options that affect how recording is done – in this example we want most of them to be turned off. Check that the following buttons are off (grey or unlit):

- Click and Precount deactivated.
- Punch In and Punch Out deactivated.
- Cycle deactivated.
- Sync deactivated.

4. Click in the ruler (the time scale area above the track in the Project window), at the position where you want to start recording. When you click, the project cursor (the black vertical line) is automatically moved to the click position. In our example, recording will start from the project cursor position.

5. To set recording to start at the cursor position, pull down the Transport menu and make sure the item “Start Record at Left Locator” is deactivated (unticked).

**Setting up monitoring**

When you are monitoring through Cubase SX/SL, you can choose to activate monitoring manually or automatically, in several different ways. In this example we choose the “Tapemachine Style” monitoring, in which the input signal is automatically monitored in Stop mode and during recording – but not during playback. This is convenient since it allows you to play back and listen to your recording without having to turn off monitoring first.
1. Pull down the File menu (Win) or Cubase SX/SL menu (Mac) and select “Preferences...”.

2. In the Preferences dialog, click the VST item to the left.

3. Pull down the Auto Monitoring pop-up menu and make sure “Tape-machine Style” is selected.

4. Click OK to close the Preferences dialog.

5. Bring up the Mixer and locate the channel strip for the audio track. Since the track is record enabled (the red button is lit) and Cubase SX/SL is in Stop mode, monitoring should now be activated.

6. Check the monitoring by playing back your audio source and listening to your monitoring equipment. You should see the meters move in the channel strip for the audio track and in the output bus to the right.

7. If you like you can adjust the monitoring level with the fader for the audio track. This will not affect the level in the recorded audio file.

You are ready to record!
Recording

1. Start recording by clicking the Record button on the Transport panel. The project cursor will start moving.

2. Play your instrument, etc. During recording, a rectangle with an audio waveform will appear, covering the recorded area. This is the recorded audio event.

3. When you are done, click the Stop button on the Transport panel. Recording stops and you can see the resulting audio event on the track.

4. If you are done recording, click the Record Enable button in the area to the left of the track, so that it goes dark.

Playing back what you just recorded

1. Move the project cursor to the beginning of the recorded audio event. This could either be done by clicking in the ruler, or by using the Rewind button on the Transport panel.

2. Click the Play button on the Transport panel. Your recording will be played back.

3. When you are done, stop playback by clicking the Stop button on the Transport panel.
**Recording more events**

At this point, you may want to continue recording audio, on the same track or on a new track.

**Recording more on the same track**

To record more audio on the same track, move the project cursor to a new start position and proceed as when you recorded the first time.

*It is possible to record audio events that overlap each other, but only the visible events (the events at the top) will be heard when you play back.*

**Recording a new audio track**

This example shows how to record a new audio track, while listening to the first recording.

1. Create a new audio track by using the “Add Track” submenu on the Project menu.

2. Decide whether you want the new track to be stereo or mono in the dialog that appears.

3. Pull down the Devices menu and open the Mixer.
   As you can see, a new channel strip has been added to the mixer.

4. Use the Input pop-up menu at the top of the channel strip to make sure that the same stereo input bus is selected for the new track.
   If the audio source is another than the one you first recorded, you need to check the input level again – see page 110.

5. Record enable the new track by clicking the red Record Enable button in its mixer channel strip.
   Make sure that the Record Enable button for the first track is disabled – otherwise you will be recording on both tracks at the same time.

6. Move the project cursor to the desired start position.

7. Activate recording by clicking the Record button on the Transport panel.
   While you are recording, the first audio track is played back.

8. When you are done, click the Stop button on the Transport panel.
Playing back in a cycle

You could continue starting and stopping playback this way, moving the project cursor manually each time. However, if you want to try out some mixing features (see the chapter “Tutorial 3: Mixing”), it is more convenient to have Cubase SX/SL play back your recorded audio repeatedly, over and over again:

1. Click on the recorded audio event to make sure it is selected. A selected audio event has a red border and white and blue handles at its beginning and end.

2. Pull down the Transport menu and select “Locators to Selection”. This moves the left and right locator (two special Cubase SX/SL markers) to the beginning and end of the selected audio event, respectively. In the ruler, the area between the left and right locator is indicated by a blue highlight.

3. Click the Cycle button on the Transport panel so that it lights up.

4. Move the project cursor to the beginning of the recording and click Play. Playback starts. When the project cursor reaches the end of the recording (the right locator), it will immediately jump back to the left locator and continue playback. When you’re done, click the Stop button on the Transport panel.
Tutorial 1: Recording and playing back audio
Tutorial 2: Recording and playing back MIDI
About this tutorial

This chapter describes the basic operations for recording and playing back MIDI. For a full description of MIDI recording please see the chapter “Recording” in the Operation Manual.

Before you start

This chapter assumes that you have correctly connected your MIDI equipment according to the instructions in the chapter “Setting up your system” in this book.

This tutorial connects to the previous chapter, so if you followed the instructions there, you should now have recorded two audio tracks.

About MIDI Thru

The normal way to work with MIDI is to have MIDI Thru activated in Cubase SX/SL, and Local Off selected in your MIDI instrument(s). In this mode, everything you play during recording will be “echoed” back out again on the MIDI output and channel selected for the recording track.

1. Open the Preferences dialog and select the MIDI page.
   The Preferences dialog is located on the File menu under Windows and on the Cubase SX/SL menu under Mac OS X.

2. Make sure the option "MIDI Thru Active" is activated.

3. Click OK to close the Preferences dialog.
Setting up for recording MIDI

Creating a MIDI track

To create a MIDI track, proceed as follows:

1. Pull down the Project menu and select “Add Track”.
   A submenu appears.

2. Select MIDI from the submenu.
   A MIDI track is added to the Track list.

Setting the MIDI input

1. Make sure the Inspector is shown to the left in the Project window.
   The Inspector shows settings for the selected track. You show or hide it with the Show Inspector button on the toolbar.

2. To set the MIDI input for a track, pull down the “in:” pop-up menu in the Inspector and select an input.
   The available MIDI inputs are shown. The items on the menu depend on the type of MIDI interface you are using etc. You can set the MIDI input independently for each track.
3. Record enable the MIDI track by clicking the red button in the Track list. MIDI Thru is automatically activated when the track is record enabled.

![Record enabling the track in the Track list. This can also be done in the Inspector area to the left or in the mixer.](image)

4. Play a few notes on your MIDI instrument, and check the level meter in the Track list to make sure that the MIDI signal is received. If not, check that you have correctly set up your MIDI system, as described on page 47.

**Setting the MIDI output and channel**

1. To set the MIDI output for a track, pull down the “out:” pop-up menu in the Inspector and select the output to which you have connected your MIDI device. The available MIDI outputs are shown. The items on the menu depend on what type of MIDI interface you are using etc.

![Click here to set the MIDI output.](image)
2. To set the MIDI channel for a track, use the MIDI “chn:” pop-up in the Inspector.
If you set the track to MIDI channel “ANY”, it will transmit MIDI on the channel(s) used by the MIDI input device (the MIDI instrument you play during recording).

Selecting a sound

- To select different sounds, you can send Program Change messages to your MIDI device using the “prg:” value field in the Inspector.

Program Change messages give access to 128 program locations. If your MIDI instruments have more than 128 programs, Bank Select messages (set in the “bnk:” value field) allow you to select different banks, each containing a number of programs.

- Play a few notes on your MIDI instrument to check that the selected sound program is correct.
Recording MIDI

1. Make sure the track is record enabled and correctly set up, as described in the previous section.

2. Make sure that Cycle and Punch In/Out are deactivated on the Transport panel.

3. To set recording to start at the cursor position, pull down the Transport menu and make sure the item “Start Record at Left Locator” is deactivated (unticked).

4. Place the project cursor at the position where you wish to begin recording.
   For example, you could try recording a MIDI part together with the audio tracks that you recorded in the previous tutorial.

5. Activate Record on the Transport panel, and play a few notes on your MIDI instrument.
   When you finish recording, a MIDI part containing MIDI events is created in the Project window.

6. If you are done recording, click the record enable button in the area to the left of the track so it goes dark.

Playing back what you just recorded

1. Move the project cursor to the beginning of the recorded MIDI part.
   This could either be done by clicking in the ruler, or by using the Rewind button on the Transport panel.

2. Click the Play button on the Transport panel.
   Your recording will be played back.

3. When you are done, stop playback by clicking the Stop button on the Transport panel.
Playing back in a cycle

You could continue starting and stopping playback this way, moving the project cursor manually each time. However, it is more practical to have Cubase SX/SL play back your recorded parts and events repeatedly, over and over again:

1. Click on the recorded MIDI part to make sure it is selected.
   A selected MIDI part has a red border and white handles at its beginning and end.

2. Pull down the Transport menu and select “Locators to Selection”.
   This moves the left and right locator to the beginning and end of the selected MIDI part, respectively. In the ruler, the area between the left and right locator is indicated by a blue line.

3. Click the Cycle button on the Transport panel so that it lights up.

4. Move the project cursor to the beginning of the recorded part and click Play.
   Playback starts. When the project cursor reaches the end of the recording (the right locator), it will immediately jump back to the left locator and continue playback. When you’re done, click the Stop button on the Transport panel.
Transposing the MIDI track

Let's try transposing the MIDI track, using the Track Parameters tab in the Inspector:

1. Make sure that the Inspector button on the toolbar is lit.

2. Select the MIDI track by clicking on it in the Track list. The parameters for the MIDI track are now shown in the Inspector area to the left.

3. Click on the Track Parameters title bar in the Inspector.
4. Click on the blue value line in the Transpose field in the Inspector. A fader appears, allowing you to transpose the MIDI track up or down in semitones. You can also use the up/down arrows to the right in the field to set transpose values.

![Example of Transpose Field](image)

Click here...

![Example of Transpose Fader](image)

…to set a transpose value for the MIDI track.

5. Start playback to hear the transposed MIDI track.
11

Tutorial 3: Mixing
About this tutorial

This tutorial shows how to do some basic mixing. You will set levels and pan, add effects and EQ and finally try automating a mixer parameter. The purpose of the tutorial is to give you some basic knowledge about the Cubase SX/SL Mixer – for complete descriptions of the mixing features please refer to the chapters “The Mixer”, “Audio Effects” and “Automation” in the Operation Manual.

- In this tutorial we will mix in stereo. If you are using Cubase SX it is also possible to do surround mixes – for a quick tutorial on this, see page 149. We recommend that you are familiar with the procedures in this chapter before moving on to the surround tutorial.

Preparations

This tutorial is based on a file included on the Cubase SX/SL DVD. Proceed as follows:

1. Insert the Cubase SX/SL DVD and open it for browsing.

2. On the DVD, open the “Additional Content” folder and locate the folder “Tutorial Projects”.

3. Copy this folder to the computer’s hard disk (for example in the “My Documents” folder under Windows).

4. Open the folder “Tutorial Projects” on your hard disk and double click on the file “Tutorial 3.cpr”. Whether file extensions are shown or not depends on the settings for your operating system.

The “Tutorial 3” project opens in Cubase SX/SL. This is a simple 16-bar “song” containing four audio tracks.

- Please note that when you open a tutorial project, a dialog may appear asking you to resolve pending connections. This is because you probably don’t have the same configuration as the creator of this project. Use the dialog to chose the desired port and click OK to close the dialog.
Since this project doesn't contain any MIDI tracks, we will only mix audio in this tutorial. If you have MIDI tracks in a project, these will also show in the mixer. Many procedures (setting levels, pan, mute, etc.) are the same for MIDI mixer channels – see the Operation Manual.

5. **Click Play to play back the project.**

As you hear, this is a low-tempo, medium-funky piece consisting of a drum track, a bass track, some electric piano and strings. Cycle is activated on the Transport panel, which means the 16 bars of music will play back repeatedly. The balance, pan and general sound isn’t the best – that’s what we will try to change on the following pages.
• If you don't hear all four tracks, make sure you have a stereo output bus (in the VST Connections window – see page 107) and that all four tracks are routed to this bus in the mixer.

To make output routing settings for the tracks, use the input/output settings panel at the top of the Mixer channel strips (or the “out” pop-up menus in the Inspector).

Setting levels

If you listen to the project, you will find that the level balance is fairly OK until the strings start in bar 9. The strings are way too loud, tending to drown the other tracks. Proceed as follows:

1. Open the Mixer by selecting it from the Devices menu (or by using the key command for this – by default [F3]).

The Mixer window opens with channel strips for the four audio tracks. If the project contained any other tracks (MIDI tracks, effect tracks, etc.) or VST instruments, there would be channel strips here for these as well.
2. Start playback and locate the channel strip for the Strings track. The names of the tracks are shown at the bottom of each channel strip.

3. Click the level fader handle in the channel strip and lower the fader until you feel the level of the Strings track is OK. As you can see, the level meters reflect the signal level of each track – the meter for the Strings track will reflect the level change you make.

- If you need to reset a level fader to ±0.00, press [Ctrl]/[Command] and click on it. You can use this method to reset most parameters to their default values.

4. If you like, adjust the levels of the other tracks as well. You can leave the project playing for the next steps in the tutorial.

Setting pan

Pan sets the left/right position in the stereo field or the stereo balance.

Right now, all tracks are set to center pan. This is probably fine for the drums and the bass, but it might be a good idea to pan the piano and strings tracks to opposite sides:

1. In the “E.Piano” channel strip, click on the blue line in the Pan control box above the fader, and drag it a bit to the left. The electric piano track is panned to the left.

2. Pan the strings track a bit to the right in the same way. These are both mono tracks which means the pan control simply pans the mono signal between the left and right channel in the output bus. For stereo tracks, the pan control serves as a stereo balance control (in Cubase SX there are two other panning modes available as well – see the Operation Manual for details).
Using Mute and Solo

Each channel strip has a Mute and a Solo button, allowing you to silence one or several channels.

1. Click the M button for the bass track.
   The button lights up and the sound of the bass is muted.

2. Mute the electric piano track in the same way.
   Several channels can be muted at the same time.
   To unmute a channel you click its M button again. You can also unmute all muted channels in one go:

3. Click the lit M button in the common panel – the area at the left side of the Mixer window.
   This button is lit whenever one or several channels are muted – clicking it unmutes all muted tracks.

4. Now click the S button for the drum track to solo it.
   This mutes all other channels.

5. To turn off solo for the channel, click the S button again...
   ...or click the lit S button in the common panel – this turns off solo for all channels.

   You can solo several channels at the same time.
   If you instead press [Ctrl]/[Command] and click an S button, that channel will be soloed and all other channels will be muted. This function is known as exclusive solo.
Adding EQ to an audio channel

Equalization shapes the tone of a signal by boosting and/or cutting selected frequencies. Each audio channel in the mixer has a built-in equalizer with four parametric modules.

When and how to apply EQ is of course individual. Below we will add EQ to two channels, to achieve the following:

- Cut a very narrow frequency band in the drum track to reduce the intensity of the rimshot.
- Add a gentle mid frequency boost to the electric piano track to make it stand out a bit more.

- Below we will show how to make EQ settings in the Channel Settings window.

If you are using Cubase SX you may find it more convenient to use the EQ panel in the extended mixer – this is described in the Operation Manual.

Let’s start with the rimshot which is mixed rather loud in the drum track. Unfortunately we cannot change this but we could try cutting a narrow band in the mid-high frequencies.

1. If you like, solo the drum track to help you hear what you’re doing.
2. Click the “e” button in the drum track’s channel strip (next to the level fader).

This opens the VST Audio Channel Settings window for the track.
This window allows you to make detailed settings for the selected mixer channel. The EQ section is located in the middle of the window with parameter dials for the four EQ modules and a graphic display showing the frequency boost/cut curve.

The three parameters in each EQ module are:

▪ Gain (inner dial) – this governs how much a frequency range should be cut or boosted.
▪ Frequency (outer dial) – this is the mid frequency for the range to be cut or boosted.
▪ Q (lower dial) – this is the width of the frequency range to be affected.

3. Click the on/off button for the "hi mid" EQ module to activate it.
   You can activate up to four modules per channel, but in this case we only need one.

4. Set the gain to a fairly drastic cut, around -10 dB or so.
   This is done by clicking and dragging the inner dial (or by entering a numeric value in the field above).

5. Raise the Q value (the lowest dial) to 12.0 – the maximum value.
   This means the frequency range will be as narrow as possible.

6. Experiment with the frequency parameter (the outer dial) and try to find a frequency where you reduce the intensity of the rimshot without interacting too much with the other drums and hi-hat sounds.
   To make fine adjustments, press [Shift] and drag the dial. You can also click the numerical value below and type in a frequency directly.
7. Turn off solo to see how the drum sound works with the other tracks.

When you activate an EQ module, the EQ indicator in the channel strip lights up green. This shows that one or several EQ modules are activated for the channel, and also serves as a bypass button:

8. To compare the sound with and without EQ, click the EQ indicator/Bypass button in the channel strip.

The button turns yellow when Bypass is activated – this means the EQ section is bypassed. Of course, in this case we could simply turn off the EQ module with its on/off button, but the bypass button is handy when you have more than one EQ module activated.
Now we will move on to the electric piano track, and try a slightly different approach:

9. Click the small arrow button in the lower left corner of the Channel Settings window and select “E.Piano” from the pop-up menu that appears.
   This selects the E.Piano mixer channel – the Channel Settings window will now show the settings for that channel instead.

   This time we will try adjusting the EQ in the curve display:

10. Click in the curve display and keep the mouse button pressed.
    A curve with a point appears, and one of the EQ modules below is activated. The number next to the curve point is the number of the EQ module.

11. While listening to the electric piano sound, drag the curve point to change gain and frequency.
    Q is set to a low value by default – this is probably good in this case. If not, you can change the Q value by pressing [Shift] and dragging in the display (or by using the Q knob in the EQ module below).

    • Clicking somewhere else in the curve display will activate another EQ module for a more complex curve.
    You can remove EQ curve points by clicking and dragging them outside the display.

12. When you've set the EQ as desired, close the Channel Settings window.

    Those were two methods of making EQ settings. You can also make EQ settings in the Inspector in the Project window or use any of the EQ panels in the extended mixer (Cubase SX only).
Audio effects

Cubase SX/SL comes with a large number of audio effect plug-ins (VST plug-ins). These can be used as send effects, insert effects or for offline processing (Cubase SX only, described in another tutorial in this book).

Adding a send effect

Send effects in Cubase SX/SL make use of FX channel tracks – “effect return” tracks, each holding one effect plug-in (or several, in series). Each audio track has eight different effect sends, which can each be routed to any FX channel track. This allows for extremely flexible effect handling.

In brief, this is what you do to add a send effect to an audio track:

- Create an FX channel track and select an effect plug-in for it.
- Activate a send for the audio track and route it to the FX channel track.
- Adjust the amount of effect for the track with the effect send.
- Adjust the amount of effect return signal by setting the level of the FX channel track.

In this project, we feel that the strings track could use some reverb. Proceed as follows:

Setting up an effect

1. Pull down the Project menu and select “FX Channel” from the “Add Track” submenu.
   A dialog appears.
2. Set the Configuration pop-up menu to “Stereo”. 
3. Pull down the Plugin pop-up menu.
The effects included with Cubase SX/SL are organized in subfolders according to the effect type. Typical send effects are reverb, delay and other effects where you want to add a little bit of effect to the original dry signal.

4. Select “Reverb A” from the Reverb submenu and click OK.
The control panel for the “Reverb A” effect appears. We’ll look closer at the control panel in a moment – first take a look at the Track list:

An FX channel track is added to the Track list. As you can see in the Track list, the insert effect button is lit for the track – this indicates that an insert effect is loaded and activated for the track.

5. Go back to the mixer – as you can see, a channel strip has been added for the FX channel track.
This serves as an effect return control.
6. Click the "e" button for the FX channel strip.
The Channel Settings window appears.

7. OK, let's look at the control panel for the effect. If it's obscured by the other windows you can click the "e" button for the Reverb A slot twice to bring the panel to front.

8. Use the pop-up menu to select the "Large" preset.

9. Since we want to use this as a send effect we don’t want any dry (unprocessed) signal to pass through the effect – drag the Mix slider fully down (wet 100, dry 0).
Setting up a send

1. Go back to the mixer and locate the channel strip for the Strings track.

2. Click the “e” button in the Strings channel strip to open its Channel Settings window. The effect sends are located to the right of the EQ section – currently they are all unused (shown as empty slots).

3. Click in the first empty effect send slot and select your FX channel from the pop-up menu that appears.

4. Click the power button for the first slot to activate the send.

5. Listen to the strings while you raise the send slider below the slot. You will hear the reverb effect being added to the sound.

6. If you like, you can adjust the effect return level with the level fader for the FX channel strip. You can also add EQ to the FX channel, change its stereo balance etc., just like for a regular audio track.

   ▪ Note that you can activate sends for other tracks in the same way, and route them to the same reverb effect.

   ▪ If you are using Cubase SX, you can also view and set up sends directly in the extended mixer – see the Operation Manual.
Adding an insert effect

An insert effect is inserted into the signal chain of an audio channel, which means that the whole channel signal passes through the effect. This also means that only one track or channel will use the insert effect – unlike send effects, where signals from several channels can all be sent to the same effect.

In our tutorial, we will add some chorus to the electric piano track.

1. Click the “e” button in the “E.Piano” channel strip (or use the channel selection pop-up menu in the lower left corner of the Channel Settings window).
   Either way, the Channel Settings window for the E.Piano track appears.

2. Click in the empty field in the first insert slot.
   This brings up the effect pop-up menu.
3. Select “Chorus” from the Modulation submenu.  
The effect is loaded and automatically activated, and its control panel appears.

![Chorus Effect Panel](image)

4. Play back the project and try selecting different chorus presets.
   - In this case we inserted an effect on a mono track – this means the output from the effect will still be in mono.  
   To get a stereo chorus, we would need to add the chorus as a send effect instead.
Automation

All mixer parameters can be automated in Cubase SX/SL. In the final example in this chapter, we will do a simple fade in for the electric piano track, so that it starts inaudible and reaches its full level at bar 9, where the strings start:

1. Arrange your windows so that you can see both the events in the Project window and the mixer.
   This is not strictly necessary but it makes it easier to see where the electric piano starts.

2. Turn off Cycle on the Transport panel.
   This is a safety measure to avoid accidentally overwriting your automation.

3. Move the song position cursor to the start of the project.
   You can do this by clicking in the ruler at the project start, or by clicking the “Goto Zero” button on the Transport panel (to the left of the Rewind button).

4. In the mixer, click the W button for the “E.Piano” channel.
   This activates automation write mode.

5. Start playback.

6. Drag the level fader for the "E.Piano" channel fully down.

7. When the song position cursor reaches the electric piano event, start slowly raising the level fader, so that it reaches full level (0.00) roughly at the start of bar 9.

8. Stop playback.

9. Click the W button to turn it off.
10. Click the R button for the channel. This activates automation read mode.

11. Play back the project from the start. You will see your automated fader movement and hear the electric piano fade in.

That concludes this tutorial! If you are happy with the result, you may want to save the project under a different name, by selecting “Save As...” from the File menu.
Tutorial 4: Creating a surround mix (Cubase SX only)
About this tutorial

If you are using Cubase SL, you can skip this chapter and go directly to the next tutorial.

This tutorial describes how to set up Cubase SX for work in 5.1 surround format, add some audio files from a library, create a simple surround mix including some mixer automation and finally export this as an interleaved multi-channel audio file.

For full descriptions of all the surround features in Cubase SX, please see the Surround chapter in the Operation Manual.

• For this tutorial to be useful, you need to have audio hardware with six (or more) outputs.
  Preferably, these outputs should be connected to a surround speaker system in 5.1 configuration.

Preparations

This tutorial is based on an existing file, included on the Cubase SX DVD.

• Below, we assume that you have followed the previous tutorial and copied the “Tutorial Projects” folder to your hard drive.
  If not, please see page 132.

Before you start, close any open projects, by making their Project windows active and selecting “Close” from the File menu. This is just to make things clear and avoid confusion – you can of course have several projects open in Cubase SX.

Creating a Project

First of all, we need to create a new project.

1. Pull down the File menu and select “New Project”.
  A dialog appears, listing a number of project templates for various purposes.
2. Make sure the “Empty” item in the list is selected and click OK.
A file dialog appears, allowing you to specify a location for the project folder. This will contain all files related to the project.

3. Navigate to the desired location for the project folder, and select it by clicking OK, or click “Create” to create and name a new folder.
The project folder is created on disk, and an empty Project window appears.

4. Pull down the Project menu and select Project Setup.
The Project Setup dialog appears. This is where you make basic settings for the project.

5. Set the Sample Rate to 48.000 kHz and the Record Format to 24 bit.
This is to match the audio files we will use.

6. Click OK to close the Project Setup dialog.
The project is empty right now so we need to add some audio tracks:

7. Select “Add Track” from the Project menu and “Audio” from the submenu that appears.

8. Make sure Stereo is selected in the dialog that appears and click OK.
A stereo audio track is created. Once you have created a track you can add more tracks of the same track type by double clicking:
9. Double click in the empty part of the track list. Again, select Stereo in the dialog that appears.

10. Create two mono tracks as well. Use the same method, just select Mono in the dialog that appears.

Now we have two stereo tracks and two mono tracks, which is what we need.

11. Pull down the File menu and select “Open Library”.

12. Navigate to the “Tutorial Projects” folder on your hard disk and open the file “Tutorial 4.npl”.

   This is a library – a stand-alone Pool with references to media files (in this case, the library contains four audio clips). Typically, you create libraries with audio clips and/or video clips that you want to use in several projects – sound effects libraries, etc.

13. Position the windows so that you can see the Project window and the Library window at the same time.
14. Turn on Snap in the Project window and make sure the Grid option is selected to the right.
This makes it easier to line up the events at the same start position.

15. Drag the clip “Ambience 1” from the library to the first stereo track and drop it at the start of the project.
You will be asked whether to copy the file to the work directory, etc. – this is not necessary.

16. Proceed in the same way with the clips “Ambience 2” (on the second stereo track), “Speech” and “Car” (each on one mono track). Position the clips roughly like in the following picture:

17. Now, change the track names accordingly: in the Track list, double-click the name field and enter the respective name (“Ambience 1”, “Ambience 2”, etc.).
If you were to play back the project at this point, all four tracks would simply play back through the default stereo output bus. It’s time to set up a surround bus.
Creating a surround bus

1. Select “VST Connections” from the Devices menu.

2. In the VST Connections window, make sure the Outputs tab is selected and click the Add Bus button.

3. In the dialog that appears, select the 5.1 option and click OK.
   The pop-up menu in the dialog lists the most common formats – to see all surround formats supported by Cubase SX, check the “More...” submenu.

   The new bus appears.

4. Click in the Device Port column for each channel in the bus and select outputs on your audio hardware.
   If you followed the recommendations on page 43, your output ports will already be named according to the channels in your surround setup – this way you just have to select the “Left” output for the left channel, the “Right” output for the right channel and so on.
Now we have a 5.1 output bus. As you will see, you can either route a mono track directly to one channel in the surround bus or route a track (mono or stereo) to the whole surround bus and use the Surround panner to position it as desired. But what if you have some stereo material that you simply want to send to a stereo channel pair in the bus (Left and Right or Left Surround and Right Surround)? For this you need to create a child bus:

5. Select the new 5.1 bus in the list and right-click (Win) or [Ctrl]-click (Mac) on it.

A pop-up menu appears.

6. Select “Add Child Bus” and from the submenu that appears the “Stereo (Ls Rs)” option.

This creates a stereo child bus within the 5.1 bus, directed to the left and right surround speakers. In a normal “project” you would be more likely to require a child bus directed to the left and right front speakers, but in this tutorial we need “Stereo (Ls Rs)”.

7. Close the VST Connections window.
Setting up a surround mix

If you have auditioned the audio clips already, you have found that we have a stereo clip with background noise from a petrol station (Ambience 1), a similar stereo clip (Ambience 2), some speech in mono and the sound of a car starting and driving away, also in mono.

- These audio files are (except for the speech clip) based on excerpts from Steinberg’s “Urban Atmospheres” sound environment recordings in 5.1 surround format.
  Please check out www.steinberg.net for more information on the Urban Atmospheres collection!

Our goal here is to set things up like this:

- The speech track goes to the Center channel only.
- The Ambience 1 track goes to the Left and Right channels.
- The Ambience 2 track goes to the surround speakers only.
- The sound of the car will be panned across the surround speakers, and we will send a bit of it to the LFE channel as well.

Proceed as follows:

1. Open the mixer.

The mixer contains channel strips for the four audio tracks as well as channel strips for the input and output buses – including the 5.1 output bus you created.
2. Make sure the Input and Output Settings panel is visible at the top of the channel strips. If not, click in the upper part of the symbol in the lower left corner of the mixer.

Surround panning in stereo

Let's start with the Ambience 1 track (the first stereo track). We want this routed to the front stereo speakers only. To get a feeling for how things work we will do this by using the surround panner:

1. Locate the channel for the Ambience 1 track and solo it by clicking the “S” button. This lets you listen to only this track.

2. Open the Output Routing pop-up menu for the track.
3. Select the 5.1 bus ("5.1 Out").
This routes the track to the whole 5.1 bus, for surround panning. As you can see, the regular pan control on the channel strip is replaced by a square grid with a dot.

4. Double click on the grid to bring up the surround panner panel.

The grey ball in the middle of the display indicates the position of the signal in the surround sound image.

5. Click on the “Mo./St.” pop-up menu and select “Y-Mirror”.
In this mode, the left and right channels in the stereo material will be “mirrored” along the Y axis. That is, the same amount of signal will be sent to the surround channels for both channels.
6. Click and drag the ball to the top right corner of the display. 
As you can see, you are dragging the "R" ball – the right channel. The left channel is automatically mirrored and is therefore positioned in the top left corner.

7. Start playback from the beginning of the project.

8. Click the "R" ball and drag it slowly downwards – towards the surround (back) speakers. 
You will hear the sound gradually move back to the surround speakers.

9. Position the balls in the upper corners again, as in the picture above. 
This is what we want in this case – the left and right channels routed to the left and right speakers, respectively.

10. Go back to the mixer. 
You can close the surround panner if you like.
Routing to a stereo child bus

Next up is the Ambience 2 stereo track, which should be routed to the surround speakers. We could use the surround panner again, but since we created a child bus for the left and right surround speakers, this is a much quicker way:

1. Unmute the Ambience 2 channel.
2. Pull down the Output Routing pop-up menu for the channel.
3. Select the “Stereo (Ls Rs) out” child bus.

This routes the track directly to the surround stereo speakers.

4. Play back the project again.

You should hear a recording of the ambient noises on a petrol station, with the rear speakers providing life-like depth and surround sense.
Routing to a separate channel in the bus

The speech track should be routed to the center channel only in this tutorial. This is easily done:

1. Unmute the speech channel and open its Output Routing pop-up menu.
2. Select the “Center” channel for the 5.1 Out.
3. Play back the project and check that the speech is heard from the center speaker.

LFE and dynamic surround panning

For the final track, the car sound, we want a sense of movement across the surround sound image. We do this by automating the surround panner.

1. Unmute the car channel and pull down its Output Routing pop-up menu.
2. Select the 5.1 Out option.
   This routes the track to the whole 5.1 bus, for surround panning.
3. Double click on the grid to bring up the surround panner panel.
   This time we’re working with a mono track, so we can keep the “Mo./Sl.” parameter set to “Mono Mix”. This means there will be a single ball, indicating the position of the sound source.
Before we set the surround panning, let's try sending some sound to the LFE (low frequency effects) channel:

4. Click the LFE knob in the surround panner panel and turn it up to a moderate level.
   This knob controls the amount of signal sent from the car channel to the LFE channel. If you like, play back the project and adjust the LFE amount.

Now on to the surround panning:

5. Position the ball at “where you want the car to start”.


7. While the car sound plays back, try dragging the ball to get a natural sense of movement. You may for example start at one side and drag the ball in a semi-circular movement across the lower part of the display.
   Practice this a few times to find the best panning sweep.

8. In the mixer, click the “W” button for the car channel to enable automation writing.

9. Play back the project and perform the panning sweep in the surround panner.

10. When you are finished, click Stop, turn off the “W” button and activate the “R” button.

11. Play back the project again.
   Now you should hear the complete surround mix, including your automated panning sweep.

12. If you like what you hear, save the project.
Exporting to a surround audio file

Cubase SX can export (mix down) audio tracks to a file on the hard disk in a number of formats. Most often you will probably export to stereo or mono files, but it’s also possible to create an interleaved multi-channel file, containing all the surround channels in a single file:

First you need to set up the left and right locators to encompass all audio files in the project. Here’s one way to do this:

1. Click in the upper half of the ruler at the very start of the project and drag to the right with the mouse button pressed.

2. Release the mouse button at the end of the last event.
   Check that all events are contained within the area between the locators (indicated with a blue highlight in the ruler).

- You can also do this by first selecting all events (e.g. by pressing [Ctrl]/[Command]-[A]) and then using the “Locators to Selection” function on the Transport menu (default key command [P]).
3. Pull down the File menu, select “Export” and then “Audio Mixdown” on the submenu that appears.
The Export Audio Mixdown dialog appears.

4. Enter a name for the mixdown file in the File name field.

5. Make sure an uncompressed file type is selected.
You can only create multi-channel interleaved files in uncompressed formats. These include Wave, Wave 64 and Broadcast Wave (PCM coding) as well as AIFF.

6. Select 48kHz in the Sample Rate field – the same as in the project.
This is only necessary because we will import the resulting file back into the project again. The Resolution setting isn’t as important, but to maintain the high audio quality you should set this to 24 Bit.

7. Select “N. Chan. Interleaved” from the Channels pop-up menu.
This option is for creating a multi-channel interleaved file. Note that it’s also possible to export in Split format, in which case each channel in the surround bus will become a separate mono file.
8. Pull down the Outputs pop-up menu and select your 5.1 Output bus. This is where you select which output bus to export. As you can see, it’s also possible to export separate audio tracks here (as well as VST Instrument channels, effect return tracks etc.).

9. Turn off the Real-Time Export and Update Display options.

10. Make sure both “Import to” checkboxes are activated. This means the resulting mixdown file will be imported back into the project, on a new audio track.

11. Click Save.

Now Cubase SX renders the output bus to a file, which may take a few moments. Then the file will be imported into the project.

- A dialog will ask you whether to copy the file into your work directory, etc. but this is not required now – deactivate all checkboxes and click OK.

If you look at the Project window now, you will find that a new track has been added. While the other tracks are in stereo or mono format, this one is a 5.1 track, containing six channels. The track contains an audio event with the exported surround file.

12. Open the mixer and make sure the new 5.1 track is routed to the 5.1 Out bus.

13. Solo the 5.1 channel and play back the project.

You will hear your surround mix again, although now it’s contained in one multi-channel audio file.

That concludes this tutorial! In the Operation Manual you can read more about the extensive Surround features in Cubase SX.
Tutorial 5: Editing in the Project window
About this tutorial

This tutorial describes some of the procedures for editing in the Project window. Typically, this is where you do the “large-scale” editing and re-arranging of events. Again, please note that this tutorial only describes some of the many functions in the Project window – for details and full descriptions, see the Operation Manual.

Preparations

This tutorial is based on an existing file, included on the Cubase SX/SL DVD.

- Below, we assume that you have followed the previous tutorial and copied the “Tutorial Projects” folder to your hard drive.
  If not, please see page 132.

1. Close any open projects, by making their Project windows active and selecting “Close” from the File menu.
   This is just to make things clear and avoid confusion – you can of course have several projects open in Cubase SX/SL if needed.

2. Pull down the File menu and select Open.

3. In the file dialog that appears, navigate to the Tutorial folder on your hard drive, select the file “Tutorial 5.cpr” and click Open.
   Now the “Tutorial 5” project opens in Cubase SX/SL.
Overview

As you can see, this project contains four audio tracks (drums, bass, guitar and strings) with a few events. Try playing back the project from the beginning!

Well, it’s obvious that things are pretty disorganized here; the audio events do not fit together very well. The goal of this tutorial is to make some sense out of this, by editing in the Project window.

While this tutorial describes the editing of audio events, most of these procedures can also be used for editing MIDI parts in the Project window. See the Operation Manual for details.
Moving and copying events

Let's start by making the events start at the same time:

1. Select the Arrow tool by clicking its icon in the toolbar.

![Arrow tool icon]

2. Make sure the Snap button is activated and the Grid option is selected on the Snap pop-up menu.

![Snap button]

The Snap function helps you find the correct positions when moving and editing, by making objects “magnetic” to certain positions (or to other objects). When the Grid option is selected and the Grid pop-up menu to the right is set to “Bar” as in the figure above, you can only move objects to the start of bars.

3. Click on the first Bass Synth event, and drag it all the way to the left. Now it will start at the same time as the “Slow Disco” drum event.

4. Drag the next Bass Synth event so that it starts where the first one ends.

5. In the same way, drag the Guitar event and the Strings event so that they start at the beginning too.

6. Move the project cursor to the start of the project and start playback.

![Snap button pop-up menu]
OK, that’s much better, but there are still things to fix. For example, the Wah guitar event ends after one bar, while the other events last two bars. Let’s add a copy of the guitar event:

7. Press [Alt]/[Option], click the Wah guitar event and drag it one bar to the right.
   A copy of the event is created.

Now we have a two-bar, slightly cheesy disco pattern. We could just activate Cycle playback and listen to these two bars over and over again. Instead we’ll use the Repeat function:

8. Select all events by pressing [Ctrl]/[Command]-[A] on the computer keyboard.
   This is the same as using the Select All function on the Edit menu. You can also select multiple events by [Shift]-clicking each event in turn or by dragging a selection rectangle around them with the Arrow tool.

9. Pull down the Edit menu and select “Repeat…”.
   A dialog appears.

10. Set the “Count” parameter to 3 and click OK.
    All events are repeated three times, for a total of four two-bar patterns. This is just the same as copying by [Alt]/[Option]-dragging, but much quicker, especially if you need several copies after each other.

At this point, our song is eight bars long. It could use some variation!
Muting and erasing events

A quick way of adding variation is to remove stuff. We could for example let the different instruments appear gradually instead of all at the same time:

1. Select the Mute tool from the toolbar.

2. Click on the first two Bass Synth events, and then on the first two Hi Strings events. They are “greyed out” indicating that they’re muted.

3. Start playback from the beginning. Fine, now the bass appears at bar 3 and the strings at bar 5.

The Mute tool is very useful for trying out variations, etc. However, now that we’re sure that we want to remove those events, we might as well delete them for real:

4. Select the Eraser tool from the toolbar.

5. Click on the four muted events. They are removed.

6. While you’re at it, remove the first and the second Wah guitar event too.
Splitting and resizing events

Well, maybe that wasn’t such a good idea after all – it may have been
better with some guitar at the beginning, but maybe with some varia-
tion. Here’s an idea:

1. Pull down the Edit menu and select Undo.
The last deleted guitar event reappears.

2. Select Undo again.
The first guitar event reappears.

Cubase SX/SL has unlimited undo – you could go back all the way to
the start of this tutorial by undoing your actions, if needed. However,
we will only need one guitar event for this:

3. Select Redo from the Edit menu.
The first guitar event is removed again.

4. Select the Scissors tool from the toolbar.

Now, the idea is to split the Wah guitar event into smaller sections, to
vary them. However, currently you can only make edits at whole bar
positions because the Snap Grid is set to “Bar”.

5. Pull down the Grid pop-up menu on the toolbar and select “Beat”.
Now you will be able to split or position events at each beat (quarter note) position.
6. Click with the Scissors tool at the fourth beat in the Wah guitar event (at the beat just before the start of bar 3). The event is split in two; one three beat long and another one beat long. If you were to play back this section now, you wouldn’t hear any difference, though.

7. Select the Arrow tool again.

8. Drag the first guitar event two beats to the left and play back. Not too bad, but we could use a little more guitar in the second bar:

9. Position the pointer in the lower left corner of the second guitar event (the one bar long event). The pointer is shown as a double arrow, indicating that you can resize the event by dragging.

10. Click and drag one beat to the left. What you did was to resize the event. In effect, you make the event start playing earlier in the audio clip. Events could be viewed as “windows” looking into an audio clip – by resizing an event you get to see more or less of its clip.

OK, that brought some variation to the start of the "song".
Adding a fade

The strings in bar 5 appear rather abruptly – they would benefit from being faded in. In the Mixing tutorial we created a fade by automating a fader – let’s try another method instead:

1. Click on the first Hi Strings event with the Arrow tool.
   The event is selected. The blue handles at the top are fade and volume handles.

   ![Screenshot of the event selected with Handles]

2. Click at the upper left handle and drag it to the right.
   A thin blue line indicates the fade-in.

   ![Screenshot of the fade line]

3. Play back to hear the fade.
   You can adjust the length of the fade by dragging the handle.
   It’s not bad, but it would be even better if the fade-in was slower at the beginning and quicker at the end (i.e. more exponential).

4. To change the shape of the fade, double click on the fade line.
   This opens a dialog in which you can adjust the fade settings:
5. Click one of the buttons to the right below the curve display to get a more exponential fade curve.

6. Click OK to close the dialog and play back the section again.

Now we would want the same fade to be applied to the second string event. While we could repeat the settings manually, it’s probably easiest to copy the faded event:

7. Remove the second string event by clicking it with the Eraser tool.

8. Select the Arrow tool again, press [Alt]/[Option] and drag the first string event two bars to the right.

As you can see, the copied event retains the fade you created.

That concludes this tutorial!

Now you’ve tried some of the many editing features in Cubase SX/SL’s Project window. If you like, you could use your new skills to change the end of the eight-bar “song”, which ends rather abruptly. For example, you could apply fade-outs, resize events to make the different instruments end one by one, or create more copies to make the song longer.

Or, you can move on to the next chapter, in which we’ll take a look at VST Instruments.
Tutorial 6: Using VST Instruments
About this tutorial

This tutorial shows you how to set up and use VST Instruments – software synthesizers (or other sound sources) that are contained within Cubase SX/SL. For detailed descriptions of procedures and the parameters of the included VST Instruments, see the Operation Manual and the separate “Audio Effects and VST instruments” document.

Preparations

Just like the previous chapter, this tutorial is based on an existing file, included on the Cubase SX/SL DVD.

- Below, we assume that you have followed the previous tutorials and copied the “Tutorial Projects” folder to your hard drive. If not, please see page 132.

1. Close any open projects, by making their Project windows active and selecting “Close” from the File menu.
   This is just to make things clear and avoid confusion – you can have several projects open in Cubase SX/SL if needed.

2. Pull down the File menu and select Open.

3. In the file dialog that appears, navigate to the Tutorial folder on your hard drive, select the file “Tutorial 6.cpr” and click Open.

- At this point, a dialog may appear asking you to resolve missing MIDI outputs.
  This is because you probably don’t have the same MIDI output configuration as the creator of this project. Just click OK to close this dialog for now.
The "Tutorial 6" project opens. If you followed the previous tutorial, this will look oddly familiar… It’s the same eight-bar “song” that you created in tutorial 5, but with three extra tracks.

Activating a VST Instrument

The three tracks at the bottom of the Track list are MIDI tracks, as indicated by the yellow border and the MIDI symbol to the left in the Track list. As you can see, one of the tracks is called “MIDI Bass” – our first goal in this tutorial is to replace the “Bass” audio track with a bass sound from a VST Instrument.

1. Pull down the Devices menu and select VST Instruments.
   The “rack” that appears can contain up to 64 VST Instruments (32 if you are using Cubase SL). However, the maximum number of instruments possible to use simultaneously depends on your computer performance and the complexity of the instruments.
2. Click in the first VST Instrument slot.
   A pop-up menu appears, listing the included VST Instruments.

![VST Instruments Menu]

3. Select “vb-1” from the Synths submenu.
   The VB-1 virtual bass unit is loaded, and its control panel appears.

![VB1 Virtual Bass Unit]

4. In the control panel, make sure the “power button” in the left corner is activated (lit).
   There is a mirror of this power button in the VST Instrument slot.

5. You can keep the control panel open or close it – it doesn’t matter, as long as the VST Instrument is activated (power button is lit).
   Since we cannot hear the instrument yet, there’s not much point in making any control panel settings though. If you close the control panel for the instrument, you can click the Edit (“e”) button in the slot to bring it up again.

   OK, so now we have activated a VST Instrument. Now you need to route a MIDI track to the instrument.
Routing

1. Go back to the Project window and select the “MIDI Bass” track by clicking in the Track list.
   You will notice that a set of tracks has been added for the vb-1 at the bottom of the Track list, within a “VST Instruments” folder. These tracks are for viewing and editing the automation of the vb-1 and its mixer channel - see the Operation Manual.

2. Make sure the Inspector is open.
   The Inspector is the area to the left of the Track list. If it’s not visible, click the Show Inspector button on the toolbar.

3. Make sure the top section of the Inspector is shown.
   If not, click on the Track Name title bar of the Inspector:

   ![MIDI Bass Inspector](image)

   The Inspector shows the settings for the selected track – in this case, the MIDI Bass track.

4. Pull down the “out:” pop-up menu in the Inspector.
   This shows all available MIDI outputs, including any MIDI interfaces you have installed, any audio card-based synthesizers in your computer and all loaded VST Instruments.

5. Select the VB-1 from the pop-up menu.
   The track is now routed to the VB-1. This VST Instrument receives MIDI on any channel, so you don’t have to care about the MIDI channel setting. However, some VST Instruments are multitimbral and can receive different MIDI data on several different channels – if that had been the case you would have had to set the “chn:” setting properly.
Playing back

Now it’s time to replace the audio bass with the VB-1:

1. Click the Mute ("M") button in the Track list for the “Bass” track. This mutes (silences) the track.

2. Click the lit Mute button in the Track list for the “MIDI Bass” track so that it goes dark. You have now unmuted the MIDI Bass track.

3. Start playback from the beginning of the song. You should now hear the VB-1 play the bass line. You may have to adjust the volume so that the VST Instrument matches the audio tracks:

4. Pull down the Devices menu and select Mixer. The Mixer window appears. As you can see, there are separate mixer channel strips for the four audio tracks, the three MIDI tracks and the VB-1.

5. Use the volume fader in the VB-1 channel strip to adjust the level of the bass line.
Adding another instrument

The next MIDI track is called “MIDI Perc” and contains a MIDI percussion pattern. This is an excellent opportunity to check out another of the included VST Instruments – the LM-7 drum machine:

1. Open the VST Instruments window from the Devices menu.
2. Pull down the pop-up menu for the next slot and select “lm-7” from the Drums submenu.
   Make sure its power button is activated.
3. In the Project window, click the Mute (“M”) button for the MIDI Perc track so that it goes dark.
4. Select the track by clicking in the Track list.
5. Use the “out:” pop-up in the Inspector to route the track to the LM-7.
   As soon as you activate a new VST Instrument, it is added to the list of available MIDI outputs in Cubase SX/SL.
   Now, let’s listen to the percussion track all by itself:
6. Click the Solo (“S”) button in the Track list for the MIDI Perc track.
   All other tracks are muted (their Mute buttons light up).
7. Start playback.
Hmm, nothing can be heard – but the indicator in the Track list shows that MIDI notes are being played! The problem here is that the wrong program (drum set) is selected for the LM-7. For this track to play back properly, we should choose a percussion set. This can be done directly in the Inspector or the VST Instruments window, but let’s check out the control panel for the LM-7 instead:

8. Click the Instruments Settings button for the track in the Inspector (next to the “chn:” pop-up).
Since the track is routed to a VST Instrument, this opens the control panel for the instrument. This way, you don’t have to go via the VST Instruments window to make settings for a VST Instrument.

The LM-7 panel. The labels underneath the buttons show the available sounds in the selected program – not many percussion sounds here.

9. Pull down the program pop-up menu in the control panel and select “Percussion”.
Under Windows, you will find this pop-up menu at the top of the panel; on a Mac it is at the bottom of the panel.

10. Start playback again.
That’s more like it.
11. Go back to the Project window and click the lit Solo button for the track to turn off the Solo function.

All tracks are unmuted again – except the tracks that were muted from the beginning (Bass and MIDI Strings).

Again, you may want to adjust the volume of the LM-7. If you open the mixer, you will find that a new channel strip has appeared – use the fader as before.

**Playing a VST Instrument in real time**

The next part of this tutorial requires two things:

- That you have a MIDI keyboard or similar connected to a MIDI input on your MIDI interface.

- That you are using audio hardware with fairly low latency (see page 53). If the latency is too high, it will be almost pointless to try to play a VST Instrument in real time – the delay between when you press a key and when you hear the sound will be too large. If you’re uncertain about your latency, just proceed with the steps below – you’ll find out whether it’s OK or not.

Now we’ll make use of the third included VST Instrument: the a1 synthesizer. Here, we will use it with a string sound (replacing the “Strings” audio track) but you can of course choose another sound if you like.

1. Open the VST Instruments window from the Devices menu.

2. Pull down the pop-up menu for the third VST Instrument slot and select “a1” from the Synths submenu. Make sure its power button is activated.

3. In the Project window, mute the “Strings” track and unmute the “MIDI Strings” track, by clicking their respective Mute buttons in the Track list.

4. Select the MIDI Strings track.

5. In the Inspector, pull down the “out:” pop-up menu and select “a1”.
This routes the track to the a1 synthesizer. However, now we also need a MIDI input, since you’re going to play the VST instrument “live”:

6. Pull down the “in:” pop-up menu and make sure the correct MIDI input is selected.
   This should be the MIDI input to which your keyboard (or other controller) is connected. If in doubt, you can select the “All MIDI Inputs” option, in which case the track will accept MIDI from all available inputs.

7. Click the monitor button in the Track list for the MIDI Strings track, so that it lights up.
   When the monitor button is activated, incoming MIDI is sent directly to the selected output – in this case the a1 synthesizer.

8. Try playing your MIDI keyboard.
   You should hear the sound from the a1. However, you may not want to use the default, first sound:

9. Use the pop-up menu below the “chn:” setting in the Inspector to select a suitable synth sound.
    Since we’re supposed to replace the Strings part, you may for example want to try the “Solina WMF” patch (under the PAD heading).

10. Start playback and play along!
Recording

When you've figured out something to play, it's time to record this. Recording for a VST Instrument is done just like "normal" MIDI recording:

1. Click the record enable button for the MIDI Strings track.
   In previous tutorials we recorded from the project cursor position – now we will start recording at the left locator, with a precount.

2. Pull down the Transport menu and make sure the “Start Record at Left Locator” setting is activated.

3. Move the left locator to where you want the recording to start.
   You can drag the locator flag in the ruler, edit the position numerically in the Transport panel or press [Ctrl]/[Command] and click in the ruler.

4. Move the right locator to a position to the right of the left locator.
   This can be done by pressing [Alt]/[Option] and clicking in the ruler.

5. Activate Precount on the Transport panel.

6. Click the Record button on the Transport panel to start recording.
   You will hear a two bar count-in and then the recording will start.

7. Play along with the background tracks.
8. When you’re done, click Stop.
   A MIDI part has been created on the MIDI Strings track.

9. Play back to listen to your recording.
   If you want to try again, select Undo from the Edit menu and proceed from step 3 above.

10. When you’re done, click the record enable button for the track to deactivate it.

Making parameter settings

After you’ve recorded your synth or string part (and possibly adjusted its volume in the mixer) you may want to adjust the actual sound as well. This can either be done by selecting another patch in the Inspector or VST Instruments window, or by using the synth parameters in the control panel for the a1.

First, you may want to set things up so that the whole piece plays back over and over again.

1. In the Project window, press [Ctrl]/[Command]-[A] to select all events and parts.

2. Pull down the Transport menu and select “Locators to Selection”.
   This moves the left locator to the start of the first event and the right locator to the end of the last.
3. Make sure Cycle is activated on the Transport panel, and start playback. The whole "song" will now play back repeatedly.

4. Click the Instrument Settings button in the Inspector (to the left of the "chn:" pop-up) for the MIDI Strings track, to bring up the a1 control panel.

5. While the music is playing, try adjusting the parameters by clicking and dragging the controls in the panel.

   The a1 is laid out much like a traditional analog synthesizer. You may for example want to adjust the Cutoff and Resonance settings in the Filter section.
Automating the changes

Just like other mixer and effect settings in Cubase SX/SL, parameter changes for VST Instruments can be automated. Proceed as follows:

1. Stop playback and move the project cursor to the start of the project.
2. Turn off the Cycle button on the Transport panel.
   This is simply a "safety measure" – if you record automation in Cycle mode, you may accidentally overwrite parameter changes you have made on a previous Cycle lap.
3. Click the Write ("W") button in the a1 control panel.
4. Start playback.
5. Adjust the parameters you want – create filter sweeps, add modulations, etc.
6. When you’re done, click Stop.
7. Deactivate the Write ("W") button in the a1 control panel.
8. Click the Read ("R") button next to it.
   This makes the VST Instrument “read” the recorded automation during playback.
9. Start playback from the beginning of the project.
   You will now see the controls moving, replicating your recorded parameter adjustments.

That concludes the VST Instrument tutorial! If you’re satisfied with what you recorded, you may want to save the project under a new name by selecting “Save As...” from the File menu.
Tutorial 7: Tempo matching
audio loops
About this tutorial

This tutorial aims to introduce one of the basic but perhaps most useful Audio Warp features in Cubase SX/SL. Audio Warp is a generic term for a number of tools and functions that (amongst other things) allow you to tempo match audio loops to any given tempo using real-time time stretch.

In this chapter we will describe how to use the Audio Tempo Definition tool to calculate the tempo of the loops used in the project, and how to enter Musical Mode. Once this is set, the audio loops will follow any tempo changes in real time, just like MIDI events!

Loops, i.e. sampled musical phrases or beats of a specific length (a set number of bars at a specific tempo), have of course been around for a long time.

Working with loops has several advantages; by establishing a basic set of building blocks, e.g. a drum beat, a bassline and some musical and/or vocal loops, you can get a song project underway very quickly, without involving time consuming programming. There are scores of sample CDs on the market, covering every possible instrument category and musical genre.

With Cubase SX/SL’s Audio Warp features you can seamlessly integrate loops into your projects, matching any loops to the project tempo in real time!
Setting up

This tutorial is also based on an existing file, included on the Cubase SX/SL DVD.

- Below, we assume that you have followed the previous tutorials and copied the “Tutorial Projects” folder to your hard drive. If not, please see page 132.
- Open the folder “Tutorial Projects” on your hard disk and double click on the file “Tutorial 7.cpr”. Whether file extensions are shown or not depends on the settings for your operating system.

The “Tutorial 7” project opens in Cubase SX/SL. The project is based on the same basic audio and MIDI files as used in the previous tutorials. The Project contains three audio tracks and two MIDI tracks connected to VST Instruments.

The audio tracks contain loops, either 1 or 2 bars long. The Drums track contains a 2 bar loop repeated 4 times, the “Wah guitar” loop on the Guitar track is 1 bar and repeated 6 times, and the events on the Strings track are 2 bars long and repeated twice. The tempo is set to 75 bpm.

We will now increase the tempo gradually from 75 bpm to 90 bpm using a ramp curve in the Tempo Track editor. Proceed as follows:
1. Open the Tempo Track editor from the Project menu. The tempo is currently set to 75 bpm which is shown on the vertical axis to the left.

2. Open the Insert curve pop-up on the toolbar and select “Ramp” as curve type.

3. Select the Pencil tool to the left on the toolbar.
4. Using the ruler and the tempo axis as guides, position the cursor at the horizontal position shown in the picture (the end of bar 8) and the vertical position of approximately 90 bpm, and click to add a point. When you point in the Tempo Track display the tempo is shown in the box above the tempo axis in the top left corner.

The tempo will be gradually increased from 75 bpm to 90 bpm over the 8 bars.

5. When you are done, close the Tempo Track editor.

6. Start playback, and stop again when you have heard enough!
As you can hear, the audio and MIDI tracks drift out of sync almost immediately. MIDI events are always adjusted automatically to the project tempo, whereas audio events have a fixed tempo and therefore remain unchanged. That means, that raising the tempo will cause adjacent audio loop events to overlap, so that the end of the loop is cut.

In the Project window, this overlap is indicated by the darkened areas in the beginning of the audio events. As the tempo gradually increases the overlaps become greater.

In the following section we will make the loops follow the tempo changes just like MIDI tracks by activating Musical Mode!
Activating Musical Mode

In this particular case we happen to know that the loops in this song have a tempo of 75 bpm. However, you can use the basic method outlined in this section to match loops to any tempo even if you don’t know their tempo or if your loops have different tempos.

The first step is to calculate the original tempo based on the loop length. Proceed as follows:

1. Double-click one of the “Slow Disco” events on the Drums track in the Project window.

   The Sample Editor now opens. On the Sample Editor’s toolbar you can find three numerical edit fields for setting time signature, audio tempo and bars & beats. For now, these fields are grayed out and cannot be edited.

   If you do not see these fields in the Sample Editor toolbar, try adjusting the toolbar elements, as described on page 234.

2. Select the Audio Tempo Definition Tool (the button with a note symbol).

   Note that there is a similar stand-alone button with a note symbol on the toolbar. This is used to activate Musical Mode which is described later.

3. Now the time signature, audio tempo and bars and beats edit fields become active and suggested values are displayed. The length (displayed in the infoline) and audio tempo values have been calculated automatically, based on the length of the loop compared to 120 bpm.
Here, the number of bars was calculated to 3 bars. But as we know the loop is in fact two bars long, we should change this:

4. Use the up/down arrows in the bars edit field to set the length to 2 bars. The tempo is recalculated automatically to 75 bpm.

5. Click the Musical Mode button so that it lights up. As the loop events on the Drums track refer to the same clip they are all adjusted to fit exactly 2 bars (as long as Musical Mode is activated) regardless of the tempo!


7. Double-click one of the “Wah guitar“ events, and repeat steps 2 to 6, but set the length to 1 bar and select the “Mix“ warp setting preset.
8. Lastly, repeat this procedure for one of the Hi Strings events, setting
the length to 2 bars and the “Mix” warp setting preset.
Now all audio events are in Musical Mode, and do not overlap anymore.

The audio events now follow the tempo exactly, just like MIDI tracks!

- The same general method can be used for any loops as long as the in-
  herent tempo is stable. Simply enter the length of the loop and activate
  Musical Mode.
  Alternatively, you can adjust the audio tempo value, if you know the original tempo of
  your loop.

  You can also tempo or groove match audio files with fluctuating tempo
  using Warp Tabs, quantize audio files and much more. The main Audio
  Warp features are described in the “Audio Warp realtime processing”
  chapter of the Operation Manual.
Tutorial 7: Tempo matching audio loops
Tutorial 8: Arranging with the play order function
About this tutorial

This tutorial describes how you can arrange projects using the play order function. Play order allows you to work with parts and events in a non-linear fashion. Instead of moving, copying and pasting events in the Project window event display to create a linear project, you can define how different sections are to be played back, like a “playlist”.

You start by creating a play order track. On this track you can draw play order parts that define time line regions, or “zones” in the current project. Parts can be added to a play order list where you can specify how many times an event is to be repeated and in what order events should be played.

This offers a different and more pattern-oriented way of working which complements the usual linear editing methods in the Project window. When you have created a play order list that you like, you have the option of “flattening” the list, which creates a normal linear project according to the play order list and removes the play order track.
Setting up

This tutorial is also based on an existing file, included on the Cubase SX/SL DVD.

- Below, we assume that you have followed the previous tutorial and copied the “Tutorial Projects” folder to your hard drive. If not, please see page 132.

- Open the folder “Tutorial Projects” on your hard disk and double click on the file “Tutorial 8.cpr”. Whether file extensions are shown or not depends on the settings for your operating system.

The “Tutorial 8” project opens in Cubase SX/SL. Again, the Project uses the same basic loops as used in the previous tutorials. It contains four audio tracks and one MIDI track which is connected to the LM-7 VST Instrument.

Adding the Play Order track

The first step is to create a play order track:

1. Select “Play Order” from the Project menu “Add Track” submenu. A play order track is added. There can be only one play order track in a project.

2. On the Project window toolbar, make sure Snap is activated, with the Grid resolution set to Bar. This means that you can create events of exact bar lengths.
Creating play order parts

In this section, we shall draw some play order parts on the play order track.

1. Select the Pencil tool on the toolbar.

Now, let’s define a two bar “zone” by drawing a play order part.

2. On the play order track, use the Pencil tool to draw a 2 bar part from the beginning of bar 3 to the end of bar 4. A play order part is added, by default this is named “A”. Any consecutive parts you add will be named in alphabetical order. You can rename play order parts but for now let’s keep the default names.

- Do not double-click play order parts at this stage. This would add the part to the play order list which we will describe later.
3. Using the same method, first draw a one bar part between the start and end of bar 1, then a second one bar part between the start and end of bar 7.
You should now have three play order parts: A, B and C. On the time line, B is placed first, A is second and C is last.

Up until now, we have added play order parts of exact bar lengths. We will now add three new parts that are shorter than a bar:

4. On the Project window toolbar, set the Grid resolution to “Beats”.
This means that you can draw parts in beat increments. As the time signature is 4/4, there are 4 beats to a bar.

5. Click and hold anywhere on the play order track with the Pencil tool.
There should be a rectangular outline visible. This time, we want to create a part exactly 1 beat long. You can see exactly how many beats long the new part will be in the tool tips that appear.
6. Release the mouse button to create the new part.

7. Create a new part in the same way, but make this 3 beats long. Like in the previous step, it doesn’t matter where you draw the part, as we will move them later.

8. Finally, create another new part, one beat long. You should now have 6 parts, from “A” to “F”. We are now going to move the three new parts “D” to “F”.

9. Select the Arrow tool. Make sure that Snap is activated and that the Grid resolution is set to Beat.

10. Click and drag part “D” to the start of bar 3 (at the same position part “A” starts). Play order parts can freely overlap.

11. In the same way, move part “E” to position 4.02, i.e. the second beat of the fourth bar. The position is displayed in the tooltip as you move the part.

12. Finally, move part “F” to the second beat of the first bar.

Next, let’s see what we can do with the parts in the Play Order Editor!
Creating a play order list

The Play Order Editor is where you assign parts to a play order list. In this list you can decide how many times a part should repeat and in what order they should play. Proceed as follows:

1. In the Track list click the “E” button of the play order track. The editor opens.

To the right all the parts we created are listed, in the order they appear on the timeline. To the left is the play order list which is currently empty (unless you have accidentally double-clicked a play order part in the event display - see below).

By adding parts to this list you create play order “steps”. The play order of the parts added to this list is from the top down.

Now let’s add parts to the play order list. In this tutorial the first step will play part “A”:
2. In the play order Parts section, double-click the “A” part in the Name column.
The part is added at the top of the play order list to the left. You can also drag parts
from the Parts window into the play order list or double-click play order parts in the
event display which adds them to the play order list.

![Play Order Editor](image)

Activate the Activate Play Order and click the Start button. The region
or zone defined by part “A” will repeat until you click the Stop button.
We want this part to repeat 4 times. This is done as follows:

3. Click in the Repeats field, type in 4 and press [Enter].
There should now be 4 bars in the Counter column indicating that this part will repeat
4 times before moving to the next play order step.

4. Make sure part “A” is not selected (the Name and Repeats columns
are dark) in the play order list by clicking somewhere below the list.
The reason for this is that if a part is selected in the play order list, the next part you add
(by double-clicking in the Parts window) will be placed above the selected part, which
we don’t want in this case. Should this happen by mistake, you can easily rearrange
the order by moving parts manually in the list.

5. As the second play order step, add part “B”.
It is added below part “A”. We only want this to repeat once, so you can leave
the Counter column as it is.

6. Using the same methods, add the following parts (in this order): part
“C”, part “D”, and part “E”.
Each part should only play once so the Repeats column should read 1 for these parts.

7. Repeat step 6 twice.
The part step order from the top down should now be “A/B/C/D/E/C/D/E/C/D/E”.

CUBASE SX/SL
16 – 208 | Tutorial 8: Arranging with the play order function
8. Finally, add part F to the bottom of the list, and set it to repeat 4 times. The list should now look like in the picture below.

9. Click in the arrow column for part A at the top of the list so that the arrow becomes blue.

10. Make sure that Play Order mode is activated by clicking the Activate Play Order mode button.

11. Position the Play Order Editor window so you can see the play order track in the project window.

12. Activate playback, either from the Play Order Editor or the Transport panel.

The following happens:

- First part A is repeated 4 times. The blue arrow in the left column indicates which play order part is currently playing.
After the fourth repeat, the project cursor jumps to part B and plays 1 bar with only drums and percussion.

Next to part C which plays 1 bar with a string note rising in volume. This is cut off as the cursor jumps back to bar 3 where part D plays one beat before jumping forward to part E which is 3 beats long (starting at the second beat of the fourth bar). This repeats 2 more times.

Finally, part F, which plays a short drum figure, repeats 4 times before the play order starts over with part A.

You should now understand the basic operation of the play order function! It is very easy to use, and is especially useful if you like to play around with the structure of a song.

Many types of modern dance music and electronica consist of repeated sections with subtle variations and for this purpose the play order function is ideal. If you want to play and record over a structure created by the play order function, you can make the current arrangement into a linear project at any time by using the “Flatten Play Order” function.

For a complete description of the play order function please refer to the “The Play Order track” chapter of the Operation Manual.
Tutorial 9: Editing audio
About this tutorial

This chapter describes the basic procedures for editing audio in the Sample Editor and how to use the Process functions. For a full description of all settings, options and operations available, please refer to the chapters “The Sample Editor” and “Audio Processing and Functions” in the Operation Manual.

The Sample Editor

The Sample Editor allows you to edit audio, by cutting and pasting, removing, drawing or processing audio data. This editing can be called “non-destructive”, in the sense that you can undo changes or revert to the original versions at any point, using the Offline Process History (see page 217).

What is shown in the Sample Editor?

An audio event plays a section of an audio clip, see page 60. When you open the Sample Editor for an audio event, it will display the waveform image of the corresponding audio clip. Above the waveform display is the thumbnail display, which provides an overview of the whole clip, with a blue rectangle corresponding to the section currently shown in the waveform display. You can navigate by dragging or resizing the blue rectangle in the thumbnail display.
Editing audio in the Sample Editor – an example

This example describes how to remove a section of audio and insert it at another position, by using cut and paste in the Sample Editor:

1. Open the Sample Editor by double clicking an audio event in the Project window.

2. Select the Range Selection tool by clicking its icon on the toolbar.

3. To select a section of the clip, click and drag in the waveform display.
   - Click at the position where you wish the selection to begin, and drag...
4. Release the mouse button when the selection is complete. You can adjust the selection by dragging its edges.

5. Select “Cut” from the Edit menu. The selection is removed from the clip and moved to the clipboard. The section to the right of the selection is moved to the left to fill out the gap.

Selecting “Paste” from the Edit menu will copy the data on the clipboard into the clip according to the following rules:

- If there is a selection in the editor, the pasted data will replace it.
- If there is no selection (if the selection length is “0”), the pasted data will be inserted starting at the selection line. By clicking, you can place the selection line at any position in the event. The section to the right of the line will be moved to make room for the pasted material.

6. For this example, make the end of the event visible, either by using the scrollbar or by moving the blue rectangle in the thumbnail display, and click to place the selection line at the event end position.

7. Now select “Paste” from the Edit menu. The selection that was cut is inserted at the position of the selection line.
Processing audio

The Process submenu on the Audio menu contains a number of audio processing functions. The functions can be applied to selected audio events or clips, or to a selected range.

In this example, we will apply normalizing to a selected audio event. The Normalize function allows you to specify the desired maximum level of the audio. A common use for normalizing is to raise the level of audio that was recorded at too low an input level.

Proceed as follows:

1. Select an audio event by clicking on it with the Arrow tool in the Project window.
2. Pull down the Audio menu and select Process.
   A submenu opens, containing the available processing functions.
3. Select “Normalize” from the submenu.
   The Normalize dialog opens.

4. For this example, use the default “Maximum” setting of 0.00 dB.
   - You can use the “Preview” button to listen to the result of the processing if you wish.
     The processing will not be applied, just auditioned.
5. Click “Process” to apply the processing.
   The audio event is normalized.
Applying an effect plug-in (Cubase SX only)

As described on page 141, you can add “real-time” effects in the mixer. However, sometimes it is useful to apply an effect directly to an audio event or clip. This is done using the Plug-ins submenu on the Audio menu:

1. Select an audio event in the Project window.  
   In this example, select the event that was normalized in the previous example.

2. Pull down the Audio menu and select Plug-ins.  
   A submenu appears, listing the installed effect plug-ins. The effects are organized in subfolders according to the effect category.

3. Select the “Chorus” effect from the Modulation subfolder.  
   The Chorus dialog appears.

4. Use the parameters in the upper part of the dialog to set up the effect as desired.  
   Clicking the Preview button will let you audition the settings before actually applying the effect.

5. Click the “Process” button to apply the effect.
Using the Offline Process History dialog

The Offline Process History dialog allows you to remove or modify audio processing at any time. It is even possible to modify or remove some processing “in the middle” of the Process History, while keeping later processing! Whether this can be done or not depends on the type of processing performed, as described in the chapter “Audio Processing and Functions” in the Operation Manual.

In this example, we will remove the Normalize function, but keep the applied Chorus effect:

1. Select the audio event in the Project window.
2. Pull down the Audio menu and select “Offline Process History…”. The Offline Process History dialog appears. This contains a list of the processing functions applied to the audio clip, with the most recent operation at the bottom of the list.

3. Select the “Normalize” action by clicking on it in the list.
4. Click the “Remove” button. You are asked whether you really want to remove the processing.
5. Click “Remove”. The Normalize processing is removed, but the Chorus effect is kept.
Tutorial 10: Editing MIDI
About this tutorial

This chapter describes the basic operations for editing MIDI in the Key Editor. For a full description of MIDI editing please refer to the chapter “The MIDI Editors” in the Operation Manual.

This chapter assumes that you have read the instructions in the chapter “Recording and playing back MIDI”, and have access to a recorded MIDI part.

Opening the Key Editor

By default, you open the Key Editor by double clicking a MIDI part in the Project window.

The Key Editor window shows the contents of one or several parts. You can have several editors open at the same time.

- The note display is the main area in the Key Editor. It contains a grid, in which MIDI notes are shown as boxes. The width of a box corresponds to the note length, and the vertical position of a box corresponds to the note number (pitch), with higher notes higher up in the grid.
- The piano keyboard to the left serves as a guide for finding the right notes.
- The area at the bottom of the Key Editor window is the controller display, used for viewing and editing velocity, MIDI controllers, etc. (see page 225).
Drawing events in the Key Editor

When you move the pointer in the note display, its bar position is indicated in the toolbar, and its pitch is indicated both in the toolbar and on the piano keyboard to the left. This makes it easy to find the right note and insert position.

To insert new notes in the Key Editor, proceed as follows:

1. Select the Pencil tool.

2. Click at the desired time position and pitch (height).

A note is inserted with the following additional properties:

- If you just click once, the created note will get the length set on the "length Q" pop-up menu on the toolbar.
  You can create a longer note by clicking and dragging the pointer to the right with the mouse button pressed. The length of the created note will be a multiple of the Length Quantize value.

- The notes will get the insert velocity value set on the toolbar. Velocity values are viewed and edited in the controller display, see page 225.
### About Snap

Snap activated on the toolbar.

The Snap function helps you find exact positions when editing in the Key Editor. It does this by restricting horizontal movement and positioning to certain positions. Operations affected by snap include moving, duplicating, drawing, sizing, etc.

- When the “Bars+Beats” display format is selected in the ruler, the quantize value on the toolbar determines the snap value.
- When any time-based display format is selected in the ruler, editing snaps to the visible grid.

### Selecting and moving events

To select events in the Key Editor window, proceed as follows:

1. Make sure the Arrow tool is selected.  
   If not, click on the Arrow icon in the toolbar.

2. To select a single event, click on it.  
   To select several events, use [Shift]-clicking or click and drag a selection rectangle.

   To move events in the Key Editor window, proceed as follows:

1. If you want to move more than one event, select them as described above.  
   If you want to move a single event, you don’t need to select it.

2. Click on one of the events with the Arrow tool and drag it to the desired position.  
   If Snap is activated on the toolbar, this determines the exact position of the moved events.
About quantize

Quantizing in its fundamental form is a function that automatically moves recorded notes, positioning them on exact note values.

- Normally, quantizing affects MIDI notes only (not other event types). However, you can choose to move the controllers together with their respective notes by activating the “Move Controller” option in the Quantize Setup dialog. This dialog is described in detail in the Operation Manual.

- In the Project window, quantizing applies to all selected parts, affecting all notes within them.

- In the Key Editor, quantizing applies to all selected notes. If no notes are selected, all notes will be affected.

Here follows a simple step by step example of using the quantize function:

1. Let’s say you have recorded a series of eighth notes, which you have opened for viewing in the Key Editor.
   As shown in the illustration below, some of them have ended up slightly beside the exact eighth note positions.

   ![Illustration of quantize example](image)

   Now there are two basic ways you can proceed:

   - To quantize all notes, no notes need to be selected.

   - To quantize some notes only, select them.
     Only the selected notes will be quantized.

     In this example, we have chosen to leave all note events unselected – this means all notes will be quantized.
2. Open the quantize pop-up menu on the toolbar.
   The menu contains three main categories of note values, Straight, Triplet and Dotted.

3. For this example, select straight 1/8 Note quantize from the menu.

4. Select “Over Quantize” from the MIDI menu.
   This quantizes the MIDI notes according to the Quantize pop-up menu setting.
Editing velocity in the controller display

The Key Editor controller display is used for viewing and editing various values and events. The controller display can have one or several lanes, each showing a separate event type.

- If no controller display is shown, right-click (Win) or [Ctrl]-click (Mac) anywhere in the editor window and select “Create New Controller Lane” from the pop-up menu that appears. This displays the controller display at the bottom of the Key Editor window.

- If you click the arrow to the left of the controller display, a pop-up appears allowing you to select what event type you wish to view. For this example, select “Velocity”.

- When “Velocity” is selected for viewing, the controller display shows the velocity of each note as a vertical bar.

![Velocity events in the controller display.](image)

- To change the velocity of a single note, click on its velocity bar with the Pencil tool, and drag the bar up or down. If there are several notes on the same position only the velocity value of the selected note is changed. If there is no note selected the velocity values for all notes on this position will be changed. While you drag, the current velocity value is shown in the display to the left.

- To change the velocity values of several notes, you can either draw a “velocity curve” with the Pencil tool or use the Line tool to create a velocity ramp.
An example

In the following example we will create a velocity ramp using the Line tool:

1. Add some notes in the note display by using the Pencil tool.

2. Select the Line tool from the pop-up menu that appears by clicking on the Line tool icon.
   The other tools available on this pop-up menu are described in the Operation Manual.

3. Click where you want the ramp to start, move the pointer to where you want the ramp to end and release the mouse button.
   When the mouse button is released, the velocity values will be scaled according to the ramp curve.
Tutorial 11: Customizing
About this tutorial

This chapter describes how you can set up and customize Cubase SX/SL in various ways according to your personal preferences.

Most parts of Cubase SX/SL can be customized to your liking: key commands can be freely changed and assigned to functions, the general look of the program can be changed, items can be hidden in the toolbars, the Track list and the Transport panel, etc.

This tutorial deals with adapting your work environment to what you need to do and how you want to do it. We will describe how to set up preferences, key commands, workspaces etc. and create a template.

This will show you some of all the ways in which Cubase SX/SL can be tailored to best suit your needs and purposes. However, you should also read the chapter “Customizing” in the Operation Manual since many available options and settings are not described in this chapter.
Setting preferences

Most of the settings for making the program behave the way you want are found in the Preferences dialog:

1. Pull down the File menu (or, if you are using Mac OS X, the Cubase SX/SL menu) and select Preferences. The Preferences dialog appears. This is divided into a number of pages you can select in the list to the left.

2. Select the “Editing” item in the list to the left. The editing page contains options for how the program should behave.

3. Activate the option “Auto Select Events under Cursor” by clicking in its box to put a checkmark in it. When this option is activated, all events “touched” by the project cursor are automatically selected. This can be helpful when rearranging projects, since it allows you to select whole sections (on all tracks) simply by moving the project cursor.
Now, let’s activate another useful option. If you are usually working on single projects for long periods of time (i.e. more than one “session” with the program), you might want to have that project automatically open when you launch Cubase SX/SL:

4. In the list to the left in the dialog, select “General”.
   The General settings page is displayed to the right. Among other things, it contains the “On Startup” pop-up menu, which allows you to specify what should happen each time you launch Cubase SX/SL.

5. Pull down the “On Startup” pop-up menu and select the option “Open Last Project”.
   Now, you have instructed Cubase SX/SL to open the last saved project each time you launch the program.

6. If you like, make other settings in the Preferences dialog.
   To get a description of the options and settings on the Preference pages, click the Help button.

7. When you are finished, click OK to close the dialog and apply the settings.
   The changes you have made will be saved globally for all projects you work on.
Next, we will set up some key commands. Key commands are shortcuts for menu items and functions, meaning you can invoke an item or a function just by pressing a key or a combination of keys on your keyboard. Key commands can be customized any way you like, so if you use a particular function very often, you can assign a key command for it. Or if it already has a key command assigned to it by default, you can change this to one that suits you better.

• The default key commands in Cubase SX/SL are listed on page 247. Let’s say that you often use the “Audio File” command from the Import submenu, and want to assign a key command for it:

1. From the File menu, select “Key Commands…”.
   The Key Commands dialog opens. In the left part of this dialog, all main menu items and a large number of other functions are arranged in a list of different categories, displayed as folders. Each category folder in turn contains a number of commands – menu items and functions.

   ![Key Commands dialog](image)

2. Since we want to assign a key command for the “Audio File” command from the Import submenu, and we know that menu item is located on the File menu, navigate to the folder called “File”.
3. Click the “+” button to the left of the folder to open it.
   You can now see a list of items and functions it contains.
4. In the list, select the item “Import Audio File”.
   As you can see, this function has no key command assigned to it, as indicated by the
   empty “Keys” column and the “Keys” section in the top right corner.
   Now, how do we know which key command we can use — that is, find
   a key command that isn’t already used for some other function?
   Here’s how to find out:

5. Click in the “Type in Key” field to the right.
   There is now a flashing cursor in the field, indicating that you can type in it.

6. Let’s try [A], by pressing the A-key.
   No luck. As you can see by the text that appears under the field, the A-key is already
   assigned to the function “Adjust Fades to Range”.

7. OK, then let’s try a combination — how about [Shift]-[A]?
   Success! Since no text appears under the text field, that key command is not assigned
   to any function. Now we can proceed to assign that particular key command to the
   “Import Audio File” function.

8. Again, make sure “Import Audio File” is selected in the list to the left.

9. Now, click the “Assign” button above the text field.
   The key command Shift+A appears in the Keys section.

We have now set up a key command that will be available in the pro-
gram after we close the Key Commands dialog.

However, we’re not quite done here yet so don’t close the dialog.
Setting up a macro

We will also try setting up a key commands macro. A macro is a stored combination of several functions or commands. By invoking the macro you can perform these functions and commands in one go, rather than manually performing them one at a time.

In this example, we’ll create a macro that will:

- Select all events in the project window
- Position the left and right locator to encompass the selection.

This is done by combining the commands “Select All” from the Edit menu and the command “Locators to Selection” from the Transport menu:

1. In the Key Commands dialog, click the “Show Macros” button in the lower part of the dialog.

The macro settings are now shown in the lower part of the dialog and the Show Macros button is renamed Hide Macros, indicating that you can close the macros section by clicking the button again.

2. Click the button “New Macro”.

A new, unnamed macro appears in the macros list to the left. Name it by typing in the desired name.

Now, we need to select the first command that should be executed in the macro – the “Select All” command:

3. Since we know the “Select All” command is located on the Edit menu, open the Edit folder in the Commands list, navigate to the item “Select All” and click on it to select it.

4. Click on the “Add Command” button in the macros section.

As you can see, the “Select All” command is added to the macro in the macros list.
5. Now repeat this procedure to select the item “Locators to Selection” from the Transport folder and add it to the macro.

That’s it, we have now created a macro with two commands. The macro will be available for instant selection and execution on the macros sub-menu at the bottom of the Edit menu in the program.

If you like, you could also assign a key command to the macro, by selecting the macro in the Commands list and assigning a key command to it as described above. We will not do that now, however. What we will do is save the key commands settings we have made, including the macro settings, as a preset for instant recall later.

### Changing the look of the toolbar

In Cubase SX/SL you can change the contents and look of several sections and panels, including the Transport panel, the toolbars in the Project window and the editors, and the track controls in the Track list. The changes you can make include hiding unwanted controls and settings from view and reordering items on the panels.

Below we will try customizing the toolbar in the Project window. As you will see, this can show a number of settings and controls – you may not need all items that are shown by default, or you may need items that are hidden by default. We will also try changing the positions of items on the toolbar.

1. Make sure the Project window is visible – you may want to maximize the window so that all items on the toolbar can be seen.

2. Right-click (Win) or [Ctrl]-click (Mac) anywhere on the toolbar.
   A pop-up menu appears. The upper half of the menu lists all the elements that can be shown or hidden on the toolbar.

3. Try activating the “Performance Meter” item.
   A checkmark next to an element means it is visible on the toolbar. As you can see, the menu closes and a miniature performance meter appears to the left on the toolbar.

4. Bring up the pop-up menu again.
   The items on the lower half of the menu are presets, allowing you to quickly select alternative toolbar setups. It’s also possible to store your own presets, for instant recall:
5. Select "Setup..." from the pop-up menu.
   A dialog opens.

   ![Dialog showing tool setup options]

   In this dialog you decide which elements should be shown and hidden,
   by selecting them and moving them from column to column using the
   arrow buttons. The left column displays the currently visible items, and
   the right column the currently hidden items on the toolbar. As you can
   see, several items are hidden by default (listed in the right column).

   You can also configure the layout of the toolbar here, by moving ele-
   ments with the Move Up and Move Down buttons. Let’s try moving the
   tool buttons to the left on the toolbar:

6. Click the Tool Buttons item to select it in the left list.

7. Click the Move Up button.
   The Tool Buttons item is moved up in the list and the tool buttons are moved to the left
   on the toolbar. They now appear to the left of the transport buttons.

   Let’s store this setup as a preset:

8. Click the disk button by the Presets pop-up menu.
   A text field appears, allowing you to name the current configuration.

9. Type in a name and click OK.
   The saved preset appears in the Presets field. You can now select this saved configu-
   ration any time from the Presets pop-up menu in this dialog, or directly from the pop-up
   menu brought up by right-clicking or [Ctrl]-clicking the toolbar.

   - You can customize the toolbars in the editors as well as the Transport
     panel and the Track list in much the same way.
     Read more about this in the Operation Manual.

   We’re done here, so close the dialog and let’s move on.
Changing the appearance of the program

Not only can you hide or reorder individual elements and controls, you can also adjust the general appearance of the program to your liking:

1. Open the Preferences dialog from the File menu (Windows) or Cubase SX/SL menu (Mac OS X).
2. Select the Appearance page.

3. Try selecting another Basic Appearance Scheme from the pop-up at the top of the page.
4. Click Apply to apply the changes.
5. Try adjusting the intensity sliders. They determine the brightness and grid contrast in the Project window and editors. Again, you need to click Apply to apply your settings.
6. When you've found an appearance you like, click OK to close the dialog and apply all changes.
Applying track colors

You can use color scheming for easier overview of certain tracks and events in the Project window. Applying colors is divided into two areas; track and event colors.

- A track color is reflected in the Inspector, Track list, in the corresponding channel in the Mixer, and in all parts and events for the track in the event display.
  Track colors can be switched on or off globally.

- Event colors are reflected in parts and events in the event display and are independent from the track colors.
  An applied event color "overrides" the track color, if both are used.

To apply a color for a track, proceed as follows:

1. Make sure that the Inspector is visible to the left of the Track list.

2. You activate track colors by clicking the color strip at the top of the Track list.
In the Inspector, the track name bar at the top becomes light grey, and a field (light grey) to the left of the output activity meters in the Track list is added. A small arrow appears to the right in the track name bar.

3. Click the arrow to bring up the color palette. This palette or color set can be edited in the Event Color dialog.

4. Pick a color to apply it to the selected track.

- As you can see, the chosen track color is reflected in the Inspector title bar, in the field by the output activity meter in the Track list, and in any parts or events on the selected track.
• If you open the Mixer, the track color is reflected in the field below the meter for the corresponding channel. You can also set the track color from the Mixer by clicking in this field.

Colorizing parts and events

There is a Color tool (the paint bucket icon) on the Project window toolbar that can be used to colorize parts and events.

Just below the Color tool there is a small strip. Click this to bring up the standard color palette. If you double-click this strip the Event Color dialog opens, where you can define new colors for the standard palette, add more colors etc.

• To colorize one or several selected events, select the Color tool, choose a color from the palette, and click on an event. The color is applied to all selected events and overrides the track color (if used).
If you press [Alt]/[Option] the Color tool cursor becomes a pipette, which can be used to select a color by clicking on a part/event.

An alternative way to colorize parts and events is by selecting them, and then picking a color from the Color selector on the toolbar.

Creating a template

If you often work with the same types of Projects, it might be a good idea to set up a track layout and save it as a template. That way, you can select the saved template from the New Project dialog each time you create a new project, and start with your preferred layout and settings.

Let’s say for example that you usually want 16 audio tracks and 16 MIDI tracks at your disposal, and that you are using an audio interface with 4 inputs and 4 outputs, which you use as stereo input/output pairs. You could set things up as follows:

Creating a new, empty project

1. Select New Project from the File menu.
   It doesn’t matter which Project folder you select.
2. Pull down the Project menu and select “Project Setup…”.
   The Project Setup dialog appears.
3. Make settings according to your needs and click OK.
   The settings here include sample rate, record format (resolution), display format, frame rate, etc.
Setting up a typical bus configuration

1. Open the VST Connections window from the Devices menu.
2. Select the Outputs tab and click the Add Bus button.
   A dialog appears.
3. Select “Stereo” and click OK.
   You should now have two separate stereo output busses.
4. Use the ASIO Device Port column to select the desired audio outputs
   on your audio hardware for the two stereo busses.
5. Click the Inputs tab and set up input busses in the same way.
6. Close the VST Connections window.

Adding tracks

Let’s start with the audio tracks – let’s say you want 8 stereo tracks
and 8 mono tracks:

1. Right-click (Win) or [Ctrl]-click (Mac) anywhere in the Track list, and se-
   lect “Add Multiple Tracks…” from the pop-up menu that appears.
   A dialog appears, allowing you to specify the type of tracks, the track configuration and
   the number of tracks.
2. Set “Track” to Audio, “Configuration” to Stereo and “Count” to 8.
   Click OK.
   Eight stereo audio tracks are now added to the project.
3. Repeat this procedure but set “Configuration” to Mono.
   Eight mono audio tracks are added.
4. By default, all audio tracks will be routed to/from the first output/input
   busses – if you want to change the routing you can do that with the
   “in:” and “out:” pop-up menus in the Inspector or the Mixer.
   A tip: to change the input or output routing of several tracks in one go, select the tracks
   by [Shift]-clicking in the track list, press [Alt]/[Option] and change the routing in the In-
   spector. This changes the setting for all selected tracks.
   Next up are the MIDI tracks.
5. Use the “Add Multiple Tracks” function again, but set “Track” to MIDI
   and “Count” to 16.
5. If you need to change the output routing for the MIDI tracks, use the "out:" column in the Track list or Inspector.
   To change the routing for all MIDI tracks, press [Ctrl]/[Command] and change the setting for one track.

   There are a lot of tracks in the Project window now – you may find it useful to put all MIDI tracks in a folder:

6. Right-click (Win) or [Ctrl]-click (Mac) in the Track list, and select "Add Folder Track".
   A new folder track appears. This track type is simply a "container" for other tracks, helping you to manage and organize the track list.

7. Select all MIDI tracks by [Shift]-clicking.

8. Click on one of the MIDI tracks and drag it onto the Folder track.
   A green arrow indicates that you are about to move the track(s) into the folder.

9. Release the mouse button.
   Now all MIDI tracks are placed inside the folder.

10. If you like, "close" the folder by clicking the minus sign to the left in the track list.
    This hides all MIDI tracks from view.

    You could add other tracks and make settings for them in the same manner – you might for example want a Marker track, Group channel tracks or a track for some standard send effects (FX Channel tracks).

**Setting up your work space**

Before saving the template, you should position the windows the way you want them. You may want to hide unwanted windows from view, position the Transport panel, maximize the Project window, etc. The open windows and their positions will be included in the template.

**Saving the template**

To create the template, pull down the File menu and select “Save as Template…”. A dialog appears, asking you to name the template. This could be a descriptive name such as “Audio/MIDI Production”.

- If you now select “New Project” from the File menu, your template will be listed in the dialog that appears.
  Selecting it will create a new project with the track layout you’ve created.
Setting up Zoom presets

When working in the Project window and the editors, you will typically need to zoom in and out depending on what you’re doing. In the project window, zooming can be done with the zoom sliders to the right, with the Zoom submenu on the Edit menu or with the magnifying glass tool (see page 73 for more about zooming).

Zoom presets are a handy way to toggle between different zoom settings. In this example we will set up two presets: One that displays the whole project for a good overview, and one with a high zoom factor for detailed editing. We will continue working with the track layout you set up for the template.

1. Locate the vertical zoom slider in the lower right corner of the project window. Just above the slider is a small arrow button – this opens the vertical zoom menu.

2. Pull down the vertical zoom menu and select the option “Zoom Tracks Full”. The project is zoomed vertically so that the eight tracks we added before take up the entire project window (or rather, the entire lower track list area). This way, we get a nice, compact layout.

3. Use the horizontal zoom slider to set a suitable horizontal zoom. Check the rulers to see how much of the project will be visible at different zoom factors.
4. When you’re satisfied, pull down the horizontal zoom menu and select “Add”.
   A dialog appears, allowing you to type in a name for the preset, e.g. “Overview”.

5. Click OK to save the zoom preset.
   This will now be available on the horizontal zoom menu, from which it can be selected and applied.

6. Use the vertical and horizontal zoom sliders to zoom in for a detailed view, and repeat the procedure of saving the zoomed factor as a preset.
   The preset could be called “Detailed”.
   Now it will be possible to toggle between these two zoom factors simply by selecting the corresponding preset from the zoom menu.

Setting up workspaces

The final task in this tutorial will be to set up workspaces. A workspace is a configuration of windows and their properties – their sizes and positions etc. This makes it possible to quickly switch between different working modes.

In the following example, we will work with two workspaces: The Main (default) workspace, with the Project window and the Project Browser displayed, and one for mixing purposes, with the Mixer and the VST Performance window displayed.

1. Let’s start by opening the Project Browser, which lets you view and edit the events of a project in list form.
   This is opened from the Project menu.

2. Now arrange the Project window and the Project Browser next to each other, so that they fill the whole screen but don’t overlap.
   If you are using Cubase SX/SL for Windows, you can quickly do this by selecting “Tile Horizontally” from the Window menu.
   You will probably also want to move the Transport panel so that it doesn’t obscure the view.

   OK, now you set up your Main workspace for editing. Let’s now create a workspace for mixing purposes:
3. From the Workspaces submenu on the Window menu, select “New Workspace” and type in a name for the workspace (e.g. Mixing). The number in brackets displayed next to the Window menu name indicates that a different Workspace is now active.

4. Close the Project Browser, minimize the Project window, and instead open the Mixer and the VST Performance window from the Devices menu.

5. Resize the windows the way you want them and arrange them as you see fit.

Now you can quickly switch between these two workspaces:

6. Pull down the Window menu and display the Workspaces submenu. Both workspaces are listed at the bottom of the menu.

7. Select “Main”. The mixer and VST Performance window are closed, the Project Browser is opened and the Project window displayed and the windows are instantly positioned in the way you stored them. It’s also possible to switch workspaces by using key commands.

That concludes this tutorial!
Shortcuts & key commands
About this chapter

Most of the main menus in Cubase SX/SL have key command shortcuts for certain items on the menus. In addition, there are numerous other Cubase SX/SL functions that can be performed via key commands. These are all factory default settings, but can be customized if you like (see the chapter “Key commands” in the Operation Manual for details).

The default key commands

Below, the default key commands are listed according to category.

- As described on page 13, modifier keys are written as: [Win modifier key]/[Mac modifier key].
  For example, “[Ctrl]/[Command]+N” in the list below means “press [Ctrl] under Windows or [Command] under Mac OS X, then press N”.

Audio category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Fades to Range</td>
<td>[A]</td>
</tr>
<tr>
<td>Crossfade</td>
<td>[X]</td>
</tr>
<tr>
<td>Find Selected in Pool</td>
<td>[Ctrl]/[Command]+[F]</td>
</tr>
</tbody>
</table>

Devices category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mixer</td>
<td>[F3]</td>
</tr>
<tr>
<td>Video</td>
<td>[F8]</td>
</tr>
<tr>
<td>VST Connections</td>
<td>[F4]</td>
</tr>
<tr>
<td>VST Instruments</td>
<td>[F11]</td>
</tr>
<tr>
<td>VST Performance</td>
<td>[F12]</td>
</tr>
</tbody>
</table>
## Edit category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autoscroll</td>
<td>[F]</td>
</tr>
<tr>
<td>Copy</td>
<td>[Ctrl]/[Command]+[C]</td>
</tr>
<tr>
<td>Cut</td>
<td>[Ctrl]/[Command]+[X]</td>
</tr>
<tr>
<td>Cut Time</td>
<td>[Ctrl]/[Command]+[Shift]+[X]</td>
</tr>
<tr>
<td>Delete</td>
<td>[Del] or [Backspace]</td>
</tr>
<tr>
<td>Delete Time</td>
<td>[Shift]+[Backspace]</td>
</tr>
<tr>
<td>Duplicate</td>
<td>[Ctrl]/[Command]+[D]</td>
</tr>
<tr>
<td>Edit In-place</td>
<td>[Ctrl]/[Command]+[Shift]+[I]</td>
</tr>
<tr>
<td>Group</td>
<td>[Ctrl]/[Command]+[G]</td>
</tr>
<tr>
<td>Insert Silence</td>
<td>[Ctrl]/[Command]+[Shift]+[E]</td>
</tr>
<tr>
<td>Left Selection Side to Cursor</td>
<td>[E]</td>
</tr>
<tr>
<td>Lock</td>
<td>[Ctrl]/[Command]+[Shift]+[L]</td>
</tr>
<tr>
<td>Move Insert Cursor to Part Start</td>
<td>[0]</td>
</tr>
<tr>
<td>Move to Cursor</td>
<td>[Ctrl]/[Command]+[L]</td>
</tr>
<tr>
<td>Mute</td>
<td>[M]</td>
</tr>
<tr>
<td>Mute Events</td>
<td>[Shift]+[M]</td>
</tr>
<tr>
<td>Mute/Unmute Objects</td>
<td>[Alt]/[Option]+[M]</td>
</tr>
<tr>
<td>Open Default Editor</td>
<td>[Ctrl]/[Command]+[E]</td>
</tr>
<tr>
<td>Open Score Editor</td>
<td>[Ctrl]/[Command]+[R]</td>
</tr>
<tr>
<td>Open/Close Editor</td>
<td>[Return]</td>
</tr>
<tr>
<td>Paste</td>
<td>[Ctrl]/[Command]+[V]</td>
</tr>
<tr>
<td>Paste at Origin</td>
<td>[Alt]/[Option]+[V]</td>
</tr>
<tr>
<td>Paste Time</td>
<td>[Ctrl]/[Command]+[Shift]+[V]</td>
</tr>
<tr>
<td>Record Enable</td>
<td>[R]</td>
</tr>
<tr>
<td>Redo</td>
<td>[Ctrl]/[Command]+[Shift]+[Z]</td>
</tr>
<tr>
<td>Repeat</td>
<td>[Ctrl]/[Command]+[K]</td>
</tr>
<tr>
<td>Right Selection Side to Cursor</td>
<td>[D]</td>
</tr>
<tr>
<td>Option</td>
<td>Key command</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl/Command+A</td>
</tr>
<tr>
<td>Select None</td>
<td>Ctrl/Command+Shift+A</td>
</tr>
<tr>
<td>Snap On/Off</td>
<td>J</td>
</tr>
<tr>
<td>Solo</td>
<td>S</td>
</tr>
<tr>
<td>Split At Cursor</td>
<td>Alt/Option+X</td>
</tr>
<tr>
<td>Split Range</td>
<td>Shift+X</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl/Command+Z</td>
</tr>
<tr>
<td>Ungroup</td>
<td>Ctrl/Command+U</td>
</tr>
<tr>
<td>Unlock</td>
<td>Ctrl/Command+Shift+U</td>
</tr>
<tr>
<td>Unmute Objects</td>
<td>Shift+U</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide Infoview</td>
<td>Ctrl/Command+I</td>
</tr>
<tr>
<td>Show/Hide Inspector</td>
<td>Alt/Option+I</td>
</tr>
<tr>
<td>Show/Hide Overview</td>
<td>Alt/Option+O</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close</td>
<td>Ctrl/Command+W</td>
</tr>
<tr>
<td>New</td>
<td>Ctrl/Command+N</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl/Command+O</td>
</tr>
<tr>
<td>Quit</td>
<td>Ctrl/Command+Q</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl/Command+S</td>
</tr>
<tr>
<td>Save As</td>
<td>Ctrl/Command+Shift+S</td>
</tr>
<tr>
<td>Save New Version</td>
<td>Ctrl/Command+Alt/Option+S</td>
</tr>
</tbody>
</table>
## MIDI category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantize</td>
<td>[Q]</td>
</tr>
</tbody>
</table>

## Macro category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bounce Events</td>
<td>[Ctrl]/[Command]+[Shift]+[B]</td>
</tr>
<tr>
<td>Export selection on selected track(s)</td>
<td>[Ctrl]/[Command]+[Shift]+[T]</td>
</tr>
<tr>
<td>Render VSTi</td>
<td>[Ctrl]/[Command]+[Shift]+[R]</td>
</tr>
<tr>
<td>Skip range playback</td>
<td>[Ctrl]/[Command]+[Enter]</td>
</tr>
</tbody>
</table>

## Navigate category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand/Undo selection in the Project window to the bottom</td>
<td>[Shift]+[Down Arrow]</td>
</tr>
<tr>
<td>Move selected event in the Key Editor down 1 octave</td>
<td></td>
</tr>
<tr>
<td>Expand/Undo selection in the Project window/Key Editor to the left</td>
<td>[Shift]+[Left Arrow]</td>
</tr>
<tr>
<td>Expand/Undo selection in the Project window/Key Editor to the right</td>
<td>[Shift]+[Right Arrow]</td>
</tr>
<tr>
<td>Expand/Undo selection in the Project window to the top</td>
<td>[Shift]+[Up Arrow]</td>
</tr>
<tr>
<td>Move selected event in the Key Editor up one octave</td>
<td></td>
</tr>
<tr>
<td>Select next in the Project window (Down)</td>
<td>[Down Arrow]</td>
</tr>
<tr>
<td>Move selected event in the Key Editor one semitone down</td>
<td></td>
</tr>
<tr>
<td>Select next in the Project window/Key Editor (Left)</td>
<td>[Left Arrow]</td>
</tr>
<tr>
<td>Select next in the Project window/Key Editor (Right)</td>
<td>[Right Arrow]</td>
</tr>
<tr>
<td>Select next in the Project window (Up)</td>
<td>[Up Arrow]</td>
</tr>
<tr>
<td>Move selected event in the Key Editor one semitone up</td>
<td></td>
</tr>
</tbody>
</table>
## Nudge category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>End Left</td>
<td>[Alt]/[Option]+[Shift]+[Left Arrow]</td>
</tr>
<tr>
<td>End Right</td>
<td>[Alt]/[Option]+[Shift]+[Right Arrow]</td>
</tr>
<tr>
<td>Left</td>
<td>[Ctrl]/[Command]+[Left Arrow]</td>
</tr>
<tr>
<td>Right</td>
<td>[Ctrl]/[Command]+[Right Arrow]</td>
</tr>
<tr>
<td>Start Left</td>
<td>[Alt]/[Option]+[Left Arrow]</td>
</tr>
<tr>
<td>Start Right</td>
<td>[Alt]/[Option]+[Right Arrow]</td>
</tr>
</tbody>
</table>

## Project category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Browser</td>
<td>[Ctrl]/[Command]+[B]</td>
</tr>
<tr>
<td>Open Markers</td>
<td>[Ctrl]/[Command]+[M]</td>
</tr>
<tr>
<td>Open Tempo Track</td>
<td>[Ctrl]/[Command]+[T]</td>
</tr>
<tr>
<td>Open Pool</td>
<td>[Ctrl]/[Command]+[P]</td>
</tr>
<tr>
<td>Setup</td>
<td>[Shift]+[S]</td>
</tr>
<tr>
<td>Show/Hide Track Colors</td>
<td>[Shift]+[C]</td>
</tr>
</tbody>
</table>

## Tool category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete tool</td>
<td>[5]</td>
</tr>
<tr>
<td>Draw tool</td>
<td>[8]</td>
</tr>
<tr>
<td>Glue tool</td>
<td>[4]</td>
</tr>
<tr>
<td>Mute tool</td>
<td>[7]</td>
</tr>
<tr>
<td>Next Tool</td>
<td>[F10]</td>
</tr>
<tr>
<td>Play tool</td>
<td>[9]</td>
</tr>
<tr>
<td>Previous Tool</td>
<td>[F9]</td>
</tr>
<tr>
<td>Range tool</td>
<td>[2]</td>
</tr>
<tr>
<td>Select tool</td>
<td>[1]</td>
</tr>
<tr>
<td>Split tool</td>
<td>[3]</td>
</tr>
<tr>
<td>Option</td>
<td>Key command</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Toggle Select Tool Info</td>
<td>[Alt]/[Option]+[1]</td>
</tr>
<tr>
<td>Zoom tool</td>
<td>[6]</td>
</tr>
</tbody>
</table>

**Transport category**

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoPunch In</td>
<td>[I]</td>
</tr>
<tr>
<td>AutoPunch Out</td>
<td>[O]</td>
</tr>
<tr>
<td>Cycle</td>
<td>Pad [/]</td>
</tr>
<tr>
<td>Fast Forward</td>
<td>[Shift]+Pad [+]</td>
</tr>
<tr>
<td>Fast Rewind</td>
<td>[Shift]+Pad [-]</td>
</tr>
<tr>
<td>Forward</td>
<td>Pad [+ ]</td>
</tr>
<tr>
<td>Input Left Locator</td>
<td>[Shift]+[L]</td>
</tr>
<tr>
<td>Input Position</td>
<td>[Shift]+[P]</td>
</tr>
<tr>
<td>Input Right Locator</td>
<td>[Shift]+[R]</td>
</tr>
<tr>
<td>Input Tempo</td>
<td>[Shift]+[T]</td>
</tr>
<tr>
<td>Insert Marker</td>
<td>[Insert]/[Help]</td>
</tr>
<tr>
<td>Locate Next Event</td>
<td>[N]</td>
</tr>
<tr>
<td>Locate Next Marker</td>
<td>[Shift]+[N]</td>
</tr>
<tr>
<td>Locate Previous Event</td>
<td>[B]</td>
</tr>
<tr>
<td>Locate Previous Marker</td>
<td>[Shift]+[B]</td>
</tr>
<tr>
<td>Locate Selection</td>
<td>[L]</td>
</tr>
<tr>
<td>Locators to Selection</td>
<td>[P]</td>
</tr>
<tr>
<td>Loop Selection</td>
<td>[Shift]+[G]</td>
</tr>
<tr>
<td>Metronome On</td>
<td>[C]</td>
</tr>
<tr>
<td>Nudge Down</td>
<td>[Ctrl]/[Command]+Pad [-]</td>
</tr>
<tr>
<td>Nudge Up</td>
<td>[Ctrl]/[Command]+Pad [+]</td>
</tr>
<tr>
<td>Panel (Transport panel)</td>
<td>[F2]</td>
</tr>
<tr>
<td>Play Selection Range</td>
<td>[Alt]/[Option]+ [Space]</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Key command</strong></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Recall Cycle Marker 1 to 9</td>
<td>[Shift]+Pad [1] to Pad [9]</td>
</tr>
<tr>
<td>Record</td>
<td>Pad [*]</td>
</tr>
<tr>
<td>Retrospective Record</td>
<td>[Shift]+Pad [*]</td>
</tr>
<tr>
<td>Return to Zero</td>
<td>Pad [.] or Pad [,]</td>
</tr>
<tr>
<td>Rewind</td>
<td>Pad [-]</td>
</tr>
<tr>
<td>Set Left Locator</td>
<td>[Ctrl]/[Command]+Pad [1]</td>
</tr>
<tr>
<td>Set Marker 1</td>
<td>[Ctrl]/[Command]+[1]</td>
</tr>
<tr>
<td>Set Marker 2</td>
<td>[Ctrl]/[Command]+[2]</td>
</tr>
<tr>
<td>Set Right Locator</td>
<td>[Ctrl]/[Command]+Pad [2]</td>
</tr>
<tr>
<td>Start</td>
<td>[Enter]</td>
</tr>
<tr>
<td>Start/Stop</td>
<td>[Space]</td>
</tr>
<tr>
<td>Stop</td>
<td>Pad [0]</td>
</tr>
<tr>
<td>Sync Online</td>
<td>[T]</td>
</tr>
<tr>
<td>To Left Locator</td>
<td>Pad [1]</td>
</tr>
<tr>
<td>To Marker 1</td>
<td>[Shift]+[1]</td>
</tr>
<tr>
<td>To Marker 2</td>
<td>[Shift]+[2]</td>
</tr>
<tr>
<td>To Right Locator</td>
<td>Pad [2]</td>
</tr>
</tbody>
</table>
### Zoom category

<table>
<thead>
<tr>
<th>Option</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom Full</td>
<td>[Shift]+[F]</td>
</tr>
<tr>
<td>Zoom In</td>
<td>[H]</td>
</tr>
<tr>
<td>Zoom In Tracks</td>
<td>[Alt]/[Option]+[Down Arrow]</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>[G]</td>
</tr>
<tr>
<td>Zoom Out Tracks</td>
<td>[Alt]/[Option]+[Up Arrow] or [Ctrl]/[Command]+[Up Arrow]</td>
</tr>
<tr>
<td>Zoom to Event</td>
<td>[Shift]+[E]</td>
</tr>
<tr>
<td>Zoom to Selection</td>
<td>[Alt]/[Option]+{S}</td>
</tr>
<tr>
<td>Zoom Tracks Exclusive</td>
<td>[Z] or [Ctrl]/[Command]+[Down Arrow]</td>
</tr>
</tbody>
</table>
Index
A
Activate Project button 133
Add Bus 154
Add Child Bus 155
Add Multiple Tracks 241
Add Track 106
All MIDI Inputs 50
Alt/Option key 13
Apple Help 12
Arrow tool 170
ASIO 2.0 46
ASIO Device Port 154
ASIO Direct Monitoring 46
ASIO DirectX driver
   About 19
   Setup 43
ASIO driver
   About 18
   Installing 20
ASIO Multimedia driver
   About 19
   Setup 44
Audio
   Channels 61
   Clips 60
   Events 60
   Parts 61
   Tracks 61
Audio buffer size 55
Audio folder 59
Audio hardware
   Connections 36
   Installing (Mac) 31
   Installing (Windows) 20
   Requirements (Mac) 30
   Requirements (Windows) 18
   Setup application 40
Audio inputs 107
Audition bus 109
Automation 147

C
Channels 61
Child Bus 155
chn setting 124
Clipping indicator 112
Clips
   Audio 60
   Video 62
Computer Requirements
   Mac 29
   Windows 17
Connecting
   Audio 36
   MIDI 47
Copy Protection key
   Mac 31
   Windows 20
Core Audio drivers 30
cpr files 59
Ctrl/Command key 13
Cut 214
Cycle 119

D
Default MIDI input/output 51
Defragmenting
   Mac 32
   Windows 22
Devices panel 78
DirectX driver 19

E
Edit History window 80
Edits folder 59
Effects
   Applying 216
   Insert effects (Audio) 145
   Send effects (Audio) 141
EQ 137
Eraser tool 172
Events
  Audio 60
  Copying 171
  Erasing 172
  MIDI 62
  Moving 170
  Muting 172
  Resizing 174
  Splitting 173
Expert settings 55
Export Audio Mixdown 163
External effects setup 38

K
  Key command conventions 13
  Key commands
    Assigning 231
    List of default commands 248
    Macros 233
  Key Editor
    Drawing events 221
    Moving events 222
    Opening 220
    Selecting events 222
  Knob mode 71

L
  Latency 53
  Level meters 111
  LFE 161
  Library 152
  Local On/Off 48

M
  Mac OS X drivers 30
  Macros 233
  Magnifying Glass tool 74
  Maximum Undo 79
  Memory Requirements
    Mac 29
    Windows 17
  Menus 64
  MIDI channel 124
  MIDI events 62
  MIDI input
    Selecting for tracks 123
    Setting default 51
  MIDI Interface
    Connecting 47
    Installing (Mac) 31
    Installing (Windows) 22
  MIDI output 124
MIDI parts 62
MIDI ports
  Default 51
  Setting up 50
MIDI recording 126
MIDI Thru 122
MIDI Thru Active 48
MIDI tracks
  About 62
  Creating 123
Mixer 134
Mixing down to disk 163
Modifier keys 13
Monitor (MIDI tracks) 186
Monitoring
  About 46
  Setting up 115
Mouse recommendations 30
Multimedia driver 19
Musical mode
  Setting loop to 197
Mute 136
Mute tool 172

npl files 152

Offline Process History 79, 217
Optimizing the Hard Disk
  Mac 32
  Windows 22
Option/Alt key 13
Output busses 107
Output ports 44

Pan
  Setting in mixer 135
  Surround 157
Parts
  Audio 61
  MIDI 62
Paste 214
Play Order list
  Creating 207
Play Order parts
  Creating 204
Play Order track
  Adding 203
Plug-in automation tracks 190
Plug-ins
  Applying 216
  Insert effects (Audio) 145
  Send effects (Audio) 141
Pop-up menus 64
Popup toolbox on right click 67
Position values 68
Process functions 215
Program Change 125
Project
  About format 58
  Creating new 105
Project folder 59
Project Setup dialog 151

Quantize 223
Quick menu 65

RAM
  Mac 29
  Windows 17
Range Selection tool 213
Record Enable 114
Recording levels 39
Redo 79, 173
Release ASIO Driver in Background 42
Repeat 171
Ruler zooming 75

S
Save as Template 240
Scissors tool 173
Scroll bars 73
Select All 171
Selecting objects 72
Send effects (Audio) 141
Show Panel 78
Show Tips 67
Slider mode 71
Snap
  MIDI editors 222
  Project window 170
Solo
  Mixer 136
  Track list 183
Start Record at Left Locator 187
Surround mixing 150
Surround Pan 157
Surround sound setup 38

T
Template 240
Tips 67
Toolbox 67
Tools 66
Track Parameters 128
Tracks
  Audio 61
  MIDI 62
  Video 62
  Transport panel
    Customizing 234
    Overview 85
  Transpose 128
  Two-button mouse (Mac) 30

U
Undo 79, 173

V
Value editing 68
Value slider 69
Velocity 225
Video
  Clips 62
  Events 62
  Track 62
  Video setup 52
  VST Audiobay 41
  VST Connections
    Inputs 107
    Outputs 154
  VST input ports 44
  VST Instruments
    Activating 179
    Automating 190
    Editing 188
    Playing in real time 185
    Routing tracks to 181
  VST output ports 44
  VU meters 111

W
Wheel mouse
  Scrolling 73
  Value editing 68
Window menu 76
Windows dialog 77
Workspaces 244
Z
Zoom presets 243
Zoom sliders 73
Zoom submenu 74
Zoom while Locating in
  Time Scale 75